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1.0  Introduction

Beam Optics Analyzer (BOA) is an advanced 3D charged particle simulation code with optimiza-
tion. Its principle applications include the design of electron guns, collectors and charged particle 
devices. Features include:

• Incorporates finite element analysis with adaptive and user-controlled meshing

• Compatible with commercial 3D CAD programs

• User friendly, intuitive, graphical user interface (GUI)

• Integral electrostatic and magnetostatic solvers

• Import of spent beam and magnetics files

• Accurate simulation of grids

• Secondary electron emission

• Fully relativistic

• Includes space charge and self-magnetic fields

• Built-in materials database

• Optimization of beam optics design of guns, collectors and beam lines

• Optimization of electrostatic and magnetostatic circuits

• Optimization of multi-stage collectors

• Support for symmetry in model simulation

• Parallel processing

[TBD. Revise. Add more background, context, discussion of applications, discussion of what 
advantages BOA has compared to competitors; discussion/overview of the optimizer, etc.]

2.0  Installation

BOA is available via download from www.Calcreek.com. BOA is certified for operation in Win-
dows 2000, Windows XP, Windows Vista and Windows 7. 

2.1  Minimum System Requirements
• Operating System: Windows 2000, XP, Vista and Windows 7.

• Memory Requirements: 1 gigabyte of RAM or greater.

Boa supports multicore CPU Architecture. 

2.2  Software Requirements for Optimization Runs 

The following software programs are required for running Optimization cases: 
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• Microsoft Excel

• SolidWorks 3D CAD software

2.3  Website Installation
1. Download BOA Beta Version - To install BOA Beta Version, go to www.calcreek.com and 

click on Products. In the Software Products section, click on Boa. In the Download BOA Beta 
Version and User Manual section click on Download BOA Beta Version. You will have the 
option to Open or Save the installer. If you choose Open, the installer will install BOA to your 
specified location or the default directory, which is C:\Program Files\Beam Optics Analyzer. If 
you choose Save, you will be prompted for the directory in which to save the installer. Save the 
file to the desired directory, double-click it and then follow the on screen instruction to proceed 
with the installation.

2. Obtain License File - The BOA solver requires a license file. To obtain a 30-day demo 
license, please contact Thuc Bui at bui@calcreek.com with your name and address. When the 
license file BoaLicense.lic is received, place it in C:\Program Files\Beam Optics Ana-
lyzer\license. (You will be asked for the serial number from the disk drive containing the exe-
cutable files. This number can be obtained by opening a DOS window on the drive where the 
executables are stored and typing ‘dir/p’. The serial number consists of eight alpha-numeric 
characters separated by a hyphen.) 

3. Download Latest BOA Patch - To install the latest patch, if one is available, click on the 
Download BOA Latest Patch link to either Open or Save the patch. (The Download BOA Latest 
Patch link is located directly below the Download BOA Beta Version link on the webpage 
described in Step 1 above.) If you have chosen the default directory for BOA installation, the 
patch will self-extract to the proper location. If not, during the extraction you can browse to the 
bin folder under your BOA installation directory to unzip the patch.

2.4  Executing BOA GUI 

If you chose to create a boaGui ‘shortcut’ during installation (on your desktop and/or in the star-
tup menu), click on the boaGui icon (shown in Figure 1) to start the program. 

FIGURE 1. BoaGui shortcut icon
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Alternatively, doubleclick on the boaGui executable file in c:\Program Files\Beam Optics Ana-
lyzer. Figure 2 shows this file highlighted.                                                                                                       

3.0   Basic Operation

3.1  File Structure

Boa uses a file structure that includes both Cases and Projects. A Case consists of a single analysis 
and a Project is a logical grouping of Cases. Typically users group all the simulations (Cases) 
associated with a single device into one Project. 

The Project directory contains the boa project file with the file extension *.boa. Case directories 
are located within the Project directory. Case directories contain geometry files (ACIS or a Para-
Solid files), parameter files, BOA input files, and all output files. (See “Appendices” on page 176 
for details on all input files, internal files and output files created by BOA.)

{TBD: maybe add a section discussing overview of all inputs & outputs? or is that unnecessary?}

3.2  Screen Organization

When you first execute BoaGui, the title bar and menu bar appear at the top of the screen and the 
section below the bars is blank. When you open a Project (described in the next section) the 
screen below the bars will divide into three section as shown in Figure 3:

• The Main Window - By default this region is used for the graphic display of the model. It can 
also be used to display other information, when desired. 

FIGURE 2. Contents of c:\Program Files\Beam Optics Analyzer 
directory. Doubleclick on boaGui to execute the Boa Gui.
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• The Project/Case Manager tree control - The upper right hand window always contains the 
Project/Case Manager tree control. 

• The Corner Window (technically the lower right corner window, however it is referred to 
elsewhere in boaGui as simply the Corner Window) - By default this region displays the Job 
Monitoring graph. It can be used to display other information when desired. 

Prior to opening a Case (described in the next section), only the Project/Case Manager section 
will contain information. It will display a tree control that shows the name of the open Project 
along with all of the Cases contained within it. Right-clicking on the Project name or on one of the 
Case names will bring up menus that allow you to manage your Cases and Project (e.g., open a 
Case, add a new Case to a Project, etc.) Once you open a Case with a defined geometry model, the 
model will appear in the Main Window. When you execute a run, the Corner Window will display 
a graph that monitors parameters for the job. These job parameters are specified via the Execute-
>Job Parameters menu.   

The pulldown menus at the top of the screen control most of the functions in BoaGui. The remain-
der of this chapter describes the basic function of each menu item as well as the menu items asso-
ciated with the Project/Case Manager. 

The subsequent chapter contains several example tutorials. The first time user may find it easiest 
to get familiar with the software by working through the examples first. (See Section 4.0 “Exam-
ples” on page 100.) 

FIGURE 3. Main BoaGui Screen
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3.3  Project/Case Manager

The Project/Case Manager appears in the upper right hand window of the screen whenever a 
Project is open. It consists of a tree control containing all cases in the Project. You can use the tree 
control to manage the Project and Cases. 

3.3.1  Project Menu 

Right-clicking on the Project name bring ups the menu shown in Figure 4. It contains the follow-
ing menu items:

Add New Case - Creates a new Case within the 
current Project. A dialog box will prompt you 
to specify the Name of the Case, the Analysis 
Type, and any desired Comments. You will also 
have the option to open the case immediately 
(make it the current case). Once the new Case is 
created, it will automatically appear beneath the 
Project in the Project/Case Manager tree con-
trol. Behind the scenes, a new Case folder will 
be placed in the current Project folder. The case 
folder will include all files specific to the case. 

Import Pre-Existing Case - Allows you to import an existing Case into the current Project. You 
will be prompted to browse the directories on your computer to locate the desired Case folder:

• If you specify a ‘removed’ Case folder in the current Project, the Case will be re-imported 
into the Project. (A removed Case is one that exists in the Project folder but that has been 
‘removed’ from appearing in the Project/Case Manager via the Remove Case menu item.) 

• If you specify a Case folder in another Project, the Case folder will be copied to the cur-
rent Project folder. (The case is not moved, it is simply copied. The original case remains 
located in the original Project folder.) 

The imported Case automatically appears beneath the Project in the Project/Case Manager tree 
control. 

Import All Cases From Directory - Allows you to import all Cases from a Project into the cur-
rent Project. You will be prompted to browse the directories on your computer to locate the 
desired Project folder: 

• If you specify the current Project folder, all ‘removed’ cases will be re-imported into the 
Project. 

• If you specify another Project folder, all Case folders in the Project (including ‘removed’ 
Cases) will be copied to the current Project. (Cases are copied, not moved. The original 
cases remain located in the original Project folder.) 

FIGURE 4. Project/Case Manager shown with 
Project Menu opened
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All imported Cases automatically appear beneath the Project in the Project/Case Manager tree 
control. 

3.3.2  Case Menu

Right-clicking on one of the Cases brings up 
the menu shown in Figure 5. It contains the fol-
lowing menu items:

Open Case - Opens the selected Case.    

Remove Case - Removes the selected Case 
from the current Project. You will be given two 
options: 

• Remove the Case from Project and 
Delete the Case Directory and all of its 
Contents - This option deletes the Case 
directory completely. 

• Remove the Case from Project - The case will remain in the Project directory but it will 
not be accessible via the Project/Case Manager. With this option the Case can still be re-
imported, but its name cannot be reused for a new case. 

Clean Up Case - Deletes files created by a previous BOA run of the case. Deleted files include:

• *.ssv 

• *.sss 

• *.pws 

• *.ebm 

• *.out 

• *.cde 

• *.tdb 

• *.fef (Note: The clean up feature removes all *.fef files generated by the case, but does not 
remove those imported into the case, such as those generated by another case)

• *.jc 

• *.trj 

• *.msd 

• *.mss 

• *.spd

• *.res 

• *.sle 

FIGURE 5. Project/Case Manager shown with 
Case Menu opened
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(See Section 6.3 “Appendix C - Internal Files” on page 183 for a description of all files created by 
Boa.)

{TBD: check appendix. i think some files were added so we need to mention here}

Display/Edit Comments - Allows you to view and edit the comments for the selected case. 

Close Case - Closes the current Case. If you have made any changes to the Case you will be given 
the option to save the Case or close without saving. 

Save Case - Saves the current Case.

Save Case As... - Allows you to copy the 
selected case to either the current Project 
directory (with a different Case name) or 
another Project directory (with the same or 
different Case name). This can be useful for 
backing up cases and can also be useful for 
sending a case to CCR for debugging during 
the beta test period. Figure 6 shows the Copy 
dialog.

• If you copy the case to the current 
Project directory, the Add New Case to Current Project checkbox gives you the option to 
‘add’ the case to the Project. (Adding the case means that in addition to it being copied 
into the directory it will also appear in the Project/Case Manager.) If you choose not to add 
the case when you copy, you can always add it later using the Import Pre-Existing Case 
feature. 

• If you copy the case to another Project directory, the case will be copied only -- not added. 
You will need to use the Import PreExisting Case feature (when that Project is open) in 
order for it to appear in the Project Case Manager.

The Copy Meshes checkbox gives you the option to include or exclude the meshes when the copy 
is performed. 

FIGURE 6. Copy Case dialog 
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3.4  File Menu 

The File pulldown menu is shown in Figure 7. It 
includes the following:

New Project - Opens a new Project. BoaGui will 
prompt you to specify the name of the Project and the 
directory in which you would like the new Project 
folder to reside. The Project folder will contain the 
Project file (*.boa) and all associated Case folders.

Open Project - Opens an existing Project. You will be 
prompted to browse the directories on your computer 
to locate the desired Project file (*.boa). 

Close Project - Closes the current Project and Case. If 
you have made any changes to the Case you will be 
given the option to save the Case (and Project) or close 
without saving. 

Add New Case - Identical to menu item with the same 
name on the Project ‘right-click’ menu. See previous 
section for details. 

Import Pre-Existing Case - Identical to menu item with the same name on the Project ‘right-
click’ menu. See previous section for details.    

Import All Cases From Directory - Identical to menu item with the same name on the Project 
‘right-click’ menu. See previous section for details. 

Open Case - Identical to menu item with the same name on the Case ‘right-click’ menu. See pre-
vious section for details. Use the tree control in the Project/Case Manager to highlight the desired 
Case.   

Remove Case - Identical to menu item with the same name on the Case ‘right-click’ menu. See 
previous section for details. If a case is not open, use the tree control in the Project/Case Manager 
to highlight the desired Case.   

Clean Up Case - Identical to menu item with the same name on the Case ‘right-click’ menu. See 
previous section for details. If a case is not open, use the tree control in the Project/Case Manager 
to highlight the desired Case.   

Display/Edit Comments - Identical to menu item with the same name on the Case ‘right-click’ 
menu. See previous section for details. If a case is not open, use the tree control in the Project/
Case Manager to highlight the desired Case.   

Close Case - Identical to menu item with the same name on the Case ‘right-click’ menu. See pre-
vious section for details. 

FIGURE 7. File Pulldown Menu
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Save Case - Identical to menu item with the same name on the Case ‘right-click’ menu. See pre-
vious section for details. 

Save Case As - Identical to menu item with the same name on the Case ‘right-click’ menu. See 
previous section for details. If a case is not open, use the tree control in the Project/Case Manager 
to highlight the desired Case.

Print Setup... - Opens the Print Setup dialog box where you can select the printer and various 
print options.

File History - Displays a history of the past four Project files opened. This allows easy selection 
of previously loaded files.

Exit - Closes BoaGui. If the currently loaded Case has not been saved, you will be given the 
option to save the Case or exit without saving.

Upon initiating BoaGui you must create or open a Project and then create or open a Case. Most 
pulldown menus will be disabled until Project and Case are specified. 

3.5  View Menu

The View pulldown menu, shown in Figure 8, con-
tains options that affect the display in the graphics 
region. The menu items include:

Orientation - Provides predefined orientations for 
the graphics display, including: zx (-y), zx (+y), yz (-
x), yz (+x), xy (-z), xy (+z), and Isometric. (The zx (-
y) orientation represents the zx plane with the -y 
axis projecting out from the screen, and so on.)

Surface Representation - Provides two types of 
visualization, Wireframe and Surface. Examples of 
both types are shown in Figure 9. Surface is the 
default view. You can also toggle between the two 
modes by typing the W key or the S key on the key-
board. 

This setting applies to all items shown in the graph-
ics display region. This can include the geometric model, the mesh (initial and adapted), and the 
resulting electrostatic and magnetic fields. 

View Representation - Provides two options for view representation, Orthogonal and Perspec-
tive. Examples of each type are shown in Figure 10. Orthogonal is the default representation. It 
displays the ‘true’ view (view rays are parallel and objects are rendered without distance effect). It 
provides accurate distance measurements when using the Measure Distance feature under the 
View Results menu.    

FIGURE 8. View pulldown menu
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The Perspective representation provides a more pleasing view in three dimensions, however it 
distorts the position of objects relative to each other. (View rays are NOT parallel and objects are 
rendered more natural looking but distortion is introduced.) WARNING: The Perspective repre-
sentation should never be used with the Measure Distance feature. It will result in incorrect dis-
tance measurements. {TBD: Check if this is still true. this is a very early constraint Bill Vogler 

gave me; if it is true, can we prohibit this in the GUI? if not, then remove this comment.}

Experiment with both representations to determine which option you prefer for general viewing 
and printing. However, always use the Orthogonal representation when using the Measure Dis-
tance feature. 

Refresh View - Refreshes the display such that the current orientation remains fixed but the entire 
model is visible and centered within the graphics display window. (This can be used to quickly 
view the whole model after zooming in on a specific region.) Typing the R key will also refresh 
the display. 

FIGURE 9. Examples of surface representations. A Wireframe representation is 
shown on the left and a Surface representation is shown on the right.

FIGURE 10. Examples of a view representations. The left image shows an 
Orthogonal representation of a cylinder. The right image shows a Perspective 
representation of the same cylinder.
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Reset View - Resets the display to the isometric view. (This command is identical to the Isometric 
item on the File-> Orientation menu.)

Model Geometry Display Resolution - Controls the Relative Resolution display of curved sur-
faces. Curved surfaces are actually composed of sections of flat surfaces. With a higher resolu-
tion, more flat surfaces are used to render the curved surface and the surface appears smoother. 
The Relative Resolution can be set between zero and one, with one being the highest resolution 
and zero being the lowest. The higher the resolution, the longer it takes for the computer to gener-
ate the initial display, but manipulation of the display thereafter (rotation, zoom, pan) is not signif-
icantly affected. The default resolution is set to 0.5. 

NOTE: For this parameter to take effect, you must save and close the case and then reopen it. 

Display Model Coordinates - Dynamically displays the X, Y, Z coordinates of the mouse cursor 
as it moves through the graphics display region. When this feature is on, a check mark appears in 
front of the menu item and the three coordinates appear in the status bar. 

Display Model - Shows and hides the geometric model. (Hiding the model can sometimes be use-
ful when viewing results.) When the display is on, a check mark appears in front of the menu 
item. 

Slice Model - This menu item allows you to create a slicing plane and remove the model on either 
side of the plane, providing a view of the interior of the model. This can be useful when assigning 
attributes or when viewing results (for example, when verifying that a beam is centered in a drift 
tunnel or to measure beam minimum position and diameter inside a part). 

The menu item brings up the dialog box shown 
in Figure 11. The Choose Plane radio buttons 
define the plane used to slice the model. 
Choose one of the three standard orthogonal 
cut planes (xy, xz or yz plane) or an arbitrary 
cut plane (xyz plane). For the arbitrary cut 
plane, specify the three components of the 
vector normal to the plane: x Normal, y Nor-
mal and z Normal. (For example, the positive 
normal vector to the xy plane is <0, 0, 1>, and 
the negative normal vector is <0, 0, -1>.) Use 
the slider bars to define the distance of the 
plane along the normal vector. 

The Slicing Side radio buttons control which 
side of the plane is removed. The Positive Side 
refers to the side normal to the plane and the 
Negative Side refers to the opposite side. The 
Slicing Style radio buttons provide options for 
the appearance of the sliced edge of the model 
(Hollow or Solid). The Viewing Parameters 

FIGURE 11. Slicing Input Parameters dialog box 
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section contains a checkbox that shows/hides the axes and a slider bar that controls the opacity of 
the slicing plane. The Slicing State radio button lets you turn the feature on and off (i.e., show or 
hide the sliced portion of the model). When the radio button is set to On, a check mark appears in 
front of the Slice Model menu item on the File menu. 

An example of a sliced model is shown in Figure 12. 

Screen Snapshot - This feature saves a snapshot of the Main Window (which typically displays 
the geometry model) to a file named ‘MainScreen.jpg’ and puts it in your case directory. 

Plot Parameters - This 
menu item brings up the 
Plot Control Panel dialog 
shown in Figure 13. Use this 
dialog to view various plots 
and specify where they 
appear. 

The Plot Type drop down 
box contains the following 
options: 

• Convergence (a line plot) 

• Permeability (a line plot)

• Particle (a scatter plot)

• Electrostatic Line Plot (a 
line plot) 

FIGURE 12. Example of Slicing the Model

FIGURE 13. Plot Control Panel dialog 
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• Magnetostatic Line plot (a line plot)

• External Magnetic Field (a line plot)

• Model (the geometric model)

• Optimizer Convergence {get more info}

• Error Estimates {get more info}

• Newton Residual {get more info}

{This section currently under revision; 

• More details to be added. integrate (or show) all info from my Excel table summary here

• confirm bugs i reported were fixed} 

Display Axes - Shows and hides the XYZ axes 
along with coordinates enclosing the displayed 
electrostatic part(s). When the display is On, a 
check mark appears in front of the menu item. 
Figure 14 shows an example of the axes displayed 
with Axes Type = ‘Box Style’ (as explained 
below). Figure 12 shows an example of the axes 
displayed with Axes Type = ‘CAD Style’. 

Axes Type - BoaGui provides two options for the 
appearance of the axes: ‘CAD Style’ and ‘Box 
Style’. CAD Style is the default. Box Style shows 
a box enclosing the model and displays the axis 
coordinates. The default Axes Type is CAD Style. 
Figure 14 shows an example of the Axes Type set 
to Box Style. 

Color - Opens the submenu shown in Figure 15. The last item, Trajectories, will be active only if 
beam analysis results have been generated. Selecting any of the first three items (Background, 

FIGURE 14. Example of Axes Displayed 
(with Axis Type = Box Style)
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Axes, and Mesh) results in the Color palette dialog shown in Figure 16. Use this dialog to set the 
desired color for the Background, the Axes, or the Mesh. 

The Trajectories item opens the dialog shown in 
Figure 16. To change the color of the trajectories for a 
given Particle Generation, select the Particle Genera-
tion and click the Change Color button. The Color 
Palette dialog shown in Figure 16 will appear. The 
Color by dropdown box allows you to further control 
the color of the trajectories as follows:

‘Full’ - shows the selected single color for all trajecto-
ries.

‘Particle ID’ - varies the color of each trajectory based 
on its Particle ID. The Particle ID legend pops up at 
the bottom of the Main Window when this option is 
selected.

‘Particle Current’ - varies the color of each trajectory 
based on its current. The Particle Current legend pops 
up at the bottom of the Main Window when this 
option is selected. 

Status Bar - Shows and Hides the status bar at the bottom of the boaGui screen. When the status 
bar is shown, a check mark appears in front of the Status Bar menu item.

Zoom Feature - BoaGui also includes a Zoom feature although it is not menu driven. The right 
mouse button controls the Zoom feature. To zoom in, hold down the right mouse button and move 
the mouse forward (or ‘up’). To zoom out, hold down the right mouse button and move the mouse 
backward (or ‘down’). 

FIGURE 15. Color Submenu
FIGURE 16.  Color Palate dialog

FIGURE 16.  Color Trajectories dialog



18 [5/10] BOA Version 4, User Manual v0.5 updates in progress

3.6  Analysis Menu

The Analysis pulldown menu, shown in 
Figure 17, sets the analysis type for the cur-
rent case. The selected analysis type appears 
preceded by a check mark. Each analysis 
type requires different input parameters. 
BoaGui enables and disables the appropriate 
menus and execution parameters based on 
this selection. Options include:

• Electrostatic - Performs an electrostatic 
analysis only. 

• Magnetostatic - Performs a magnetostatic 
analysis only.

• Electrostatic Beam - Performs an electrostatic analysis, followed by a beam simulation, 
updating and refining the electric fields based on space charge effects. Self magnetic field from 
the electron beam is not included in the simulation.

• Electrostatic/Self Field Beam - Performs an electrostatic analysis, followed by a beam simu-
lation, updating and refining the electric fields based on space charge effects. Self magnetic 
field from the electron beam is included in the simulation.

• Electro/Magnetostatic Beam - Performs an electrostatic simulation, followed by a magneto-
static simulation. The magnetostatic fields are interpolated to the electrostatic mesh during 
subsequent iterations. The electron beam is simulated and the electric fields are updated based 
on space charge effects. Self magnetic field from the beam electrons is not included. 

• Electro/Magneto/Self Field Beam - Performs an electrostatic simulation, followed by a mag-
netostatic simulation. The magnetostatic fields are interpolated to the electrostatic mesh during 
subsequent iterations. The electron beam is simulated and the electric fields are updated based 
on space charge effects. Self magnetic field from the beam electrons is included. 

• Heat Transfer - A thermomechanical modeling module is planned for future versions. This 
feature is not available in the initial beta release.

All Electrostatic analysis types include the option for a Single Case analysis or an Optimizer 
Analysis:

• Executing a Single Case means the user imports a single geometry, specifies a single set of 
problem attributes, meshes and then executes for that geometry and attribute set. 

• In contrast, an Optimizer Analysis allows the user define goals for the optimal design, then 
based on these goals, Boa runs, updates the geometry and other problem attributes, re-meshes 
and reruns until the goals are achieved.

Note: Running the Optimizer requires both Excel and SolidWorks. BOA will issue an error if the 
system does not meet these requirements.

FIGURE 17. Analysis pulldown menu
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During an Optimization run, the lower Corner Window will display the progress of the optimiza-
tion. 

3.7  Model Menu

{TBD: This section needs some revisions: add discussion of the multiple information messages 
that appear and explain initial vs. final model. (I already added this to the examples but did not 
yet add here.) Also, update section referenced below.}

The Model menu item opens the 
Geometry Model Parameters dialog 
box, shown in Figure 18. It contains 
two main sections, one for specifying 
Geometry and one for specifying 
Background. The Model Units are 
shown at the bottom of the dialog. 

The exact title of the Geometry section 
varies with the selected Analysis Type. 
(For example, in Figure 18 it is titled 
Electrostatic Beam Geometry because 
the Analysis Type for this particular 
analysis is set to ‘Electrostatic Beam’.) 
The Geometry section contains the fol-
lowing: 

CAD Drawing - This feature currently 
works for CAD drawings created in 
SolidWorks only:

• Optimization run: The CAD Draw-
ing is required for an Optimization 
run. The drawing is updated with each consecutive optimization run and a new geometry file is 
imported into the case to meet the specified optimization goals. This CAD drawing must be 
created in SolidWorks and SolidWorks is a system requirement for Optimization runs. 

• Single case - For a single case run, this feature is provided for convenience only. It allows you 
to access the SolidWorks CAD drawing used to create the geometry file without leaving 
BoaGui. WARNING: If you make a change to the CAD drawing in SolidWorks, BOA will not 
automatically copy the modified geometry file into the Case directory. Make sure to copy the 
modified file to the Case directory by re-specifying it as described in the section below. 

Use the Browse button to locate (specify path for) the desired CAD file. Use the CAD button to 
access the specified CAD drawing in SolidWorks. 

Geometry Solid Model File - Used to specify the geometry file (either an ACIS *.sat file or a Para-
Solid *.x_t file) on which the analysis is based. This file is always required. 

FIGURE 18. Geometry Model Parameters dialog 
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Note: for the current beta release the ParaSolid *.x_t file format has not been fully tested due to 
the issue with model units always in meters.

Use the Browse button to 
locate the desired file. 
When you select the file, 
BOA will display the mes-
sage shown in Figure 19 
informing you that the 
specified file will be cop-
ied to the Case directory. 
Press Yes to proceed. (BoaGui requires that a copy of the geometry file reside in the BOA case 
directory. BoaGui does not use the original version of geometry file.)

Note that subsequent steps in a BOA analysis depend on the geometry model file, including 
attribute assignments and mesh generation. If you specify a new geometry file, BOA will issue a 
Warning message with three options:

• Update - updates boundary and source assignments. To successfully update, the new geometry 
model must have the same number of parts and the same part names as the old model.

• New - automatically clears attribute assignments and deletes the existing mesh file so that you 
can start new assignments 

• Cancel 

See the Appendix for details on how parts and surfaces should be named within the geometry file. 

The Background section {TBD: provide explanation; waiting for implementation of redesign...}

Model Units - These units are taken directly from the geometry model file. 

3.8  Attributes Menu

The Attributes menu item brings up the tabbed Attribute Assignment Properties dialog shown in 
Figure 20. It contains five possible tabs: Electrostatics, Beam Optics, Magnetostatics, Optimizer 
and Miscellaneous. The tabs vary depending on the selected analysis type. For example, in 
Figure 20, the Magnetostatic tab is absent because the Analysis menu is set to ‘Electrostatic 
Beam’. Note that the Miscellaneous tab is for internal CCR use during the Beta testing period 
only. Users should not use this tab unless troubleshooting with CCR personnel.

FIGURE 19. Geometry File Copy Message
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3.8.1  Electrostatic Attributes

The Electrostatics tab, 
shown in Figure 20, is 
used to assign properties 
required for an electro-
static analysis. It is 
enabled when the Analy-
sis menu is set to one of 
the Electrostatic analysis 
types. The tab includes 
sections for defining prop-
erties at both the part level 
and the surface level. 

3.8.1.1  Properties at the 
Part Level 

The Properties at the Part 
Level section allows you 
to assign properties to the 
parts that make up the 
geometric model. The 
table at the top of the sec-
tion contains all of the 
parts defined in the elec-
trostatic geometry file. It 
is automatically popu-
lated based on the file 
specified on the Geometry Model Parameters dialog. Additional entries cannot be added. To mod-
ify a part’s properties, first select the part to make it active. The properties beneath the table will 
then become available. Properties include:

Name - The part name is identical to the name provided in the geometry file. This property is not 
editable.

Color - Specify a color for the part from the Color dropdown box. 

Visible checkbox - Check/uncheck the box to show/hide the part in the graphics display of the 
geometry model (shown in the Main Window). BoaGui will initially show all parts -- except for 
the background part -- as visible.

Opacity - Opacity is the translucency of a part for the purposes of graphical display. It ranges from 
1 to 0, going from no transmission of light through the part (opaque) to full light transmission 
(transparent). A part’s Opacity is editable only if it is set to Visible. (Notice that although by 
default the background part is set to invisible, if you change it to visible then its Opacity defaults 
to 0.8. This default value allows you to see through it to the internal parts.) 

FIGURE 20. Attribute Assignment dialog box, Electrostatics tab
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Voltage Assigned to the Entire Part checkbox - Check the box for any part that has potential and 
enter the voltage in Volts. If the box is left unchecked, the part is assumed to have no potential. 
(An unchecked box is not the same as a checked box with a voltage of zero.) 

Volume Charge Density Assigned Inside Part - To assign a volume charge density inside of the 
part, check the box and enter the volume charge density in Coloumbs per cubic ‘length unit’ (the 
length unit (e.g., inch) is defined in the geometry file and shown on the Geometry Model Parame-
ters dialog). If the box is left unchecked, the part is assumed to have no volume charge density. 

Relative Permittivity section - The Relative Permittivity for a part can be entered directly or 
looked up in the Materials Properties database. (See Section 3.12.3 for a description of the Mate-
rials Properties database.) Typically it is looked up, so by default the Value field is non-editable 
(i.e., the Edit directly checkbox next to it is unchecked) and the Material dropdown box is used to 
find the Relative Permittivity.

The Edit Directly checkbox allows you to enter a Relative Permittivity Value directly. Use this fea-
ture if you want to either: 

• enter a value independent of the Material Properties database (the material name will default 
to ‘Noname’ when it appears in the Parts table), or 

• edit the Relative Permittivity Value of a user-provided material in the Material Properties data-
base. 

You can also add materials to the Material Properties database by selecting ‘Add Your Own 
Material’ in the Material drop-down box. This will bring up the Material Properties dialog dis-
cussed in Section 3.12.3. (It can also be accessed via the Tools->Material Properties menu.) 

3.8.1.2  Properties at the Surface Level 

The Properties at the Surface Level section (shown in Figure 20) is used to assign voltages and 
surface densities to specific surfaces in the model. Unlike Properties at the Part Level, the Sur-
face Property table is empty until you explicitly define properties to specific surfaces. 

{TBD: Decide if this belongs here or in an earlier, more general discussion about surfaces 
throughout the BOA GUI:   Each part in the geometry model consists of multiple surfaces. 
These surfaces are defined when the CAD model is created. Surfaces in the geometry model 
can be named in the CAD program that generates the geometry model. If the geometry 
model contains names for the defined surfaces, BoaGui will retain these names and will not 
allow you to edit the names. If the geometry model contains surfaces that have not been 
named, BoaGui will prompt you to name any surface for which you define properties. These 
names will be editable.}
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To assign a voltage to a surface, click the Voltage Add 
button beneath the table. This will bring up the Main 
Window containing the geometric model. Select the 
desired surface by pressing Ctrl-Left mouse button 
and pressing Enter. The Voltage Assignment dialog 
box in Figure 21 will appear. Enter the desired Name 
and Voltage and specify the Color. (If the surface is 
already named in the geometry model, the Name will 
not be editable.) Click OK to complete the assignment 
and the item will appear in the table.

To assign a surface charge density to a surface, click 
the Surface Charge Density Add button beneath the table. This will bring up the Main Window 
containing the geometric model. Select the desired surface by pressing Ctrl-Left mouse button 
and pressing Enter. The Surface Charge Density Assignment dialog in Figure 22 will appear. 
Enter the desired Name and Charge Density and specify the Color. (If the surface is already 
named in the geometry model, the Name will not be editable.)Click OK to complete the assign-
ment and the item will appear in the table.

To modify a surface property once 
it is defined, select the item in the 
table and click the Modify button. 
The appropriate dialog will appear 
and you can edit the values. To 
delete a surface property, select 
the item in the table and click the 
Delete button. 

3.8.2  Beam Optics Attributes 

The Beam Optics tab, shown in Figure 23, enables you to make the attribute assignments required 
for beam analyses. The screen includes sections for specifying the following:

FIGURE 21. Surface Voltage Assignment 
dialog

FIGURE 22. Face Surface Charge Density Assignment dialog box
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• Beam Optics 
Parameters 

• Emitter Assign-
ments

• External Magnetic 
Field 

• Optically Trans-
parent Parts 

• Optical Surface 
Assignments (Peri-
odic and Reflective 
surfaces). 

3.8.2.1  Beam Optic 
Parameters

The Beam Optic Parame-
ters section includes the 
following parameters: 

Emission Current Conver-
gence Criteria - This is 
one of the two conver-
gence criteria for the BOA 
algorithm.   The solution 
converges if both EQ 1 and EQ 2 are met.           

(EQ 1)

The default value is 0.005.

Potential Convergence Criteria - This is the second convergence criterion for the BOA algorithm. 
The solution converges if both EQ 1 and EQ 2 are met.         

(EQ 2)

 The default value is 0.005.

Charge Neutralization Factor - This parameter accounts for charge neutralization (ionic charges 
neutralizing electronic charges). Each particle charge is reduced by this factor. This value must be 
less than or equal to 1. The default value is 1 (i.e., no charge neutralization).

FIGURE 23. Attribute Assignment dialog, Beam Optics tab

1
Emission Currentprevious iteration
Emission Currentcurre nt iteration
--------------------------------------------------------------------------– Emission Current Convergence Criteria<

1
Maximum Potentialprevious iteration
Maximum Potentialcurre nt iteration
-------------------------------------------------------------------------------– Potential Convergence Criteria<
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Maximum Number of Secondary Generations - This parameter is enabled only when a secondary 
emitter is defined in the Emitter Assignments section. It defines the maximum number of possible 
secondary generations per one primary electron. 

3.8.2.2  Emitter Assignments 

The Emitter Assignments section allows you to add thermionic emitters, injected emitters and sec-
ondary emitters. The sections below describe the details for defining each emitter type. 

Note that BOAGui provides the capability to disable particular emitters for a simulation without 
having to delete them from the case. This feature is useful if you want to temporarily turn off 
some secondary emitters or certain thermionic emitters for a simulation but want to re-use them in 
subsequent runs. By definition, a beam analysis requires at least one enabled primary (thermionic 
or injected) emitter. BoaGui will issue a warning if there is not at least one primary emitter speci-
fied and enabled.

Thermionic Emitters

To add a thermionic emitter, click on 
the Thermionic Emitter Add button 
beneath the emitter table. This will 
bring up the main window contain-
ing the geometric model. Find the 
desired surface and select it by press-
ing Ctrl-Left mouse button. Click 
Enter to complete the selection. The 
dialog shown in Figure 24 will 
appear. 

Enter the desired Name and select a 
Color. (If the surface is already 
named in the geometry model, the 
Name will not be editable.) Use the 
Enable checkbox to enable or disable 
the emitter for the simulation. Dis-
abling an emitter allows you to tem-
porarily turn off an emitter without 
deleting it.

Enter the parameters in the Emission 
Properties box, including: 

• Number of Particle Launch Mesh 
Faces - This value is an estimate 
only. The exact number will be 
calculated when the initial mesh is generated.   

• Number of Particles per Launch Face

FIGURE 24. REPLACE (new Tag filed) Thermionic 
Emitter Parameters dialog
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• Number of Thermal Energy Levels per Launch Site 

• Number of Thermal Angles per Launch Site - This must be an odd number. BOA defines the 
angles such that one angle is always normal to the surface and the remaining angles form sym-
metrical pairs with respect to the normal.

• Total Number of Particles (Trajectories) - For convenience, the user interface displays the 
approximate Total Number of Particles (Trajectories). This is calculated as the product of the 
Number of Particle Launch Mesh Faces, Number of Particle per Launch Face, Number of 
Thermal Angles per Launch Site and Number of Thermal Energy Levels per Launch Site. (E.g., 
if the Number of Particle Launch Mesh Faces = 50, Number of Particle per Launch Face = 3, 
Number of Thermal Energy Levels per Launch Site = 2 and Number of Thermal Angles per 
Launch Site = 3, then the user interface will show Approximate Total Number of Emitted Parti-
cles = 900.) Keep in mind that since the number of launch mesh faces you enter is an approxi-
mation, this calculation is also an approximation. The exact number of emitted particles will be 
calculated when the initial mesh is generated. 

• Emitter Temperature - Enter in degrees C. 

• Emitter Work Function - Enter in electron Volts. Enter the value directly or by selecting a work 
function from the Find Work Function (optional) drop-down box. This drop-down box con-
tains a ‘library’ of work functions for commonly used materials. You can add materials to the 
library by selecting ‘Add Your Own Material’ in the drop-down box and entering the desired 
values in the Material Properties dialog. (You can also access the Material Properties dialog 
via the Tools->Material Properties menu. See Section 3.12.3 for details.) 

• Check the Temperature Correction checkbox to include a temperature correction factor. This 
optional correction is derived from Maxwellian energy distribution for low voltage region in 
the proximity of the thermionic emitting surfaces. The correction factor as a function of (Tc/V) 
is expressed as a series expansion given by Langmuir and et al.

• Check the Relativistic Correction checkbox to include a relativistic correction factor. This 
optional correction is for electron guns operating in relativistic regime. It is formulated from 
Child-Langmuir law and recasted into a series expansion by Lau and et al. as a function of 
(gamma - 1).

Enter the Meshing Parameters as follows:
• The Grid Present checkbox determines how the cathode spacing is defined. If a grid is present, 

check the box and enter the value for Cathode-to-Grid Spacing. If no grid is present, leave the 
box unchecked and enter the value for the Cathode-to-Anode Spacing. The units for the spac-
ing are the length units defined for the model (as defined in the geometry file). Note that the 
spacing value is approximate. It can vary +/-10%. 

• The Depth of Finer Mesh Region extended from Emitter parameter allows you to define a 
region of finer mesh around the emitter. It is used only when adaptivity is turned on (i.e., when 
Max Number of Adaptivity Passes is set to > 0 on the Execute BOA dialog). The region is 
defined as a virtual column of user-specified depth extending from the emitter surface. The 
mesh within the column will be adaptively refined to approximately the same mesh size as on 
the emitter surface. 
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Click OK to complete the emitter definition. The emitter will appear in the table.

Injected Emitters

To add an injected emitter, click on the 
Injected Emitter Add button beneath 
the emitter table on the Beam Optics 
tab (see Figure 23). This will bring up 
the graphics display window contain-
ing the geometric model. Find the sur-
face you want to define as the emitter 
and select it by pressing Ctrl-Left 
mouse button. Click enter to complete 
the selection. The dialog box shown in 
Figure 25 will appear. 

Enter the desired Name for the 
injected emitter and select a Color. (If 
the surface is already named in the 
geometry model, the Name will not be 
editable.) Use the Browse button to 
locate the Injected Beam file. Use the 
Enable checkbox to enable or disable 
the emitter for the simulation. Dis-
abling an emitter allows you to tempo-
rarily turn off an emitter without 
deleting it.

Specify the file format using the radio 
buttons in the File Format for Planar 
Emitter section. BOA supports four 
file formats: 

• BOA format

• Magic2D format

• Magic3D format

• Christine 3D format 

The selections associated with each format are described below. The file formats are defined in 
the Appendix. 

• BOA Format - The BOA file format is for a DC, Cartesian beam. It contains the 3D particle 
positions and velocities at the original injected surface/plane. If the specified emitter surface is 
a flat plane having a regular shape such as a circular disk or a rectangular plate, two options 
will be available:No Transformation Required and Transformation Required. Select No Trans-
formation Required if the beam, as defined in the file, can be used exactly as is (i.e., if the ini-

FIGURE 25. REPLACE (new Tag filed) Injected 
Emitter Parameters dialog
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tial particle positions in the file match the surface you designated as the injected emitter). If the 
two planes do not match, select Transformation Required and specify the Axis of Original 
Spent Beam. The original injected plane will be transformed to the actual injected plane. 

If the specified emitter surface is not a flat plane having a regular shape, only the No Transfor-
mation Required option will be available. The specified emitter surface must approximate the 
initial particle positions in the file.

• Magic 2D Format - The Magic2D file format is for a Polar beam. Number of Azimuthal Sec-
tions is the number of azimuthal coordinates that Boa uses to convert a Magic2D spent beam 
(which is an axisymmetric beam) to a 3D Cartesian beam. Skipped Particles per Timestep is 
the number of particles to be skipped per time step when reading the Magic2D/3D spent beam 
data to reduce computation costs. Enter ‘1’ to use all particles. Number of Skipped Timesteps is 
the number of time steps to be skipped when reading the Magic2D/3D spent beam data file to 
reduce computational costs. Enter ‘1’ to use all steps. 

This format is available only if the specified emitter surface is a flat plane having a regular 
shape such as a circular disk or a rectangular plate. The axis of the original spent beam (i.e., the 
spent beam defined in the file) must be the z axis. Thus, the original injected plane will always 
be the r plane normal to the z-axis, and the direction of the beam is assumed to always point to 
the direction of the positive z-axis. The original injected plane will be transformed to the actual 
injected plane.

• Magic 3D Format - The Magic3D file format is for a DC, Cartesian beam. As with the BOA 
format, it contains the complete 3D particle attributes at the original injected surface. If the 
specified emitter surface is a flat plane having a regular shape such as a circular disk or a rect-
angular plate, two options will be available: No Transformation Required and Transformation 
Required. Select No Transformation Required if the beam, as defined in the file, can be used 
exactly as is (i.e., if the initial particle positions in the file match the surface you designated as 
the injected emitter). If the two planes do not match, select Transformation Required and spec-
ify the Axis of Original Spent Beam. The original injected plane will be transformed to the 
actual injected plane. 

If the specified emitter surface is not a flat plane having a regular shape, only the No Transfor-
mation Required option will be available. The specified emitter surface must approximate the 
initial particle positions in the file.

Skipped Particles per Timestep is the number of particles to be skipped per time step when 
reading the Magic2D/3D spent beam data to reduce computation costs. Enter ‘1’ to use all par-
ticles. Number of Skipped Timesteps is the number of time steps to be skipped when reading the 
Magic2D/3D spent beam data file to reduce computational costs. Enter ‘1’ to use all steps. 

• Christine Format - The Christine file format is available only if the specified emitter surface 
is a flat plane having a regular shape such as a circular disk or a rectangular plate. Specify 
either Polar Coordinates or Cartesian Coordinates. The axis of the original spent beam (the 
spent beam defined in the file) is assumed to be the z-axis. Thus, the original injected plane 
will always be the xy or r plane normal to the z-axis, and the direction of the beam is assumed 
to point in the direction of the positive z-axis. The original injected plane will be transformed 
to the actual injected plane. 

The second section of the Injected Emitter Parameters dialog allows you to verify that the values 
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for the Number of Particles, the Injecting Current and the Injecting Power are what you expect. 
Click the Verify button to perform the verification. 

In the Meshing Parameters section, the Depth of Finer Mesh Region extended from Emitter 
parameter allows you to define a region of finer mesh around the emitter. It is used only when 
adaptivity is turned on (i.e., when Max Number of Adaptivity Passes is set to > 0 on the Execute 
BOA dialog). The region is defined as a virtual column of user-specified depth extending from the 
emitter surface. The mesh within the column will be adaptively refined to approximately the same 
mesh size as on the emitter surface. 

Click OK to complete the injected emitter definition. The injected emitter will appear in the Emit-
ter Assignments table on the Beam Optics tab of the Attribute Assignment Properties dialog.

Secondary Emitters

To add a secondary emitter, click on the 
Secondary Emitter Add button beneath 
the emitter table on the Beam Optics tab 
(see Figure 23). This will bring up the 
graphics display window containing the 
geometric model. Find the surface you 
want to define as a secondary emitter and 
select it by pressing Ctrl-Left mouse but-
ton. Click enter to complete the selection. 
The dialog box shown in Figure 26 will 
appear. 

Enter the desired Name and select a 
Color. (If the surface is already named in 
the geometry model, the Name will not 
be editable.) In the Number of Secondar-
ies field, enter the number of scattered 
electrons caused by one incoming parti-
cle. Use the Enable checkbox to enable 
or disable the emitter for the simulation. 
(Disabling an emitter allows you to temporarily turn off an emitter without deleting it)

In the Surface Emission Properties section, use the radio buttons to select the desired secondary 
model. The Yield option uses a simple Secondary Yield Coefficient to compute the yield. The 
Atomic Specification option uses a Monte Carlo simulation to compute the yield based on the val-
ues entered for Atomic Number, Atomic Mass and Material Density (in grams per cubic centime-
ter). 

For either secondary model, you can enter the required parameters in one of two ways: 

• Enter the parameter values directly, or

FIGURE 26. REPLACE (new Tag filed) Secondary 
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• Select a material from the Select a Surface Material drop-down box, located above the radio 
buttons. BOAGui will automatically populate the values associated with the selected material, 
in the Material Properties database for each parameter. (See Section 3.12.3 for a discussion of 
the Material Properties database.)

The Number of Secondaries is used with the Maximum Number of Secondary Generations 
(defined on the Beam Optics tab of the Assign Attributes dialog) as shown in the following exam-
ple: 

Assume Number of Secondaries = 3 and Maximum No. of Secondary Generations = 2. 
When a primary hits a secondary emitter, three electrons are emitted. When these three sec-
ondaries of the 1st generation hit another secondary emitter, another three electrons of the 
2nd generation are emitted. When these 2nd generation secondaries hit another secondary 
emitter they do not propagate any further, since there is a maximum of two generations.

Click OK to complete the emitter definition. The emitter will appear in the table.

To modify an emitter once it is defined, select the emitter in the emitter table and click the Modify 
button. The appropriate dialog will reappear and you can edit the values. To delete an emitter, 
select the emitter in the emitter table and click the Delete button. 

3.8.2.3  External Magnetic Field Options

The External Magnetic Field Options section on the Beam Optics tab (refer to Figure 23) enables 
you to define an external magnetic field. It is active when the Analysis menu is set to either ‘Elec-
tro/Magnetostatic Beam’ or ‘Electro/Magneto/Self Field Beam’. The drop down box contains the 
following options: 

1. Uniform Magnetic Flux Density

2. Boa Integrated Magnetic Case

3. Boa Magnetic Flux Density (fef file)

4. CCR Imported Magnetic Flux Density (bf file) 

5. Maxwell 3D Imported Magnetic Flux Density 

6. Maxwell 2D XY Imported Magnetic Flux Density 

7. Maxwell 2D RZ Imported Magnetic Flux Density

8. Pandira/Poisson RZ Imported Magnetic Flux Density 

9. 1D Axial Imported Magnetic Flux Density

Choose the desired option and a dialog will appear prompting you to enter the necessary parame-
ters. The specifics of the dialog will vary depending on the selected External Magnetic Field 
Option but, in general, all of the dialogs are similar and contain the same basic elements:

• Field Definition - The upper portion of the dialogs includes all parameters necessary to define 
the selected magnetic field type in three dimensions. 
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• Field Plot - The Plot to Verify Field button allows you to create a linear plot of the magnetic 
flux density in order to verify that the field is defined correctly.

• The Field Parameters section provides options for plotting the field data. To make this 
section active, check the Enable checkbox. {TBD, expand this section to include discus-
sion of all fields} 

• The Plot Parameters opens a hidden section of the dialog that provides additional controls 
such as Plot Characteristics (i.e., the appearance of the plot, including title, axis labels, 
etc.) {TBD: Refer to the Plot section earlier in the manual once that is complete.} 

The sections below describe the dialogs triggered by each External Magnetic Field Option: 

Uniform Magnetic Flux 
Density

Setting the External Magnetic 
Field Options dropdown box 
to ‘Uniform Magnetic Flux 
Density’ allows direct entry 
of a uniform magnetic flux 
density. This option brings up 
the dialog shown in 
Figure 27. Enter the three 
components of the uniform 
magnetic flux density (Bx, By, 
Bz) in Tesla. 

Boa Integrated Magnetic Case

Setting the External Magnetic Field Options dropdown box to 'Boa Integrated Magnetic Case' 
implies that you want to use the magnetic fields, which have been generated by BOA from the 
same geometry of the currently open case. To use this option, the following should be true: 

• the currently open case was initiated as a Magnetostatic case (Analysis menu item set to 'Mag-
netostatic'), 

• you have run the mesh for and executed that Magnetostatic case (so that the magnetic field 
exists), and

• you have now changed the Analysis type of the current case to either 'Electro/Magnetostatic 
Beam' or to 'Electro/Magneto/Self Field Beam').

FIGURE 27. Dialog for defining a Uniform Magnetic Flux Density
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If you create such a case in this way, then setting the External Magnetic Field Options dropdown 
box to ‘Boa Integrated Magnetic Case’ will bring up the message in Figure 28. Click ‘Yes’ to 

complete your External Magnetic Field selection. 

If a magnetostatic case exists in the current directory but is incomplete (i.e., the case started as a 
‘Magnetostatic’ case but the case was never executed), then setting the External Magnetic Field 
Options dropdown box to ‘Boa Integrated Magnetic Case’ will bring up the informational mes-
sage shown in Figure 29. This message indicates that you must go back and complete the Magne-
tostatic analysis before continuing with the integrated case. (That is, first change the Analysis type 
back to ‘Magnetostatic, mesh (is needed) and execute the case.) 

If there is no magnetostatic case in the current directory (i.e., the case was simply started as an 
‘Electro/Magnetostatic Beam’ or ‘Electro/Magneto/Self Field Beam’ analysis), then setting the 
External Magnetic Field Options dropdown box to ‘Boa Integrated Magnetic Case’ will bring up 
the informational message shown in Figure 30. This message explains how to create an integrated 
magnetostatic case. 

FIGURE 28. A Magnetostatic analysis exists in current case and is ready to use

FIGURE 29. A Magnetostatic analysis exists in current case but is not ready to use

FIGURE 30. A Magnetostatic analysis does not exist in the current case
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Boa Magnetic Flux Density (fef file)

Setting the External Magnetic 
Field Options dropdown box to 
‘Boa Magnetic Flux Density (fef 
file)’ enables you to use the 
magnetic flux density file gener-
ated by a previous BOA run. 
This option brings up the dialog 
box shown in Figure 31. 

Use the Browse button to locate 
the desired *.fef file. The *.fef 
format is a CCR proprietary for-
mat and it is defined in the 
Appendix. The remaining fields 
are defined as follows:

• The Field Scale is the scale 
factor for the imported magnetic field magnitude. Set it to ‘1’ to use the imported field as is. 

• The three components of the Translation Vector (CAD Axes) are required if the origin of the 
imported magnetic model is different from that of the geometry (CAD) model. The translation 
vector is used to match the two origins. For example, if the origin of the imported magnetic 
model is (2,1,5) and the geometry model is (3,0,0) then the translation vector is (3-2, 0-1, 0-5) 
= (1,-1,-5) where the elements of each tuple are the x, y and z coordinates respectively. 

• If the z-axis of the geometry model is different from the z-axis of the imported magnetic 
model, a coordinate rotation is also required. Use the Alignment of CAD Model to Z Axis drop-
down box to specify which coordinate axis of the CAD model (x, y or z) to match to the z-axis 
of the imported magnetic model. 

• Grid Unit is the length unit of the imported field, which can be different from the model. 

CCR Imported Magnetic Flux 
Density (bf file)

Setting the External Magnetic 
Field Options dropdown box to 
the ‘CCR Imported Magnetic 
Flux Density (bf file)’ option 
enables you to import a magnetic 
flux density file in the CCR for-
mat. This option brings up the 
dialog box shown in Figure 32. 

Use the Browse button to locate 
the desired CCR format Mag-
netic Flux Density file (*.bf file). 

FIGURE 31. Dialog for importing a Magnetic Flux Density File 
in Boa format

FIGURE 32. Dialog for importing a Magnetic Flux Density File in 
CCR format
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The *.bf format is a CCR proprietary format and is defined in the Appendix. Specify the Field 
Scale, Translation Vector (CAD Axes), Alignment of CAD Model to Z Axis and Grid Unit, if 
appropriate. (See BOA Magnetic Flux Density (fef file) section above for definitions of these 
parameters.) 

Maxwell 3D Imported Magnetic Flux Density

Setting the External Magnetic 
Field Options dropdown box to 
the ‘Maxwell 3D Imported Mag-
netic Flux Density’ option 
enables you to import a magnetic 
flux density file in the Maxwell 
3D format. This option brings up 
the dialog box shown in 
Figure 33. 

Use the Browse button to locate 
the desired Maxwell 3D file. 
Specify the Field Scale, Transla-
tion Vector (CAD Axes), Align-
ment of CAD Model to Z Axis 
and Grid Unit, if appropriate. 
(See BOA Magnetic Flux Den-
sity (fef file) section above for definitions of these parameters.) 

Maxwell 2D XY Imported Magnetic Flux Density 

Setting the External Magnetic 
Field Options dropdown box to 
the ‘Maxwell 2D XY Imported 
Magnetic Flux Density’ option 
allows you to import a magnetic 
field from Maxwell2D in XY 
coordinates. This option brings 
up the dialog box shown in 
Figure 34. 

Use the Browse button to locate 
the desired Maxwell 2D file. 
Specify the Field Scale, Transla-
tion Vector (CAD Axes), Align-
ment of CAD Model to Z Axis and 
Grid Unit, if appropriate. (See 
BOA Magnetic Flux Density (fef file) section above for definitions of these parameters.) 

FIGURE 33. Dialog for importing a Magnetic Flux Density File in 
Maxwell 3D format

FIGURE 34. Dialog for importing a Magnetic Flux Density File in 
a Maxwell 2D, XY coordinate format
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Use the Bz edit box to specify the uniform flux component (i.e., the z component of the magnetic 
flux) in Tesla.

Maxwell 2D RZ Imported Magnetic Flux Density

Setting the External Magnetic 
Field Options dropdown box to 
the ‘Maxwell 2D RZ Imported 
Magnetic Flux Density’ option 
allows you to import a magnetic 
field from Maxwell2D in RZ 
coordinates. This option brings 
up the dialog box shown in 
Figure 35. 

Use the Browse button to locate 
the desired Maxwell 2D file. The 
remaining fields are defined as 
follows:

• The Field Scale is the scale 
factor for the imported mag-
netic field magnitude. Set it to ‘1’ to use the imported field as is. 

• The Axial Translation (Tz) is used to match the z-coordinate of the origin of the imported flux 
to that of the corresponding axis of the CAD model (the beam axis). 

• If the z-axis of the geometry model is different from the z-axis of the imported magnetic 
model, a coordinate rotation is also required. Use the Alignment of CAD Model to Z dropdown 
box to specify which coordinate axis of the CAD model (x, y or z) to match to the z-axis of the 
imported magnetic model. 

• Btheta defines the 3rd uniform flux component (theta component of the magnetic flux) in Tesla. 

• The Largest Field Radius defines how far from the axis to compute Br 

• The Number of r Coordinates of the Field specifies how many lines to compute 

FIGURE 35. Dialog for importing a Magnetic Flux Density File in 
a Maxwell 2D, RZ coordinate format
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Pandira RZ Imported Mag-
netic Flux Density

Setting the External Magnetic 
Field Options dropdown box to 
the ‘Pandira RZ Imported Mag-
netic Flux Density’ option allows 
you to import a magnetic field 
from Pandira in RZ coordinates. 
This option brings up the dialog 
box shown in Figure 36. 

Use the Browse button to locate 
the desired Pandira file. The 
remaining parameters in the dia-
log box are identical to those for 
the Maxwell 2D RZ Magnetic Flux Density option. See the previous section for details.

1D Axial Imported Magnetic Flux Density

Setting the External Magnetic 
Field Options dropdown box to 
the ‘1D Axial Imported Mag-
netic Flux Density’ option 
allows you to import a 1D axial 
magnetic flux density file. This 
option brings up the dialog box 
shown in Figure 37. 

Use the Browse button to locate 
the desired file. The format for 
the 1D Axial file is defined in 
the Appendix. 

The remaining parameters in the 
dialog box are identical to those 
for the Maxwell 2D RZ Magnetic Flux Density option. See the previous section for details. Note 
that BOA calculates the off-axis or 2nd component of the flux (Br) internally. 

3.8.2.4  Optically Transparent Parts

FIGURE 36. Dialog for importing a Magnetic Flux Density File in 
a Pandira, RZ coordinate format

FIGURE 37. Dialog for importing a Magnetic Flux Density File in 
1D Axial format
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The Optically Transparent 
Parts section of the Attribute 
Assignment dialog Beam 
Optics tab enables you to 
define parts in the model as 
optically transparent. 

To make a part optically 
transparent, click the Add 
button next to the table 
shown in Figure 38. (Refer 
back to Figure 23 to see the 
complete Beam Optics tab.) 
This will bring up the graph-
ics display window contain-
ing the geometric model. 
Find the desired part and select it by pressing Ctrl-Left mouse button. Click enter to select. The part 
will appear in the table.

To delete optical transparency from a part, highlight the part in the table and click the Delete button. 

Optical transparency for a part can be enabled or disabled via the checkbox that precedes the part 
name in the Optically Transparent Parts table (see Figure 38). When the checkbox is checked, the 
part is enabled.   

3.8.2.5  Optical Surface Assignments

The Optical Surface Assignments section of the Beam Optics tab (Figure 39) is used to define Peri-
odic Surfaces and Reflective Surfaces in order to reduce the size of the model. (See Figure 23 for the 
complete Beam Optics tab of the Attribute Assignments Properties dialog) 

Periodic Surfaces

FIGURE 38. Optically Transparent Parts table (on the Beam 
Optics tab of the Attribute Assignments Properties dialog)

FIGURE 39. Optical Surface Assignments table (on the Beam 
Optics tab of the Attribute Assignments Properties dialog)
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Periodic surfaces are used to model very long parts. Periodic surface assignment entails specify-
ing two surfaces: an inlet surface and an outlet surface. When particles exit the outlet surface, par-
ticles with identical attributes (e.g., velocity, current) re-enter the inlet surface. In effect, it is as if 
the model is infinitely repeating itself. 

To add a pair of periodic surfaces, 
click on the Periodic Add button 
beneath the Optical Surface Assign-
ments table (shown in Figure 39). 
This will bring up the Periodic Sur-
faces Assignment dialog shown in 
Figure 40. To define the inlet peri-
odic surface, click the Select button 
in the Inlet Periodic Face section. 
This will bring up the window con-
taining the geometric model. Find the surface you want to define as the inlet periodic face and 
select it by pressing Ctrl-Left mouse button. Click enter to complete the selection. The Periodic 
Surfaces Assignment dialog will reappear. Enter the desired Name (if editable) and select a Color. 
(Remember, the Name field will not be editable for any surface that already has a name in the 
CAD model.) To define the outlet periodic face, repeat the same process using the Select button 
and Color dropdown box in the Outlet Periodic Surface section. Click OK to complete the assign-
ment. The periodic surfaces will appear as an entry in the table.

Reflective Surfaces

Reflective surfaces are used to model symmetry. During 
the simulation, when particles encounter reflective sur-
faces, they reflect back like a ray of light hitting a mirror. 
So, for example, instead of modeling a complete sphere, 
you could model one octant of the sphere (a symmetric 
1/8 ‘slice’) and then define the three ‘sliced’ faces as 
reflective. Similarly, for a Pierce gun, only 1/2 or 1/4 of 
the gun would be required. 

To add a reflective surface, click on the Reflective Add 
button beneath the Optical Surface Assignments table 
(shown in Figure 39). This will bring up the containing the geometric model. Find the surface you 
want to define as reflective and select it by pressing Ctrl-Left mouse button. Click enter to select. 
The dialog shown in Figure 41 will appear. Enter the desired Name (if editable) and select a 
Color. (Remember, the Name field will not be editable for any surface that already has a name in 
the CAD model.) Click OK to complete the assignment. The reflective surface will appear as an 
entry in the table.

To modify an Optical Surfaces entry once it is defined, select it in the table and click the Modify 
button. The appropriate dialog will reappear and you can edit the values. To delete an entry, select 
the entry in the table and click the Delete button. 

FIGURE 40. Periodic Surfaces Assignment dialog 

FIGURE 41. Reflective Surface 
Assignment dialog
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3.8.3  Magnetostatics Attributes

The Magnetostatics tab, shown in Figure 42 is enabled whenever the Analysis menu is set to the 
‘Magnetostatic’ analysis type. Use it to make the attribute assignments required for magnetostatic 
analyses. It contains three sections. The top section (Properties at the Part Level) specifies the 
basic magnetostatic properties for all parts in the model. The middle section (Current Density 
Attribute Assignment) specifies current densities for parts that are conductors. The bottom section 
specifies homogenous Dirichlet boundary conditions for surfaces. 

3.8.3.1  Properties at the Part Level 

The Properties at the Part Level section enables you to assign attributes to the parts that make up 
the geometric model. The table at the top of the section summarizes all of the parts in the geome-
try file. To modify a part’s properties, first select the part to make it active. Properties include:

Name - The part name is identical to the name provided in the geometry file. This property is not 
editable.

Color dropdown box - Specify a color for the part. 

Visible checkbox - Check/uncheck the box to show/hide the part in the graphics display region. 
BoaGui will initially set all parts to visible except for the background part. 

FIGURE 42. Attribute Assignment dialog box, Magnetostatics tab
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Opacity - Opacity is the translucency of a part. BoaGui uses it to draw the part in the graphics dis-
play window. It ranges from 1 to 0, going from no transmission of light through the part (opaque) 
to full light transmission (transparent). A part’s Opacity is editable only if it is set to Visible. 
(Notice that although by default the background part is set to invisible, if you change it to visible 
then its Opacity defaults to 0.8. This default value allows you to see the internal parts.) 

Relative Permeability section - The Relative Permeability for a part can be entered directly or 
looked up in the Materials Properties database. (See Section 3.12.3 for a description of the Mate-
rials Properties database.) Typically it is looked up, so by default the Format and Value fields are 
non-editable (i.e., the Edit directly checkbox between them is unchecked) and the Material drop-
down box is used to find the Relative Permeability. The fields in this section include:

Material - This drop-down box contains a list of materials that correspond to those in the 
Materials Properties database. Select the desired material and the Relative Permeability 
Value will appear along with the Format in which it is entered. 

Format - There are three possibilities for the Relative Permeability’s Format: 

• ‘Scalar’ - This type implies that the relative permeability is constant and uniform. That 
is, it is a single number. In the current version, most of the BOA provided materials in 
the Material Properties database have scalar relative permeabilities.

• ‘File’ - This type implies that the relative permeability is provided in a two-column 
data file containing the BH curve. In the current version, the BOA provided Material 
Properties database contains three materials whose Relative Permeability is provided 
in file format. 

• ‘Formula’ type [this feature is not yet functional] - Future versions of BOA will allow 
BH curves to be entered via equations (eg B = 0.2 * H^0.2). 

Edit Directly checkbox - The Edit Directly checkbox allows you to enter Relative Perme-
ability (both Format and Value) directly. Use this feature if you want to either:

• enter values independent of the Material Properties database (the material name will 
default to ‘Noname’ when it appears in the Parts table), or 

• edit the Relative Permeability of a user-provided material in the Material Properties 
database. 

You can also add materials to the Material Properties database by selecting ‘Add Your Own 
Material’ in the Material drop-down box. This will bring up the Material Properties dialog dis-
cussed in Section 3.12.3. (It can also be accessed via the Tools->Material Properties menu.) 

3.8.3.2  Current Density Attribute Assignment

The Current Density Attribute Assignment section on the Magnetostatics tab (Figure 43) enables 
the assignment of current densities to parts in the geometry model that are conductors. 

Current densities can be defined as one of three types:

• a Uniform Current Density (used for straight conductors),
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• an Analytic Cylindrical Solenoid (uniform cylindrical thickness) 

• a Directional Current (used for open conductors or for solenoids with more complex shapes or 
nonuniform cross section)    

Uniform Current Density 

This option should be used for straight conductors 
only. By definition, a part with a uniform current 
density can only be a straight conductor because 
the current density is uniform in both magnitude 
and direction.

To define a part with a uniform current density, set 
the Select Current Vector Type drop down box 
(located beneath the Current Density Attribute 
Assignment table) to ‘Uniform Current Density’ 
and click the Add Part(s) button. The main window 
containing the geometric model will become 
active. Select the desired part by pressing Ctrl-Left 
mouse button. Click Enter to complete the part selection. The dialog box shown in Figure 44 will 
appear. Enter the values for the three components of the current density. Click OK to complete the 
definition. The part will appear in the Current Density Attribute Assignment table. 

Analytic Cylindrical Solenoid

This option should be used for solenoid cylinders of uniform thickness. The geometry model for 
the solenoid must consist of either: 

• a single cylinder of uniform thickness, or 

FIGURE 43. Current Density Attribute Assignments table (on the Magnetostatic tab of 
the Attribute Assignments Properties dialog)

FIGURE 44. Uniform Current Density dialog 
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• two parts that make up a uniformly thick cylinder and intimately in contact; each part can be 
any angular fraction of the cylinder cross section (e.g. two 180 degree halves, or a 90 degree 
piece and 270 degree piece of a cylinder, etc.) 

To define a part as an analytic cylindrical 
solenoid, set the Select Current Vector Type 
drop down box to Analytic Cylindrical 
Solenoid and click the Add Part(s) button 
next to it. This will bring up the main win-
dow containing the geometric model. 
Select the desired part by pressing Ctrl-Left 
mouse button. Click Enter to complete the 
part selection. The dialog box shown in 
Figure 45 will appear. Enter the values for 
the Coil Current, select the Coil Axis, and 
set the Coil IR (inner radius) and the Coil 
OR (outer radius). 

If the chosen part represents the complete cylinder, click OK to complete the definition. If the 
cylindrical solenoid is composed of multiple pieces (as described above), use the Add More Parts 
button to select the other pieces to complete the cylinder. Click OK to complete the definition. 
The item will appear in the Current Density Attribute Assignment table. 

Directional Current 

The Directional Current option enables you to specify a current with a uniform magnitude but 
directionally varying along a conductor. This option requires an inlet face (to which the incoming 
current is normal) and an outlet face (to which the outgoing current is also normal). 

A directional current vector can be defined as open or closed. An open directional current vector 
should be used when the inlet and outlet faces do not overlap (e.g., a horseshoe or a C-Core con-
ductor). A closed directional current vector should be used for conductors with varying cross sec-
tion. (Solenoid cylinders of uniform thickness should use the Analytic Cylindrical Solenoid option 
discussed above rather than the Directional Current option. The Analytic Cylindrical Solenoid 
option is computationally faster and more accurate.) 

Note that a closed conductor does not physically have an inlet or outlet, however an inlet and out-
let must be specified so that boundary conditions can be prescribed for solving the current density 
sub-problem. For this option to work properly as a closed conductor, the geometry model must 
consist of two connecting parts (e.g., for a nonuniform cross section cylinder, the conductor 
should consist of two 180 degree halves, or a 90 degree piece and 270 degree piece of a cylinder, 
etc.)

To define a part as having a directional current vector, set the Select Current Vector Type drop 
down box to ‘Directional Current’ and click the Add Part(s) button next to it. This will bring up 
the main window containing the geometric model. 

FIGURE 45. Cylindrical Solenoid dialog 



BOA Version 4, User Manual v0.5 updates in progress[5/10] 43

If you are defining an open conductor, select the desired part (i.e., the single part that represents 
that open conductor) by pressing Ctrl-Left mouse button. Click Enter to complete the part selec-
tion and the dialog box shown in Figure 46 will appear. 

Enter the Current at Inlet 
Surface in Amps and 
uncheck the Closed Con-
ductor checkbox. To 
define the inlet surface, 
click on the Select button 
in the Current Inlet Sur-
face section. This will 
bring up the main window 
containing the geometry 
model. Select the desired 
surface by pressing Ctrl-
Left mouse button. Click 
enter to complete the 

selection. The Directonal Current Vector dialog box will reappear. Set the color for the inlet sur-
face using the Color dropdown box. Repeat the same process for the outlet surface using the 
Select button and Color dropdown box in the Current Outlet Surface section. Click OK to com-
plete the directional current vector definition. The part and surfaces will appear as an entry in the 
Current Density Attribute Assignment table.

If you are defining a closed conductor (solenoid), the process is similar. However, when you ini-
tially select the desired part, you select just one of the two parts representing the solenoid. On the 
Directional Current Vector dialog, leave the Closed Conductor check box checked. Pick one face 
for the inlet and the opposite end as the outlet to specify the current direction. Because the check-
box is checked, BoaGui will automatically find the other half and complete the current assign-
ment for you. (Note that, alternatively, you could achieve the same result by defining each half 
separately as having an open directional current. However, if you do this you must make sure the 
currents flowing in both parts are defined in the same direction.)

To modify any item in the Current Density Attribute Assignment table once it is defined, select it 
in the table and click the Modify button. The appropriate dialog will reappear and you can edit the 
values. To delete a current density definition, select it and click the Delete button. 

3.8.3.3  Homogeneous Dirichlet Boundary Condition Assignment

The Homogeneous Dirichlet BC (BN = 0) section on the Magnetostatics tab (Figure 47) enables 
you to specify surfaces for which the normal component of the magnetic flux density, Bn, will be 
set to zero. {TBD: ask Thuc or Mike to elaborate on when it makes sense to do this.}

FIGURE 46. Directional Current Vector dialog
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To add such a surface, click on Add button beneath the Homogeneous Dirichlet BC (BN = 0) 

table. This will bring up main window containing the geometric model. Find the desired surface 
and select it by pressing Ctrl-Left mouse button. Click enter to select. The dialog shown in 
Figure 48 will appear. Enter the desired Name (if editable) and select a Color. (Remember, the 
Name field will not be editable for any surface that already has a name in the CAD model.) Click 
OK to complete the assignment. The surface will appear as an entry in the table.

To modify any item in the Homogeneous Dirichlet 
BC (BN = 0) table once it is defined, select it in the 
table and click the Modify button. The above dialog 
will reappear and you can edit the values. To delete a 
surface from the table, select it and click the Delete 
button. 

FIGURE 47. Homogeneous Dirichlet BC (BN = 0) table (on the Magnetostatic tab of the 
Attribute Assignments Properties dialog)

FIGURE 48. Homogeneous Dirichlet 
BC (BN = 0) Assignment dialog
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3.8.4  Optimizer Attributes

The Optimizer tab, shown 
in Figure 49 is enabled 
whenever the Analysis 
sub-menu is set to Opti-
mizer (rather than Single 
Case) Use it to make the 
attribute assignments 
required for optimization 
runs. It contains four sec-
tions. The top section 
(Goal Functions) is used to 
specify the goals for the 
optimization. The Optimi-
zation Method defines the 
method used for the opti-
mization calculations. The 
Optimized Parameters sec-
tion defines the parameters 
to be optimized, and the 
bottom section defines the 
Execution parameters for 
the optimization run.

3.8.4.1  Goal Functions

This section includes two 
options for the optimization’s Goal Function: ‘Optics’ and ‘Minimize Surface Electric Field’. For 
an analysis including beam optics, both options are available. For an electrostatic analysis’, only 
the option the to minimize the surface electric field is available. 

When the Goal Function radio button is set to ‘Optics’, you can specify the Targets for the Beam 
Current, Beam Diameter and/or Beam Ripple. (Use the checkbox in front of each to indicate 
which to make active.) The Beam Ripple can be specified only when there is a magnetic field (i.e., 
when Analysis menu is set to either ‘Electro/Magnetostatic Beam’ or ‘Electro/Magneto Self Field 
Beam’). For each Target, specify a weight. The larger the weight, the more important that goal is 
in the goal function. All three targets are determined from the beam characteristics at multiple 
planes and then averaged for the goal function. These planes are specified in the Sampling Coor-
dinates section. Choose the beam axis (the Along Axis dropdown box), the beam direction (the 
Positive and Negative radio buttons), Position (plane coordinate), Number of Positions (planes) 
and Position Range. These ranges are centered at the specified position. Thus, if the plane Posi-
tion is 1.0" and the Position Range is +-0.75", then the minimum position would be 0.25" and the 
maximum position 1.75". The planar particle attributes are used to compute these beam character-
istics, and they need a beam centroid to be transformed to cylindrical coordinates. There are three 
options for specifying this centroid:

FIGURE 49.  Attribute Assignment dialog box, Optimizer tab
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• ‘All Particles’ - computes the centroid by a simple averaging of all particle (primary and sec-
ondary) coordinates on the plane,

• ‘Primary Particles’ - uses only primary particles (neglecting all secondaries), 

• ‘Input Coord’ - lets the user specify the centroid coordinates manually. 

Note that the first and the second option are the same if there are no secondary emissions.

When the Goal Function radio button is set to ‘Minimize Surface Electric Field’, use the Select 
Surface button to choose the surface on which to minimize the electric field. Only CAD named 
surfaces can be selected. (BoaGui will produce an error message if you do not select a named sur-
face.) Once selected, the surface Name and Tag appear on the dialog. The Clear button clears the 
current selection. (The Clear button is provided as a convenience only; strictly speaking it is not 
actually necessary. If another surface is selected surface via the Select Surface button, the previ-
ous selection is automatically cleared.) Note that only one surface for field minimization can be 
selected at a time in the current BOA version.

3.8.4.2  Optimization Method

The current BOA version includes two iterative sampling methods for Optimization Method. 
‘Nelder-Mead’ is the default method. It is very efficient and works well for smooth goal func-
tions. If the goal function is noisy, and ‘Nelder-Mead’ fails to converge, use ‘Implicit Filtering’ 
instead.

Both ‘Nelder-Mead’ and ‘Implicit Filtering’ require many goal function evaluations. In BOA 
Optimizer, each function evaluation (besides computing other internal variables) runs SolidWorks 
once and then runs BOA until convergence. 

3.8.4.3  Execution Parameters

The Execution section at the bottom of the dialog contains the execution parameters for the Opti-
mizer. The parameters in this section vary slightly, depending on the selected Optimization 
Method.

• Implicit Filtering method - The Optimizer will terminate if the Maximum Number of Function 
Evaluations is exceeded. (This criterion is not hard set. During the course of optimization, if it 
is exceeded, the optimization will not stop immediately but will proceed for many more itera-
tions before a complete stop.) In addition, the objective of the optimization is to drive the Goal 
Function values toward zero (which is unrealistic to achieve computationally) to obtain the 
optimal design. The Termination Tolerance tells the Optimizer an optimal configuration has 
been achieved if the goal function value is less than this tolerance. The Maximum Execution 
Hrs. tells the Optimizer to stop if the total CPU time exceeds this value. {may not be functional 
yet, but should be implemented soon.}. The Restart Previous Optimization check tells the Opti-
mizer to start the optimization using the previous "optimized" parameters, which would be 
updated and listed in the Optimized Parameters sub-window. The Scale Depth (applicable for 
‘Implicit Filtering’ only) is used to modify and scale the initial simplex when it encounters a 
stagnation to push the optimization forward.
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• Nelder-Mead method - The execution parameters are mostly the same as above. However, for 
Nelder-Mead, Maximum Number of Iterations is specified rather than Maximum Number of 
Function Evaluations. Execution terminates exactly when the number of iterations exceeds the 
Maximum Number of Iterations. Behind the scenes, the number of function evaluations in 
Nelder-Mead is several factors more. In addition, Scale Depth is not applicable.

3.8.4.4  Optimized Parameters

The Optimized Parameters section specifies the design parameters to be optimized. 

• Magnetic Field Position and Scale - For analyses that include a magnetic filed (Analysis set to 
‘Electro/Magnetostatic Beam’ or ‘Electro/Magneto Self Field Beam’), the top of the section 
specifies the initial, minimum and maximum axial translations of the field, axis of translation, 
and the initial, minimum and maximum field scales. (Init Axial Trans of B, Min Trans, Max 
Trans, Axis, Init Scale of B, Min Scale and Max Scale) For analyses that do not include a mag-
netic field (Analysis set to ‘Electrostatic’, ‘Electrostatic Beam’ or ‘Electrostatic Self Field 
Beam’), no optimization on the magnetic field position and scale is available so these fields are 
not enabled (as shown in Figure 49). 

• Geometry Parameters - The optimized geometry parameters are specified via design tables that 
are originally generated by SolidWorks and then converted to Excel spreadsheets. {Ask Mike to 
provide ‘how-to’ detail here.} These design tables must be added in the Optimized Parameters 
section. Each optimized geometry parameter is represented by a coordinate in the design table. 
The optimization routine initially sets the value in the design table to the Initial value, then var-
ied it from the specified Minimum to the Maximum. These reset design tables are then used by 
SolidWorks to update the geometry. In other words, these design tables are the interface 
between SolidWorks and the Optimizer. 

To add a geometry parameter, click 
the Add button next to the table. One 
of the dialogs shown in Figure 50 
will appear (depending on selected 
Goal Function). Use the Browse but-
ton to locate the Excel File design 
table. Enter the Parameter Name 
and the Cell location (the column 
number and row number in the 
Excel spreadsheet, e.g., B4). (Note 
that when the Goal Function is set to 
‘Optics’, the dialog includes a drop-
down box with two commonly used 
parameters: ‘k2aspacing’ and ‘kCur-
vatureRadius’; BoaGui will autofill 
the Parameter Name field when one 
of these parameters selected). The 

FIGURE 50. Adding an Optimized Parameter (top figure is 
for Goal Function set to ‘Minimize Surface Electric Field’; 
bottom figure is for Goal function set to ‘Optics)
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Minimum Value and the Maximum Value. Click OK and the geometry parameter will appear in 
the table in the Optimized Parameters section. 

To modify an entry in the table, select the desired row and click the Modify button. To delete an 
entry, select the desired row and click the Delete button. 

3.8.5  Misc Attributes

The Temporary Thermionic Emitter Thickness Parameters (internal CCR use only) section is for 
internal CCR use during the Beta testing period. 

3.9  Meshing Menu

The Meshing pull down menu, 
shown in Figure 51, controls 
generation of the initial mesh. 
You must generate the initial 
mesh prior to executing BOA.   
Keep in mind that, if adaptive 
meshing is used, then the mesh 
will be adapted after the first 
iteration of BOA. The sections 
below describe each of the 
menu items shown in 
Figure 51.

3.9.1  Setting Mesh Parameters

The Parameters menu item opens the Mesh Parameters dialog box, shown in Figure 52. The pri-
mary purpose of the dialog is to provide user control over the generation of the initial mesh, as 
follows: 

FIGURE 51. Meshing pulldown menu
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• The Global Mesh Refine-
ment section allows you to 
specify the global parame-
ters used for the initial 
mesh generation.

• The Local Mesh Refine-
ment section lets you spec-
ify mesh parameters to be 
used for specific entities in 
the geometric model.

• The Boundary Layer sec-
tion lets you specify mesh 
parameters for regions that 
extrude from specified sur-
face in the model.

• The Free Region section 
lets you specify mesh 
parameters for user-defined 
cylindrical regions any-
where within the bounding 
box of the model.

Note that if adaptivity is 
turned on (i.e., when Max 
Number of Adaptivity Passes 
is set to > 0 on the Execute 
BOA dialog), subsequent adaptive meshes can be finer, but never coarser, than the initial mesh, as 
specified on this dialog. 

In addition to the meshing parameters, this dialog provides the option to generate a log file when 
the mesh routine executes. The Create Log File checkbox defaults to checked (i.e., create log 
file). The log file contains statistics associated with the meshing routine, such as number of nodes, 
number of meshes, number of surfaces, etc. Typically there is no need to view the log file. It is 
available primarily for diagnostic purposes. To view the log file, click the Display Log File but-
ton.

3.9.1.1  Global Mesh Refinement

The Global Mesh Refinement section allows you to control the global parameters used for the ini-
tial mesh generation. It includes two types of refinements: Mesh Size and Curvature-based Refine-
ment. 

Mesh Size - When the Set Mesh Size checkbox is checked, the Type and the Size controls 
next to it become enabled. The Type dropdown box can be set to ‘Relative Size’ or ‘Abso-
lute Size’. With ‘Absolute Size’, enter the actual physical mesh size in the units designated 
for the analysis. (E.g., if the geometry model has the unit of inches, enter the absolute mesh 

FIGURE 52. Meshing Parameters dialog box
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size in inches.) ‘Relative Size’ is the mesh size relative to the largest edge of the box con-
taining the entity to be meshed. The value must be greater than 0 and less than or equal to 1. 
(0 is not a valid size.)

Note that a smaller mesh size translates into a denser mesh. For structured meshes, reducing 
the mesh size by half increases the mesh density by roughly a factor of 8 (i.e, 23). This rule 
of thumb is less accurate for more unstructured meshes. 

If the Set Global Mesh Size checkbox is unchecked, then the meshing routine defaults to a 
relative mesh size of 0.25.

Curvature-based Refinement - Curvature-based Refinement allows the mesh to be refined 
automatically to match the curvature of the entities in the geometric model. Checking the 
Set Curvature-based Refinement checkbox enables the two controls next to it. The Parame-
ter Factor is the size relative to the element size. More precisely in 2D, it is the ratio of the 
segment height to the arc chord, which is the element size. The Relative Mesh Size Limit is 
the minimum relative mesh size due to curvature refinement on all model entities with 
curved surfaces.

3.9.1.2  Local Mesh Refinement

The Local Mesh Refinement 
section enables you to con-
trol the size of the mesh for 
specific entities in the geom-
etry model. The table in this 
section is initially blank. 
Use the buttons beneath the 
table to set up local mesh 
refinements for specific sur-
faces, parts, and shells. A 
shell is defined as a thin part 
such as the grid shown in 
Figure 53. (The mesh defini-
tion for a shell includes 
additional parameters that 
provide for better meshing 
of thin parts.) FIGURE 53. For meshing, a grid is considered a shell (a part having a 

small thickness)
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To add a surface (or set of surfaces) to 
the Local Mesh Refinements table, click 
on the Add Surface(s) button. This will 
bring up the main window containing 
the geometric model. Find the desired 
surface and select it by pressing Ctrl-
Left mouse button. Click enter to 
select. The dialog shown in Figure 54 
will appear. 

Enter the desired Name (if editable) and 
select a Color. (The Name field will not 
be editable for any surface that already 
has a name in the CAD model.) Set the Mesh Size parameters (Type and Size) and the Curvature-
based Refinement parameters (Parameter Factor and Relative Mesh Size Limit) for the surface. 
(These parameters are defined in the Global Mesh Refinement section above. Here they have a 
similar meaning, however they apply only to the surface(s) specified.) To add more surfaces to the 
entry, use the Add Surface button. (This option is only available for surfaces that are not named in 
the model.) Click OK to complete the assignment. The surface(s) will appear as an entry in the 
table.

To add a part to the Local Mesh Refine-
ment table, use the Add Part button. 
The process for adding a part is nearly 
identical to the process for adding a 
surface, as described above. The dia-
log, shown in Figure 55, includes the 
same parameters discussed above. 

To add a shell to the Local Mesh 
Refinements table, click on the Add 
Shell button. This will bring up the 
main window containing the geometric 
model. Move the cursor to the part you 
want defined as a shell and select it by pressing Ctrl-Left mouse button. Click Enter to complete 
the selection. The dialog shown in Figure 56 will appear. Enter the desired Shell Name (if edit-
able). (The Shell Name field will not be editable for any part that already has a name in the CAD 
model.) 

FIGURE 54. Surface Local Mesh Refinement

FIGURE 55. Part Local Mesh Refinement
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With shell mesh refinement, you can 
specify the mesh size across the shell 
thickness (Normal) as well as along its 
surfaces (Tangential). These parame-
ters become active when you check 
the Set Anisotropic Mesh Size check-
box. In order for the GUI to determine 
the unit vector normal to the shell sur-
faces, you must specify one of the 
shell surfaces. Click on the Sel Surface 
button to bring up the main window 
containing the geometric model. Move 
the cursor to the desired surface (on 
the shell), press Ctrl-Left mouse button and Enter to select. The Shell Mesh Refinement dialog 
will reappear. Enter the desired Surface Name (if editable) and select a Color. (The Surface Name 
field will not be editable for any surface that already has a name in the CAD model.) You can also 
set the Curvature-based refinement parameters (same as discussed above). To complete the 
assignment, click OK. The shell will appear as an entry in the table. 

To modify a local mesh refinement entry once it has been defined, select it in the table and click 
the Modify button. The appropriate dialog will reappear and you can edit the values. To delete an 
entry from the table, select it and click the Delete button. 

3.9.1.3  Boundary Layers

Boundary Layers are lay-
ers of semi-structured 
meshes extruding from a 
prescribed surface (see 
Figure 57). They are useful 
if high field fidelity is 
desired in the neighbor of 
a particular surface.

To add a Boundary Layer 
Mesh, click on the Add 
button beneath the table. 
This will bring up main 
window containing the 
geometric model. Find the 
surface from which the 
boundary layer should 
extrude and select it by 
pressing Ctrl-Left mouse button. Click Enter to select. The dialog shown in Figure 58 will appear. 

FIGURE 56. Shell Mesh Refinement

FIGURE 57. Boundary Layer Meshes extruding from an anode. Here, 
there are four layers of equal thickness meshes.
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Enter the desired Name (if editable) and 
select a Color. (Remember, the Name 
field will not be editable for any surface 
that already has a name in the CAD 
model.) Make sure the Enable check box 
is checked. (This checkbox allows you to 
disable boundary layer meshes for a run 
without having to delete them from the 
case.) Select the desired Side (‘Vacuum 
side, ‘Solid side’ or ‘Both sides’). Set the 
Number of Layers and the Total Layer 
Thickness in the analysis units. Each layer 
will be of equal thickness. To add more 
surfaces to the entry, use the Add Surface 
button. (This option is available only for surfaces that are not named in the model.) Click OK to 
complete the assignment. The surface(s) will appear as an entry in the table.

To modify a boundary layer definition once it is entered, select it in the table and click the Modify 
button. The appropriate dialog will reappear and you can edit the values. To delete an entry from 
the table, select it and click the Delete button. 

3.9.1.4  Free Regions

Free Regions are user-defined cylindrical regions for which the user can define a mesh size. One 
reason for adding a free region is to get better resolution around the beam area in a beam analysis. 
This cylindrical region can be defined in one of two ways: 

• A Free Cylinder is defined by specifying two end face center points and a radius. The cylinder 
axis is the line connecting the two centers.

• A Surface-constrained Cylinder is defined by first selecting a surface and then defining a 
radius and a length. The surface center is internally computed; the cylinder axis originates from 
this center and is perpendicular to the constrained surface.

To add a Free Cylinder mesh, select the Free Cylinder radio button and click on the Add button 
beneath the table. This will bring up the dialog shown in Figure 59. 

FIGURE 58. Boundary Layer Mesh 
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Enter the desired Name and select a 
Color. Make sure the Enable check 
box is checked. (This checkbox 
allows you to disable free regions 
for a run without having to delete 
them from the case.) Set the 
desired Mesh Size. Define the 
cylindrical region by specifying 
Radius, and the two endpoints 
(First End Surface Center and Sec-
ond End Surface Center). These 
endpoints can be entered in one of 
three ways: 

• Direct entry allows you to enter 
the x, y, and z components of 
each point directly in the edit 
fields provided.

• Surface selection allows you to select two points anywhere on the surface of the model. Click 
the Surface Select button and the main window containing the geometry model will become 
active. Use the Ctrl-Left mouse button to select the first and second end points. Only points on 
surfaces can be selected. A small dot will appear for each endpoint and the xyz coordinates will 
automatically appear in the fields provided on the Free Cylinder Meshing dialog. 

• 3D select allows you to select two endpoints anywhere within the bounding box of the model. 
Click the 3D Select button and the main window containing the geometry model will become 
active. A line widget with two endpoints will appear. Use the Ctrl-Left mouse button to move 
the endpoints to their desired locations. To complete the selection, click 3D Select on the Free 
Cylinder Meshing dialog. The xyz coordinates will automatically appear in the fields provided. 

Click OK to complete the assignment. The free region will appear as an entry in the table.

To add a Surface-constrained Cylinder mesh, select the Surface-constrained Cylinder radio but-
ton and click the Add button. This will bring up the main window containing the geometry model. 
Find the surface on which to constrain the desired cylindrical region and select it by pressing Ctrl-
Left mouse button. Click Enter to complete the selection. The dialog shown in Figure 60 will 
appear. 

FIGURE 59. Free Cylinder Meshing dialog
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Enter the desired Name (if editable) 
and select a Color. (Remember, the 
Name field will not be editable for any 
surface that already has a name in the 
CAD model.) Make sure the Enable 
check box is checked. (This checkbox 
allows you to disable free regions for a 
run without having to delete them 
from the case.) Set the desired Mesh 
Size. Define the cylindrical region by 
specifying its Radius and Length (+/-). 
Specifying a positive length means the 
cylinder will be generated away from 
the solid part to which the surface is 
adjacent. Specifying a negative length means the cylinder will be generated into the part. You can 
also specify a nonzero Distance from Surface and the meshes will be created the specified dis-
tance away from the constrained surface. 

The Complete Surface button is provided for cases where the surface is broken into multiple 
pieces and does not have a CAD name. (A CAD named surface, even if split into multiple seg-
ments, could be selected as one entity, obviating the need for using this button.) For such a case, 
use the Complete Surface button to add the other pieces to complete the selection. Click OK to 
complete the assignment. The surface-constrained cylinder will appear as an entry in the table.

To modify a free region once it is defined, select it in the table and click the Modify button. The 
appropriate dialog will reappear and you can edit the values. To delete an entry from the table, 
select it and click the Delete button. 

3.9.2  Generating and Displaying the Initial Mesh

The next set of items on the 
Meshing pulldown menu (see 
Figure 61) control the genera-
tion and display of the initial 
mesh.

3.9.2.1  Generation of Initial 
Mesh 

The Generate Initial Mesh 
menu item initiates generation 
of the initial mesh. A DOS 
window will appear indicating 
progress during the mesh generation process. Once the process is completed, hit any key to close 
the DOS window and return control back to the user interface. You must generate the initial mesh 
before you execute BOA. 

FIGURE 60. Free Cylinder Meshing

FIGURE 61. Meshing pulldown menu
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3.9.2.2  Display of Initial Mesh

The Display Initial Mesh 
menu item turns the display 
of the initial mesh on and off 
in the main window. As 
shown in Figure 61, this item 
contain three sub-menus. The 
Complete item toggles the 
complete mesh on and off. 
The On Entities item toggles 
the mesh on and on for user-
selected entities. The Add/
Remove Entities menu item 
brings up the Entity Selector 
dialog shown in Figure 62. Use the Add Surface(s) and Add Region(s) buttons to add the desired 
surfaces and regions. {TBD: get definition of Region. in some cases it allows you to select whole 
parts and other times just a subsection of Part. Get explanation.} 

When the mesh is displayed, the menu item (either Complete or On Entity) will appear with a 
check mark in front of it. Note that you will only be able to see the mesh on the outer boundaries 
of the problem domain (i.e. on the outer boundaries of the background part). To see the internal 
mesh structure, use Extent Clipping described in the next section.

3.9.2.3  Extent Clipping for Initial Mesh

The Extent Clipping Initial Mesh menu item brings up the 
Mesh Extent Clipping dialog box shown in Figure 63. This fea-
ture allows you to remove sections of the mesh in order to view 
the internal structure. When the Clipping State radio buttons is set 
to Off, the graphics window displays the mesh on the outer 
boundaries of the problem domain. When the radio button is set 
to On, the XYZ ranges in the Specify Bounding Box Parameters 
to Clip Mesh section are used to determine which area of the 
mesh to display. Keep in mind that you can choose to include dis-
play of all or selected parts in the model geometry using the Visi-
ble checkbox on the Electrostatics tab of the Attribute 
Assignment window. 

A sample display is shown in Figure 64. Here an initial mesh was 
generated for a Pierce electron gun. Parts of the gun were turned off in the Attribute Assignment 
window to allow visualization of the interior. The user specified that mesh elements with X values 
less than 0 should be removed. Since whole elements are removed, the clipped surface can appear 

FIGURE 62. Entity Selector Dialog

FIGURE 63. Mesh 
Extent Clipping dialog 
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rather strange, as shown in the figure. Never the less, information on the mesh size and location 
can be determined. 

3.9.2.4  Initial Mesh Information

This Initial Mesh Informa-
tion menu item brings up the 
information dialog shown in 
Figure 65. It provides statis-
tic for the initial mesh, 
including: 

• number of regions, 

• number of faces, 

• number of edges, and 

• number or vertices.

3.9.2.5  Aborting Mesh Generation

To abort meshing while mesh generation is in progress, select the Abort Meshing menu item (the 
last item on the menu shown in Figure 61).

FIGURE 64. Extent clipping parallel to Y-Z plane at X=0. 

FIGURE 65. Initial Mesh Information
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3.10  Execute Menu

The Execute pull down 
menu, shown in Figure 66, 
controls the execution of the 
BOA program. It includes 
options for executing a Sin-
gle Case run, executing an 
Optimizer run, and moni-
toring a run (Job Monitor 
Parameters and Monitor 
Job). The sections below 
describe each of the menu 
items shown in Figure 66.

3.10.1  Executing a Single Case

The Single Case menu item opens the sub-menu shown in Figure 66. It includes: 

• Execute - Initiates the single case execution. 

• Generate Input Data Only - Generates only the input data set for the single case execution 
BOA can be executed using the command line, provided that the required input parameters and 
files are provided. This allows the user to make rapid or systematic changes to the input with-
out invoking the graphical user interface. For advanced users, this can result in a significant 
increase in efficiency. The necessary command line arguments for executing BOA are pro-
vided in the Appendix. The naming convention for the input data file is CaseName.att (where 
CaseName is the name of the current case). The file will be placed in the Case directory. 

• Abort Boa - This item allows you to abort a simulation in progress. This menu item is intended 
primarily for Beam Optics simulations. (Electrostatic and magnetostatic simulations run 
quickly so there is little need for an Abort function.) Prior to aborting, an informational mes-
sage will report the last iteration available for post-processing and give you the option to cancel 
or continue with the termination. The last iteration available for post-processing depends on 
the settings in the Beam Optics Parameters section of the Execute Boa dialog. 

FIGURE 66. Execute pulldown menu
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The first two menu items initiate the 
dialog shown in Figure 67. It includes 
sections for Field Solution Parameters, 
Beam Optics Parameters Logging 
Options, Restart and Execution Prior-
ity. These sections are discussed below. 

When you click Execute a DOS win-
dow will appear indicating progress 
during BOA execution. Once the pro-
cess is completed, hit any key to close 
the DOS window and return control 
back to the user interface. 

3.10.1.1  Field Solution Parameters

The Field Solution Parameters section 
of the Execute BOA dialog includes:

Integration Order - This parameter sets 
the order of the finite element. Enter 
either 1 (linear) or 2 (quadratic). Qua-
dratic integration is more accurate; 
however, it can take 3 to 4 times longer 
to reach a solution. The default value is 
1.

Max Number of Adaptivity Passes - 
This parameter sets the maximum number of times BOA will call the adaptive meshing routines 
for mesh refinement. Typically, this value will be 2 or 3; however, in some cases it may be advan-
tageous to set this to a lower value to reduce the turnaround time at the cost of accuracy. This may 
be particularly applicable during the early stages of the design. Setting the value to 0 will result in 
execution of BOA using only the initial mesh. The default value is 0. 

Adaptivity Objective - This parameter sets the accuracy objective for the adaptive meshing rou-
tines. Provided the number of adaptivity passes does not exceed the Maximum Number of Adap-
tivity Passes, the program will continue to invoke the mesh generation routines until the relative 
Energy Error Norm Estimate between the current iteration and the previous iteration is less than 
the Adaptivity Objective.   (The Energy Error Norm Estimate is a global value describing the 
accuracy of the solution. BOA computes this value internally based on the numerical solution. It 
is not an input parameter. See the Appendix for details.) The default value is 0.25.

The Use Last Adapted Mesh as Initial Mesh checkbox allows you to start a simulation using the 
last adapted mesh. This allows you to reduce the analysis time if you have already done an adap-
tive simulation with a good mesh, and want to repeat the analysis with some minor changes such 
as small increase/decrease in beam voltage, different convergence criteria, etc. In such a scenario, 

FIGURE 67. Execute dialog
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you can just turn off adaptivity (set Max Number of Adaptivity Passes = 0) and start with an 
already "good" initial mesh. 

3.10.1.2  Beam Optics Parameters

The Beam Optics Parameters section of the Execute BOA dialog is active when the Analysis type 
includes beam optics. This section contains the following parameters:

Number of Allowable Iterations - This parameter is the maximum number of iterations allowed in 
the BOA algorithm. If the solution does not converge after the specified number of iterations, 
BOA will stop the analysis and exit. The default value is 10.   

Min Num of Iterations - The minimum number of iterations performed in the BOA algorithm. 

Adaptivity Only... Radio Buttons - These radio buttons control how often BOA calls the adaptivity 
routine. It is enabled when Max Number of Adaptivity Passes > 0. Options include performing 
adaptivity for: 

• the first iteration only, 

• the first three iterations, or 

• after a user-specified number of iterations. 

(Note that the first iteration does not include particles. The self-consistent method, which 
BOA uses to push particles, iterates on the electric field and emission current until their nor-
malized relative errors are less than Electric Field Convergence Criterion and Emission 
Current Convergence Criterion, respectively, (both criteria are specified on the Beam 
Optics tab of the Attribute Assignment Properties dialog), or until the number of iterations 
exceeds the Number of Allowable Iterations. In the first iteration there are no particles yet, 
thus the electrostatic field is solved without particles before any can be pushed. Adaptive 
meshing is performed using the electric field. Therefore, if the first radio button is selected 
(adaptivity for first iteration only), no particles are involved.

Max Number of Self Field Calc and Self Field Relative Tol. - These parameters are enabled when 
the Analysis Type is either ‘Electrostatic/Self Field Beam’ or ‘Electro/Magneto/Self Field Beam’. 
With the self field calculation, the normalized relative energy norm of the self field of the previ-
ous self field iteration to the present is compared with the Self Field Relative Tolerance. If the nor-
malized relative energy norm is less, the self field solution converges. Also, if the number of self 
field iterations exceeds the Max Number of Self Field Calc., the self field solution also stops.

In summary the self field calculation algorithm is:

a. The beam without the self field is run until it converges

b. The converged beam current in (a) is used to compute the self field

c. With the just-computed self field kept frozen, the beam is run again until convergence

d. Steps (a)-(c) are repeated until the number of self field iterations exceeds the Max Number 
of Self Field Calc or the relative energy norm of the present to the previous iterated self field 
is less than the Self Field Relative Tolerance.
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Output Solution and Source Fields Every {N} Iterations - This parameter controls how often the 
solution and source fields are output to results files. A value of -1 (the default value) means the 
solution and source fields are written to files for the first two iterations (the 0th1 and 1st iterations) 
and for the last iteration. This is the case regardless of whether or not the solution converges. 

Example: If you set this value to 3 and the simulation stops at the 14th iteration, then the solution 
is written to files at 0th, 1st, 4th, 7th, 10th, 13th and lastly 14th iterations. If you abort the job at 
the 9th iteration, you can still obtain the results of the last written iteration, which in this case 
would be the 7th iteration. Alternatively, if you set this value to 5 and abort at the 9th iteration, 
you have only the 6th iteration available. If you use the default value of -1 and abort at the 9th 
iteration, you have only the 1st iteration to postprocess. 

Output Trajectory Data Every {N} Iterations - This parameter controls how often the trajectory 
data is output to results files. A value of -1 (the default value) means the trajectory data is written 
to a file for the first two iterations (the 0th and 1st iterations) and for the last iteration. This is the 
case regardless of whether or not the solution converges. 

3.10.1.3  Logging Options

The Logging Options section provides options for showing the run log real time (Log to Screen 
checkbox) and creating a log file (Log to File checkbox). The log filename defaults to [Case 
Name]_.log. Use the Log File Name edit box to change the filename if desired. The log file is 
placed in the case directory. The log file can be accessed within BoaGui from the View Results 
pulldown menu. 

3.10.1.4  Restart 

The Restart section will be active if iterations from a previous BOA run exist. To restart a previ-
ous execution of Boa, check the Enable box then choose the particle iteration from the Select Iter-
ation drop down box. The iterations available for selection are based on you selections for both 
Output Solution and Source Fields Every {N} Iterations and Output Trajectory Data Every {N} 
Iterations, described in the previous section. 

3.10.1.5  Execution Priority 

The Execution Priority section gives you some control over how much of your computer’s 
resources are used when executing BOA. If you want the computer to spend less time executing 
BOA and more time on your other programs, change the Priority Level from ‘Normal’ to ‘Lower’ 
or ‘Lowest’.

3.10.2  Executing an Optimizer Case

The Optimizer menu item... {TBD. waiting for Optimizer example from M in order to see dialogs. 
(can’t run without Solidworks)} 

1. The 0th iteration of a beam simulation is the very first iteration with NULL space charge. From the 1st iteration on, 
space charge will be present due to particle motion.
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3.10.3  Monitoring a Beam Optics Run

The two Job Monitoring menu items 
enable allow you to dynamically monitor 
the convergence of a beam optics simula-
tion. As shown in Figure 68, the Job 
Monitor Parameters menu item allows 
you to select the desired parameters for 
plotting: Current, Current Error and/or 
Potential Error. The Monitor Job menu 
item lets you toggle the monitoring on 
and off. The convergence plot appears in 
the lower right hand region of the BoaGui 
as shown in Figure 69. The convergence plot is automatically updated behind the scene as the 
beam simulation progresses. 

FIGURE 68. Job Monitoring Parameters

FIGURE 69. BOAGui shown with Job Monitoring On for a beam optics simulation 
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3.11  View Results Menu 

The View Results pulldown menu, shown in 
Figure 70, provides access to all results, includ-
ing: Electrostatics (available for electrostatic 
analyses only), Magnetostatics (available for 
magnetostatic analyses only), and Beam Analysis 
(available for analyses that include beam optics). 
The menu also enables you to view the execution 
log (View Run Log), generate a summary output 
file for the case (Generate Case Summary) and 
view the log file for optimization cases (View 
Optimization Log).

3.11.1  Viewing Electrostatic Results

The Electrostatics menu item will be active 
after completion of an electrostatic analysis. 
The first time you select this menu item fol-
lowing BOA execution, BoaGui will display 
the informational message shown in 
Figure 71. This message indicates that the 
Electrostatic Field Postprocessor must be run 
in order to generate the files necessary for 
display. Click ‘Yes’ and wait for the postpro-
cessor to complete. 

FIGURE 70. View Results Pull-down Menu

FIGURE 71. Postprocessor Informational Message 
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The default electrostatic results will appear in the main window and the Electrostatic Display 
Parameters dialog will automatically pop up on top as shown Figure 72. The displayed results 

correspond to the default settings on the Electrostatic Display Parameters dialog: Display Vector 
Field (E) set to ‘On’ and Display Scalar Field set to ‘V’ (i.e., display the voltage contours). 

This Electrostatic Display Parameters dialog is shown more clearly in Figure 73. It includes the 
following sections:

• Iteration Selection - For beam analyses, the dropdown in the upper right corner of the dialog 
specifies the iteration for which to display the Electrostatic results. The contents of the drop-
down box correspond to the saved iterations of the last run (as defined by the parameter Output 
Solution and Source Fields Every {N} Iterations on the Execute dialogs). The default iteration 
is the final iteration. 

• 0D/1D Display - The upper left portion of the dialog provides buttons for accessing the Single 
Point Electrostatic Field Extractor dialog (via the Data Point button) and the Electrostatic 
Line Plotter dialog (via the Line Plot button). 

FIGURE 72. Electrostatic results (default settings) 
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• 2D/3D Display - The majority of the dialog is devoted to the controls for 2D and 3D display of 
the electrostatic results. This section is discussed next.

3.11.1.1  2D/3D Display

The 2D/3D section of the Electrostatic Display Parameters dialog provides controls for configur-
ing the 2D and 3D display of the electrostatic results. It contains the following controls:

FIGURE 73. Electrostatic Display Parameters dialog
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The Surface/Part Display 
radio buttons control 
whether the results are 
shown for the whole geome-
try (‘Parts’) or selected Sur-
faces (‘Surfaces’). The 
radio buttons initially 
default to ‘Parts’. To view 
results for specific surfaces 
instead, change the radio 
button to ‘Surfaces’. The 
dialog shown in Figure 74 
will pop up. Initially the 
table will be blank. To spec-
ify a surface, click the Add Surface radio button. This will bring up the main window containing 
the geometric model. Find the desired surface and select it by pressing Ctrl-Left mouse button. 
Click Enter to select. {TBD: Integrate email response 3/19/10; resolve open issues; also note that 
when the surface does not have a CAD name, by convention it will be named in the GUI as 
SimFace_xx where xx is its tag.}Click OK to close the Surface Selector dialog.

The Display Vector Field radio buttons turn the electric vector field display on and off. Figure 75 
shows an example of Display Vector Field set to ‘On’.

The Electric Field Parameters section con-
trols the appearance of the electric vector 
field display. This section is inactive if the 
Display Vector Field radio button is set to 
‘Off’. The parameter settings include the size 
of the vector arrows (Vector Scale Factor) 
and the Displayed Min and Max values for the 
field. The Displayed Min and Max values ini-
tially default to the Calculated Min and Max 
values. The Calculated Min and Max values 
appear for reference (this makes it easy to 
reset the values). The Display Legend check-
box turns the legend on and off and the radio 
buttons labeled Horizontal and Vertical dic-
tate the legend placement. 

The Display Scalar Field radio buttons turn the display of the various scalar fields on and off. 
Options include: 

• ‘Off’ (does not display any scalar fields) 

• ‘Ex’ (displays magnitude of the x component of the electric field) 

• ‘Ey’ (displays magnitude of the y component of the electric field)

• ‘Ez’ (displays magnitude of the z component of the electric field)

FIGURE 74. Surface Selector dialog

FIGURE 75. Display of Electric Vector Field
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• ‘Emag’ (displays magnitude of the total electric field)

• ‘V’ (displays voltage)

• ‘Rho’ (displays charge density) (applies to electrostatic beam analyses only) 

The Scalar Field Parameters section is active when the Display Scalar Field radio buttons are set 
to something other than ‘Off’. The Show Contour checkbox controls the appearance of the scalar 
field contour plot. If the checkbox is unchecked, the scalar field appears as a standard continuous 
contour plot like the ones shown in Figure 76. (The left-hand figure shows the contour plot for the 

outside of the meshed problem space. The right-hand figure uses extent clipping to reveal the 
internal structure. Extent clipping is discussed in a subsequent section.) Alternatively, if the Show 
Contour checkbox is checked, you specify Number of Contours and the display will group similar 
values into the specified number of discrete iso-surfaces as shown in Figure 77. 

The Displayed Min and Max values dictate the 
upper and lower values displayed. These values 
initially default to the Calculated Min and Max 
values. (The Calculated Min and Max values 
appear for reference, making it easy to reset the 
values.) The Display Legend checkbox turns 
the legend display on and off, and the radio but-
tons labeled Horizontal and Vertical dictate the 
legend placement. 

Initial (or Adapted) Mesh - This section con-
trols the display of the mesh. It refers to the last 
mesh used in generating the results, either Ini-
tial (if Adaptivity is off) or Adapted (if adaptiv-
ity is on). The Display Mesh radio button 
shows/hides the mesh. The Show Mesh Outline 
checkbox displays an outline of the mesh. 
Figure 79 shows an example of the Adapted 

FIGURE 76. Voltage field contour plots, with the Show Contours checkbox unchecked (Right-hand 
figure uses extent clipping) CHANGE TO MATCH ORIENTATION BELOW

FIGURE 77. Voltage field contour plot, 
with Show Contours checked (i.e., iso -
surfaces of voltage)
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Mesh turned On, the scalar field set to voltage and extent clipping used to remove a portion of the 
adapted mesh.

The Clipping State section, shown in Figure 78, 
allows you to remove sections of the displayed results 
in order to view the internal structure. When the Clip-
ping radio button is set to ‘On’, the XYZ ranges (x 
Min, x Max, y Min, y Max, z Min, z Max) are used to 
determine which portion of the results to display. The 
ranges initially default to the full range of the problem 
space. For reference, these default values appear 
above each edit box (this makes it easy to reset the 
values). The units for all values (shown in parentheses 
after the words “Clipping state”) are the models units. 
Changes to the ranges do not take effect in the graph-
ics window until you click the Apply button (or hit 
Enter). 

Figure 79 shows two examples of extent clipping. In both, the clipping range corresponds to the 
values shown in Figure 78. In the left-hand figure, the electric vector field is ‘On’ and the scalar 
field is set to ‘voltage’ with Show Contours checked. In the right-hand figure the scalar field is set 
to ‘voltage’ with Show Contours unchecked and the mesh display is set to ‘On’.   

FIGURE 78. Clipping State section of the 
Electrostatic Display Parameters dialog

FIGURE 79. Extent clipping for two different result displays. Left-hand figure shows Voltage On (with 
Show Contours checked) and Vector Electric Fields On. Right-hand Figure shows Voltage On (with 
Show Contours unchecked) and Mesh On. Extent Clipping is set as shown in Figure 78.
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The Scalar Slicing button 
(located beneath the Scalar 
Field radio buttons) accesses the 
Scalar Field Cut Plane dialog. 
The dialog allows you to define 
a plane anywhere within the 
problem boundary and view the 
scalar field distribution on that 
plane. (The scalar field shown 
corresponds to the selected radio 
button on the Electrostatic Dis-
play Parameter dialog.) The 
Scalar Field Cut Plane dialog is 
divided into the following sec-
tions:   

Cut Plane Normal Specification 
- Use the slider bars to specify 
the exact position of the cut 
plane. Controls include: Angle 
from the Z-axis (from 0 to 180 degrees), Angle from the X-axis (from 0 to 360 degrees) and Nor-
malized Distance from Center Along Normal (slides the plane along the normal to the surface). 
You can also enter specific values for these parameters in the edit boxes provided rather than use 
the slider bars. For Normalized Distance from Center Along Normal, you can enter in the distance 
in the model units (Model) or normalized units (Norm).

Contour Specifications - This 
section controls the display of 
the scalar field on the cut 
plane. Use the Show Contours 
checkbox to toggle the display 
between contour lines 
(checked) and a continuous 
color contour plot 
(unchecked). When viewing 
contour lines, define the con-
tour range by specifying the 
Number of Contours to be dis-
played and the Minimum Volt-
age and Maximum Voltage 
that define the range. Note 
that changes do not take effect 
in the graphics display until 
you click the Apply button (or 
the Enter key). 

FIGURE 80. Scalar Field Cut Plane dialog

FIGURE 81. Scalar Field Cut Plane 
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Viewing Parameters - The Set Opacity slider bar sets the opacity of the scalar cut plane. To hide 
the cut plane, set the slider bar to zero. The Line Width sets the thickness of the contour lines. It 
applies only when the Show Contours checkbox is checked. 

Clipping State - This radio button turns the clipping state on and off. For an explanation of Clip-
ping State, see discussion of the Clipping State section of the Electrostatic Display Parameters 
dialog in the section below.) 

The Close button closes the Scalar Field Cut Plane dialog and returns to the Electrostatic Display 
Parameters dialog, shown in Figure 73. 

{TBD: discuss Hide vs. Exit; Also do more bug-checking to see if I can reproduce the odd behav-
ior I initially saw when using Hide on the jlab klystron case.} 

3.11.1.2  01/1D Display (Line Plots & Data Point Extraction)

3.11.1.2.1  Line Plots

The Line Plot button in the 
0D/1D section of the Electro-
static Display Parameters 
dialog (shown in Figure 73) 
brings up the Electrostatic 
Line Plotter dialog shown in 
shown in Figure 82. This dia-
log enables you to create line 
plots for various fields. Use 
the Field to Plot radio buttons 
to select the desired field:

• ‘Voltage’

• ‘Charge Density’ (applica-
ble for electrostatic beam analyses only) 

• ‘Electric field, E’ - Use the checkboxes to select ‘x Comp’, ‘y Comp’, ‘z Comp’ or ‘Mag’ (the 
x component, y component, z component or total magnitude of E, respectively)

• ‘Electric Flux Density, D’ - Use the checkboxes to select ‘x Comp’, ‘y Comp’, ‘z Comp’ or 
‘Mag’ (the x component, y component, z component or total magnitude of D, respectively)

To specify the desired line for which to plot the selected field, you must identify a Starting Point 
and an Ending point. The dialog provides several options for identifying these two points: 

• Direct entry - Allows you to enter the x, y, and z components of each point directly in the edit 
fields provided on the Electrostatic Line Plotter dialog (e.g., Starting Point x, Starting Point y 
etc.) 

FIGURE 82. Electrostatic Line Plotter dialog 
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• Surface Selection - Allows you to select two points anywhere on the surface of the model. 
Click the Surface Select button and the main window containing the geometry model will 
become active. Use the Ctrl-Left mouse button to select the first and second end points. Only 
points on surfaces can be selected. A small dot will appear for each endpoint and the xyz coor-
dinates will automatically appear in the fields provided on the Electrostatic Line Plotter dialog 
(e.g., Starting Point x, Starting Point y etc.). 

• 3D Selection - Allows you to select two endpoints anywhere within the bounding box of the 
problem space. Click the 3D Select button and the main window containing the geometry 
model will become active. A line widget with two endpoints will appear. Use the Ctrl-Left 
mouse button to move the endpoints to their desired locations. To complete the selection, click 
3D Select on the Electrostatic Line Plotter dialog. The xyz coordinates will automatically 
appear in the fields provided on the Electrostatic Line Plotter dialog (e.g., Starting Point x, 
Starting Point y etc.). 

Once you specify the desired field and the desired line, click the Plot button. The resulting line 
plot will appear in the main window, as shown in Figure 83. In this case, the line plot corresponds 
to the settings shown in Figure 82. 

FIGURE 83. Voltage Line Plot
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The Plot Parameters Open button opens a hidden portion at the bottom of the Electrostatic Line 
Plotter dialog. This section {TBD: discuss here and/or reference back to the earlier Plot Parame-
ters section.} 

To exit the Electrostatic Line Plotter dialog, click the exit button and control will be returned to 
the Electrostatic Display Parameters dialog. 

3.11.1.2.2  Data Point Extraction

The Data Point button in the 
0D/1D section of the Electro-
static Display Parameters 
dialog (shown in Figure 73) 
brings up the Single Point 
Electrostatic Field Extractor 
dialog shown in Figure 84. 
This dialog enables you to 
extract the value of the 
desired field at a particular 
point. Use the Field to Inspect 
radio buttons to select the 
desired field:

• ‘Voltage’

• ‘Charge Density’ (applica-
ble for electrostatic beam 
analyses only) 

• ‘Electric field, E’ 

• ‘Electric Flux Density, D’ 

There are three different ways to specify the desired point: 

• Direct entry - Allows you to enter the x, y, and z components of the point directly into the edit 
fields provided on the Single Point Electrostatic Field Extractor dialog (Point Location x, y & 
z). 

• Surface Selection - Allows you to select the point anywhere on the surface of the model. Click 
the Surface Select button and the main window containing the geometry model will become 
active. Use the Ctrl-Left mouse button to select the point. Only points on surfaces can be 
selected. A small dot will appear for the selected point and the xyz coordinates will automati-
cally appear in the fields provided on the Single Point Electrostatic Field Extractor dialog 
(Point Location x, y & z). 

• 3D Selection - Allows you to select the point anywhere within the bounding box of the prob-
lem space. Click the 3D Select button and the main window containing the geometry model 
will become active. A 3-plane widget will appear. Use the Ctrl-Left mouse button to move the 
planes to their desired positions. To complete the selection, click 3D Select on the Single Point 

FIGURE 84. Single Point Electrostatic Field Extractor
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Electrostatic Field Extractor dialog. The xyz coordinates of the point represented by the inter-
section of the three planes will automatically appear in the fields provided on the Single Point 
Electrostatic Field Extractor dialog (Point Location x, y & z). 

Once you specify the desired 
field and the desired point, 
click the Extract button. The 
resulting value(s) will appear 
in the appropriate Field Value 
at Selected Point box(es), as 
shown in Figure 85. Note that 
when Field to Inspect is set to 
‘Electric Field’ or ‘Electric 
Flux Density’, the Field 
Value at Selected Point 
includes values for the x, y 
and z components as well as 
the total magnitude of the 
field. 

To exit the Single Point Elec-
trostatic Field Extractor dia-
log, click the Exit button and 
control returns to the Electrostatic Display Parameters dialog. 

3.11.2  Viewing Magnetostatic Results

{THIS SECTION IS INCOMPLETE. Complete after I get new Magnetostatic example from MR}

The Magnetostatics menu item will be 
active after completion of a magnetostatic 
analysis. The first time you select the Mag-
netostatics menu item following BOA exe-
cution, BoaGui will display the 
informational message shown in Figure 86. 
This message indicates that the Magneto-
static Field Postprocessor must be run in 
order to generate the files necessary for dis-
play. Click ‘Yes’ and wait for the postprocessor to complete. 

{TBD - waiting for case to complete this section}

FIGURE 85. Results from Single Point Electrostatic Field Extraction

FIGURE 86. Postprocessor Informational Message 
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The default magnetostatic results will appear in the main window and the Magnetostatic Display 
Parameters dialog will automatically pop up on top as shown Figure 87. The displayed results 

correspond to the default settings on the Magnetostatic Display Parameters dialog: Magnetostatic 
Flux Density radio button selected, Display Vector Field set to ‘On’ and Display Vector Field 
Component set to ‘none’. 

This Magnetostatic Display Parameters dialog is shown more clearly in Figure 88. It includes the 
following sections:

• {Iteration Selection - confirm this has been removed} IT HAS. UPDATE ALL PICS.

• 0D/1D Display - The upper left portion of the dialog provides buttons for accessing the Single 
Point Magnetostatic Field Extractor dialog (via the Data Point button) and the Magnetostatic 
Line Plotter dialog (via the Line Plot button). 

FIGURE 87. Magnetostatic results (default settings) GET REAL CASE PICTURE
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• 2D/3D Display - The majority of the dialog is devoted to the controls for 2D and 3D display of 
the magnetostatic results. This section is discussed next.

3.11.2.1  2D/3D Display

The 2D/3D section of the Magnetostatic Display Parameters dialog provides controls for config-
uring the 2D and 3D display of the magnetostatic results. It contains the following controls:

FIGURE 88. Magnetostatic Display Parameters dialog 
(UPDATE: iteration selection gone & MAGNETIC FIELD 
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The Surface/Part Display 
radio buttons control 
whether the results are 
shown for the whole geome-
try (‘Parts’) or selected Sur-
faces (‘Surfaces’). The 
radio buttons initially 
default to ‘Part’. To view 
results for specific surfaces 
instead, change the radio 
button to ‘Surfaces’. The 
dialog shown in Figure 89 
will pop up. Initially the 
table will be blank. To specify a surface, click the Add Surface radio button. This will bring up the 
main window containing the geometric model. Find the desired surface and select it by pressing 
Ctrl-Left mouse button. Click Enter to select. {TBD: Integrate email response 3/19/10; resolve 
open issues; also note that when the surface does not have a CAD name, by convention it will be 
named in the GUI as SimFace_xx where xx is its tag.}Click OK to close the Surface Selector dia-
log. 

The Vector Field Type radio butttons control the type of vector field displayed: 

• ‘Magnetic Flux Density’,

• ‘Current Density Vector’, or 

• ‘Magnetic Field’. 

The Display Vector Field radio buttons turn the selected vector field on and off. Figure 90 shows 
an example of Display Vector Field set to ‘On’ for Vector Field Type ‘Current Density Vector’. 

The Field Parameters section controls the appear-
ance of the selected vector field. This section is 
inactive if the Display Vector Field radio button is 
set to ‘Off’. The parameter settings include the size 
of the vector arrows (Vector Scale Factor) and the 
Displayed Min and Max values for the field. The 
Displayed Min and Max values initially default to 
the Calculated Min and Max values. The Calculated 
Min and Max values appear for reference (this 
makes it easy to reset the values). The Display Leg-
end checkbox turns the legend on and off and the 
radio buttons labeled Horizontal and Vertical dic-
tate the legend location. 

The Display Vector Field Comp radio buttons turn 
the display of the various vector field components 
on and off. Options include: 

FIGURE 89. Surface Selector dialog

FIGURE 90. Display of Current Density
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• ‘Off’ (does not display any components) 

• ‘x Component’ (displays magnitude of the x component of the selected vector field)  

• ‘y Component’ (displays magnitude of the y component of the selected vector field)  

• ‘z Component’ (displays magnitude of the z component of the selected vector field)

• ‘Magnitude’ (displays total magnitude of the selected vector field)

The Component Parameters section is 
active when the Display Vector Field Comp 
radio buttons are set to something other than 
‘Off’. The Show Contour checkbox controls 
the appearance of the contour plot. If the 
checkbox is unchecked, the field appears as 
a standard continuous contour plot like the 
one shown in Figure 91. (In this figure, 
extent clipping is used to reveal the internal 
structure. Extent clipping is discussed in a 
subsequent section.) Alternatively, if the 
Show Contour checkbox is checked, you 
specify Number of Contours and the display 
will group similar values into the specified 
number of discrete contour surfaces (i.e., 
iso-surfaces), as shown in Figure 92. 

The Displayed Min and Max values dictate 
the upper and lower values displayed. These 
values initially default to the Calculated Min 
and Max values. (The Calculated Min and 
Max values appear for reference, making it 
easy to reset the values.) The Display Leg-
end checkbox turns the legend display on 
and off, and the radio buttons labeled Hori-
zontal and Vertical dictate the legend place-
ment. 

The Initial (or Adapted) Mesh section con-
trols the display of the mesh. It refers to the 
last mesh used in the generation of the 
results, either Initial (if adaptivity is off) or 
Adapted (if adaptivity is on) in the graphics 
window. Use the Display Mesh radio button 
to show or hide the mesh. The Show Mesh 
Outline checkbox to display an outline of the mesh. 

FIGURE 91. Contour plot for Magnitude of Magnetic
Flux Density, with Show Contours unchecked

FIGURE 92. Contour plot for Magnitude of 
Magnetic Flux Density, with Show Contours checked 
(10 iso-surfaces) 
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The Clipping State section allows you to remove sec-
tions of the displayed results in order to view the inter-
nal structure. When the Clipping radio button is set to 
‘On’, the XYZ ranges (x Min, x Max, y Min, y Max, z 
Min, z Max) are used to determine which portion of 
the results to display. The ranges initially default to the 
full range of the problem space. For reference, these 
default values appear above each edit box (this makes 
it easy to reset the values). The units for all values 
(shown in parentheses after the words “Clipping 
State”) are the model units. Changes to the ranges do 
not take effect in the graphics window until you click 
the Apply button (or hit Enter). 

(The Clipping feature operates identically for both the Magnetostatic and Electrostatic results. 
Refer to Figure 78 and Figure 79 (on page 68) in the Electrostatic results section to see additional 
examples of extent clipping.)

The Scalar Slicing button located beneath the Display Vector Field Comp 
radio buttons (see Figure 94) accesses the Scalar Field Cut Plane dialog 
shown in Figure 95. The dialog allows you to define a plane anywhere 
within the problem boundary and view the scalar field distribution on that 
plane. The scalar field shown corresponds to the selected vector field 
component radio button on the Magnetostatic Display Parameter dialog. 
The Scalar Field Cut Plane dialog is divided into the following sections:   

Cut Plane Normal Specification 
- Use the slider bars to specify 
the exact position of the cut 
plane. Controls include: Angle 
from the Z-axis (from 0 to 180 
degrees), Angle from the X-axis 
(from 0 to 360 degrees) and 
Normalized Distance from Cen-
ter Along Normal (slides the 
plane along the normal to the 
surface). You can also enter spe-
cific values for these parame-
ters in the edit boxes provided 
rather than use the slider bars. 
For Normalized Distance from 
Center Along Normal, you can 
enter in the distance in the 
model units (Model) or normal-
ized units (Norm).

FIGURE 93. Clipping State section of the 
Magnetostatic Display Parameters dialog

FIGURE 94. Scalar 
Slicing button

FIGURE 95. Scalar Field Cut Plane dialog
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Contour Specifica-
tions - This sec-
tion controls the 
display of the sca-
lar field on the cut 
plane. Use the 
Show Contours 
checkbox to tog-
gle the display 
between contour 
lines (checked) and 
a continuous color 
contour plot 
(unchecked). 
When viewing 
contour lines, 
define the contour 
range by specify-
ing the Number of Contours to be displayed and the Minimum Voltage and Maximum Voltage that 
define the range. Note that changes do not take effect in the graphics display until you click the 
Apply button (or the Enter key). 

Viewing Parameters - The Set Opacity slider bar sets the opacity of the scalar cut plane. To hide 
the cut plane, set the slider bar to zero. The Line Width sets the thickness of the contour lines. It 
applies only when the Show Contours checkbox is checked. 

Clipping State - This radio button turns the clipping state on and off. For an explanation of Clip-
ping State, see discussion of the Clipping State section of the Magnetostatic Display Parameters 
dialog in the section below.) 

The Close button closes the Scalar Field Cut Plane dialog and returns to the Magnetostatic Dis-
play Parameters dialog, shown in Figure 88. 

{Discuss Hide vs. Exit buttons} 

3.11.2.2  01/1D Display (Line Plots & Data Point Extraction)

3.11.2.2.1  Line Plots

FIGURE 96. Scalar Field Cut Plane 
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The Line Plot button in the 
0D/1D section of the Magne-
tostatic Display Control Panel 
dialog (shown in Figure 88) 
brings up the Magnetostatic 
Line Plotter dialog shown in 
Figure 97. This dialog enables 
you to create line plots for 
various fields. Use the Field 
to Plot radio buttons to select 
the desired field:

• ‘Magnetic Flux Density, B’

• ‘Magnetic Field, H’ 

• ‘Current Density, J’ 

Use the checkboxes to select ‘x Comp’, ‘y Comp’, ‘z Comp’ or ‘Mag’ (the x component, y com-
ponent, z component or total magnitude of the selected field, respectively)

To specify the desired line for which to plot the selected field, you must identify a Starting Point 
and an Ending point. The dialog provides several options for identifying these two points: 

• Direct entry - Allows you to enter the x, y, and z components of each point directly in the edit 
fields provided on the Magnetostatic Line Plotter dialog (e.g., Starting Point x, Starting Point y 
etc.) 

• Surface Selection - Allows you to select two points anywhere on the surface of the model. 
Click the Surface Select button and the main window containing the geometry model will 
become active. Use the Ctrl-Left mouse button to select the first and second end points. Only 
points on surfaces can be selected. A small dot will appear for each endpoint and the xyz coor-
dinates will automatically appear in the fields provided on the Magnetostatic Line Plotter dia-
log (e.g., Starting Point x, Starting Point y etc.). 

• 3D Selection - Allows you to select two endpoints anywhere within the bounding box of the 
problem space. Click the 3D Select button and the main window containing the geometry 
model will become active. A line widget with two endpoints will appear. Use the Ctrl-Left 
mouse button to move the endpoints to their desired locations. To complete the selection, click 
3D Select on the Magnetostatic Line Plotter dialog. The xyz coordinates will automatically 
appear in the fields provided on the Magnetostatic Line Plotter dialog (e.g., Starting Point x, 
Starting Point y etc.). 

FIGURE 97. Magnetostatic Line Plotter dialog 
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Once you specify the desired field and the desired line, click the Plot button. The resulting line 
plot will appear in the main window, as shown in Figure 98. In this case, the line plot corresponds 
to the settings shown in Figure 97. 

The Plot Parameters Open button opens a hidden portion at the bottom of the Electrostatic Line 
Plotter dialog. This section {TBD: discuss here and/or reference back to the earlier Plot Parame-
ters section.} 

To exit the Magnetostatic Line Plotter dialog, click the exit button and control will be returned to 
the Magnetostatic Display Parameters dialog. 

3.11.2.2.2  Data Point Extraction

FIGURE 98. Magnetic Flux Density Line Plot
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The Data Point button in the 
0D/1D section of the Magne-
tostatic Display Parameters 
dialog (shown in Figure 88) 
brings up the Single Point 
Magnetostatic Field Extractor 
dialog shown in Figure 99. 
This dialog enables you to 
extract the value of the 
desired field at a particular 
point. Use the Field to Inspect 
radio buttons to select the 
desired field:

• ‘Magnetic Flux Density, B’

• ‘Magnetic Field, H’ 

• ‘Current Density, J’ 

There are three different ways to specify the desired point: 

• Direct entry - Allows you to enter the x, y, and z components of the point directly into the edit 
fields provided on the Single Point Magnetostatic Field Extractor dialog (Point Location x, y 
& z). 

• Surface Selection - Allows you to select the point anywhere on the surface of the model. Click 
the Surface Select button and the main window containing the geometry model will become 
active. Use the Ctrl-Left mouse button to select the point. Only points on surfaces can be 
selected. A small dot will appear for the selected point and the xyz coordinates will automati-
cally appear in the fields provided on the Single Point Magnetostatic Field Extractor dialog 
(Point Location x, y & z). 

• 3D Selection - Allows you to select the point anywhere within the bounding box of the prob-
lem space. Click the 3D Select button and the main window containing the geometry model 
will become active. A 3-plane widget will appear. Use the Ctrl-Left mouse button to move the 
planes to their desired positions. To complete the selection, click 3D Select on the Single Point 
Magnetostatic Field Extractor dialog. The xyz coordinates of the point represented by the 
intersection of the three planes will automatically appear in the fields provided on the Single 
Point Magnetostatic Field Extractor dialog (Point Location x, y & z). 

FIGURE 99. Single Point Magnetostatic Field Extractor
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Once you specify the desired 
field and the desired point, 
click the Extract button. The 
resulting value(s) will appear 
in the appropriate Field Value 
at Selected Point boxes, as 
shown in Figure 100.  

To exit the Single Point Mag-
netostatic Field Extractor 
dialog, click the Exit button 
and control returns to the 
Magnetostatic Display 
Parameters dialog. 

3.11.3  Viewing Beam 
Analysis Results

The Beam Analysis menu item will be active after completion of any analysis that includes beam 
optics. This menu item brings up the beam optics results in the main window. The Beam Optics 
Display Control Panel dialog automatically pops up on top, as shown Figure 101. The initially 

FIGURE 100. Results from Single Point Magnetostatic Field Extraction

FIGURE 101. Beam optics results (default settings)
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displayed results correspond to the default settings on the dialog: Particle Iteration set to the last 
saved iteration, Display Power Densities radio button set to ‘Off’ and Display Traj/Planar Parti-
cles set to ‘Trajectories’ and Emitters and Trajectories set to the first generation of all enabled 
emitters. 

3.11.3.1  Overview

This Beam Optics Display Control Panel dialog is shown more clearly in Figure 102. The purpose 
of this dialog is to enable examination of the following:

• Power densities - This feature displays the power densities in 3D on user-selected surfaces.   

• Trajectories - This feature displays user-selected trajectories in 3D. 

• Planar Particles - This feature gen-
erates particle projections of user 
defined trajectories onto user-
defined cross sections. It includes:

• the ability to display the parti-
cle projections in 3D 

• the ability to generate more 
detailed information on planar 
particle attributes. You can save 
this information to a separate 
output file, view a 2D particle 
plot and view summary infor-
mation. 

• Terminal Particles - This feature 
generates a separate file containing 
the terminal attributes of all parti-
cles. 

The subsequent sections describe how 
to use the Beam Optics Display Con-
trol Panel to produce results in each of 
these four areas. Note that this is par-
ticularly complex, feature-rich dialog 
and that the various sections of the dia-
log change depending on which radio 
buttons are selected. 

3.11.3.2  Iteration Selection

The Particle Iteration dropdown in the 
upper left corner of the Beam Optics 
Display Control Panel dialog specifies 
the iteration for which to display all beam optics results (i.e., Power Densities, Trajectories, Pla-

FIGURE 102. Beam Optics Display Control Panel dialog
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nar Particles and Terminal Particles). The contents of the dropdown box correspond to the saved 
iterations of the last run (as defined by the parameter Output Solution and Source Fields Every 
{N} Iterations on the Execution Parameters dialogs). The default iteration is the final iteration.

3.11.3.3  Power Densities

When the Display Power Densities radio button is set to ‘On’, a blank version of the Surface 
Selector dialog will pop up automatically if no surfaces are selected yet. This is shown below on 
the right side of Figure 104. In addition, the following sections become active (shown on the left 
side of Figure 104):

• Power Densities, 

• Initial (or Adapted) Mesh, and 

• Clipping State. 

The 3D power density display will appear in the main window. Note that power densities are 
based on all emitters enabled in the case (i.e., all emitters enabled on the Beam Optics tab of the 
Attribute Assignment properties dialog). The Emitters and Trajectories table has no effect. 

Selecting Surfaces

FIGURE 103. Beam Optics Display Control Panel dialog with Power Densities ‘On’
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To add a surface on which to display power densities, click the Select Surfaces button next to the 
Display Power Densities ‘On’ radio button (if the dialog is not open already). Click the Add Sur-
face(s) button beneath the table. This will bring up the graphics display window containing the 
geometry model. Rotate the model so that you can see the face of the desired surface. Select it by 
pressing the Ctrl-Left mouse button. The surface will change color to indicate it is selected. Press 
Enter and the surface will appear in the Selected Surfaces table. Add additional surfaces using the 
same method. 

To modify the Color or Name (if editable) for a selected surface, select the table entry and click 
the Modify button. Make the desired changes in the resulting Selected Surfaces Properties dialog 
and click OK. To deleted a selected surface, select the desired table entry and click the Delete but-
ton. 

To close the Surface Selector dialog, click OK. 

Setting Power Density Parameters

In the Power Densities section, the Show Contour checkbox controls the appearance of the power 
densities on the selected surfaces. 

If the checkbox is unchecked, 
the power densities appears as 
a standard continuous contour 
plot like the one shown in 
Figure 104. Alternatively, if 
the Show Contour checkbox 
is checked, you specify Num-
ber of Contours and the dis-
play will group like values 
into the specified number of 
discrete contour lines, as 
shown in Figure 105. 

The Displayed Min and Max 
values dictate the upper and 
lower values displayed. These 
values initially default to the 
Calculated Min and Max val-
ues. (The Calculated Min and Max values appear for reference, making it easy to reset the values.) 
The Display Legend checkbox turns the legend display on and off, and the radio buttons labeled 
Horizontal and Vertical dictate the legend placement. 

FIGURE 104. Power Density contour plot (with Show Contours unchecke
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Changes take effect when you 
click the Apply button (or hit 
Enter).

Showing the Mesh

The Initial Mesh (or Adapted 
Mesh) section controls the dis-
play of the mesh. (The section 
label refers to the mesh used in 
the generation of the results. If 
the mesh was adapted, it is 
labeled Adapted Mesh; if not, 
it is labeled Initial Mesh.) 

The Display Mesh radio but-
tons show and hide the mesh. 
The Show Mesh Outline checkbox displays an outline of the mesh. 

Using Extent Clipping

The Clipping State section allows you to remove sections of the Power Density display, including 
the mesh, if it is ‘On’. It operates similarly to the Extent Clipping features discussed in the Elec-
trostatic and Magnetostatic results sections. When the Clipping radio button is set to ‘On’, the 
XYZ ranges (x Min, x Max, y Min, y Max, z Min, z Max) are used to determine which portion of 
the results to display. The ranges initially default to the full range of the problem space. For refer-
ence, these default values appear above each edit box (this makes it easy to reset the values). The 
units for all values are the model units. Changes to the ranges do not take effect in the graphics 
window until you click the Apply button (or hit Enter). 

For an example of extent clipping used with the Electrostatic results, see Figure 79 (on page 68). 
Extent clipping for the power density display is analogous.

3.11.3.4  Trajectories

When the Display Traj/Planar Particles radio button is set to ‘Trajectories’: 

• the trajectories appear in the main window as shown in Figure 106, and

FIGURE 105. Power Density contour plot (with Show Contours checked
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• the Emissions and Trajectories section of the Beam Optics Display Control Panel dialog 
becomes active. {confirm; only true if Mattie and Thuc take my suggestion}

Specifying Displayed Trajectories 

The specific trajectories displayed correspond to the settings in the Emissions and Trajectories 
section, shown in Figure 107. This section includes the following controls:

• Emitters - All enabled emitters in the case 
appear in the table. Emitters are turned on/off 
for the purposes of display via the checkbox 
that precedes the emitter name. At least one 
emitter must be checked at all times. (Emit-
ters are defined and enabled for a case via the 
Beam Optics tab of the Attribute Assignment 
Properties dialog.)

• Generations - The primary generation (0th 
generation) as well as any secondary genera-
tions will appear in this section. Generations 
are turned on/off for the purposes of display 
via the checkbox that precedes the generation 
number. At least one generation must be 
checked at all times.

• Particle Selection Type - The Particle Selection Type dropdown box allows further refinement 
of which particle trajectories get included in the display: 

• ‘Full’ - This option results in the display for all particles. 

FIGURE 106. Display Trajectories ‘On’ 

FIGURE 107. Emitters and Trajectories section
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• ‘ID’ - With this option, the minimum and maxi-
mum ID numbers for all particles appear in the 
table. To modify the ID range, click on the row 
for the desired emitter and the dialog shown in 
will appear. Enter the desired range (Min and 
Max) and click OK. Only trajectories (or planar 
particles) and power densities associated with 
the specified ID range will appear in the main 
window. 

• ‘Current’ - With this option, the minimum and maximum current for all particles (Min and 
Max) appear in the table. To modify the current range, click on the row for the desired 
emitter and a dialog similar to will appear (however it will ask for a current range rather 
than an ID range). Enter the desired current range and click OK. (or planar particles) and 
power densities associated with the specified ID range will appear in the main window. 
{This dialog is missing units. Tell Thuc.}

Specifying Trajectory Color

The color of the trajectories is based on the color setting in the Colors->Trajectory item under the 
View menu. See Figure 15 and Figure 16 (on page 17) for details on these controls. As explained 
there, you can change the color of the trajectories based on ID and current. 

3.11.3.5  Planar Particles

FIGURE 108. Particle Range Selector dialog
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When the Display Traj/Planar Particles 
radio button is set to ‘Planar Particles’:

• a cut plane appears in the main window 
(as shown in Figure 110) 

• the Emissions and Trajectories section of 
the Beam Optics Display Control Panel 
dialog becomes active {confirm; only 
true if Mattie and thuc implement my 
suggestion}, and 

• the Planar Particle section appears in the 
middle portion of the Beam Optics Dis-
play Control Panel and becomes active, 
as shown in red in Figure 109. This sec-
tion contains input parameters needed to 
specify both the cut plane and to generate 
more detailed information about the pla-
nar particles. 

Selecting Emissions 

The Emissions and Trajectories section 
specifies which emissions are included in 
the planar particle results. See the Trajecto-
ries section above (Section 3.11.3.4) for a 
complete explanation of this section. 

Defining the Cut Plane

In the Planar Particles section, the Choose 
Plane radio buttons define the orientation for the cut plane. Options include the three standard 
orthogonal planes and an arbitrary cut plane: 

• ‘yz’ - the yz plane, with normal in the x axis,

• ‘zx’ - the zx plane, with normal in the y axis,

• ‘xy’ - the xy plane, with normal in the z axis, 

• ‘xyz’ - an arbitrary plane; the three components of the vector normal to the plane are specified 
by the edit fields x Normal, y Normal and z Normal.   

The Normal Distance slider bar defines the distance of the plane along the normal vector. The 
Opacity of Plane slider bar controls the opacity of the cut plane. 

FIGURE 109. Planar Particles section of the 
Beam Optics Display Control Panel dialog
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The cut plane, as defined here, appears in the main window of the BoaGui with the particles pro-
jected onto it. As you vary the above parameters, you can see the cut plane change. 

Generating Detailed Planar Particle Information

In addition to viewing the planar particles in the main window, you can also generate additional 
information, including

• a separate output file containing detailed planar particle information

• a 2D particle position plot

• summary statistics for the planar particles

To generate this additional information, first complete the necessary input parameters in the Par-
ticle Statistics section, including: 

• Axis Dir - The Axis Dir dropdown box specifies the direction of the normal (‘positive’ or ‘neg-
ative’). When Choose Plane is set to the ‘xyz’ plane, then Axis Dir = ‘Positive’ indicates the 
same direction as that specified by n = (x Normal, y Normal, z Normal) and Axis Dir = ‘Nega-
tive’ indicates the opposite direction of n. 

• Num r’s - The number of r coordinates, [Grammar note: Thuc/Mattie, this is incorrect usage of 
an apostrophe; apostrophes are used to indicate possessive not plural]

• Num Theta’s - The number of polar angles, [Gammer note: Thuc/Mattie, this is incorrect usage 
of an apostrophe; apostrophes are used to indicate possessive not plural] 

FIGURE 110. 3d Planar Particle Display
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• Centroid - The centroid (center of gravity) of the beam on the specified plane. The Centroid by 
dropdown box provides three options for specifying the planar beam centroid:

• ‘All Particles’ - Uses all planar particles of all generations to compute the centroid.

• ‘Primary Particles’ - Uses only the primary particles. (This is identical to the first method 
if there are no secondary emissions.)

• ‘Input Coord’ - Allows for manual entry of the coordinates. The Input Centroid fields 
become active and you must enter two of the thee coordinates (x,y and z). (The third coor-
dinate is fixed, per the selected plane.)

• Output File - The fine name given to the output file when it is generated. (The default filename 
is ‘Papa.ppo’1.) This file is stored in the case directory.

Next, select either the Output File or the Output File & Plot radio button. Then click the Generate 
button. The following will occur:

1. The output file is automatically generated and saved in the current case directory to the file-
name specified in the Output File edit box. 

2. If the Output File 
& Plot radio but-
ton is selected, a 
plot like the one 
shown in 
Figure 111 appears 
in the main win-
dow. In addition, 
the Plot Parame-
ters button (in the 
Plot Statistics sec-
tion) becomes 
active. This button 
accesses the Plot 
Control Parame-
ters dialog which 
enables you to 
modify the plot, as 
desired. (This dialog is shown in Figure 13, “Plot Control Panel dialog,” on page 15 and 
explained in more detail there.)

3. The Planar Particles section in the middle of the Beam Optics Display Control Panel disap-
pears and is replaced by the Particle Statistics section as shown in Figure 112. This section 
provides the following summary statistics: 

1.The term ‘Papa’ stands for Planar Particle Attributes. 

FIGURE 111. Particle Position Plot



BOA Version 4, User Manual v0.5 updates in progress[5/10] 93

• the coordinates of the centroid (Pla-
nar Beam Centr), 

• the number of particles (Num Parti-
cles), 

• the Total Current, 

• the total kinetic energy (Total KE),

• the Brillouin field (Bb) - the Brillouin 
field produces a magnetic force that 
balances the space charge and centrif-
ugal forces of the particle beam.   

• In addition, a larger, non-editable box 
appears containing: the Total Current, 
Total Kinetic Power, Beam Diameter, 
the first derivative of the radius with 
respect to the beam axis (dr/dz) and 
the second derivative of the radius 
with respect to the beam axis (d2r/
dz2). (Note that once calculated, the 
information in this larger, non-edit-
able box remains available after you 
use the Return button at the bottom of 
the screen to switch the Particle Sta-
tistics section back to the Planar Par-
ticles section. This is also true for the 
Brillouin field (Bb).)

If the analysis includes an external mag-
netic field (i.e., if the Analysis type is set 
to either ‘Electro/Magnetostatic Beam’ 
or ‘Electro/Magneto/Self Field Beam’), 
then two additional sets of statistics will appear (as shown in Figure 112): 

• The lower portion of the Particle Statistics section will contain a table that summarizes particle 
statistics for the whole plane. The table includes the Mean, minimum (Min), maximum (Max) 
and standard deviation (Sigma) for the following:

• KE [eV] - kinetic energy

• Perp. KE [eV] - kinetic energy perpendicular to the beam axis

• Para. KE [eV] - kinetic energy parallel to the beam axis

• v_perp/c - perpendicular velocity normalized by the speed of light

• alpha - the ratio of perpendicular velocity/parallel velocity

• B [T] - magnetic field

• r [model units, e.g.,‘in’]) - beam radius

FIGURE 112. Particle Statistics section of the 
Beam Optics Display Control Panel dialog
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• The bottom portion of the Beam Optics Display Control Panel will change to a section named 
Additional Particle Statistics. This section summarizes particle statistics at the mean radius of 
the beam (r Mean). For each polar angle (Theta) in radians, the table provides: 

• v_perp/c - the perpendicular velocity normalized by the speed of light

• alpha - the ratio of perpendicular velocity/parallel velocity

• rg - the Lamor radius in model units (e.g., ‘in’). Also known as ‘gyrotron radius’. 

• Bx, By, Bz - the coordinates of the magnetic field, in model units (e.g., ‘in’)

(Remember, you define the number of number of polar angles (Num Theta’s) in the Planar 
Particle section, as described above.) 

Both sets of statistics can be saved via the Save Stat File Save button at the bottom of the screen.

3.11.3.6  Generate Terminal Particles 

This section of the Beam Optics 
Display Control Panel dialog is 
used to save information on the 
terminal particles to a separate 
file. The file is generated based 
on the user-specified Particle 
Iteration (see dropdown box at 
the top of the dialog). Note that 
the Emissions and Trajectories 
section has no effect on the ter-
minal particle results. All emit-
ters enabled on the Beam Optics 
tab of the Attribute Assignment 
properties dialog are included. 

To generate the file, click the 
Generate button. An informa-
tion message will pop-up showing the exact location (path and filename) for the file. The default 
name for the file is ‘n-Enpa.out’1, where n corresponds to the Particle Iteration number. Click OK 
and the file will be created. To display the newly created file, click the Display Particles File but-
ton. The file will pop up in a separate window. The file format is documented in the Appendix. 

1. The term ‘Enpa’ stands for End Particle Attributes. 

FIGURE 114. Terminal Particles section of Beam Optics Display 
Control Panel dialog
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3.11.4  Viewing Run Log

This View Run Log menu 
item brings up a separate 
window containing the 
log file, as shown in 
Figure 115. 

Note that the Total Emit-
ted Current reported in the 
log file is the total current 
emitted by the cathode. It 
is not the actual transmit-
ted beam current when 
analyzing an electron gun 
with grids. Electrons 
leave the cathode, some 
are turned back and some 
intercept the grids. To 
obtain the actual beam 
current when grids are 
present, use the Display 
Planar Particles feature 
(accessed via the View Results, Beam Analysis menu). On the Plot Planar Particles dialog, select 
a cross section plane that is normal to the beam and between the control grid and the anode. Enter 
the desired values in the remaining fields in the Planar Particles section and then click Generate. 
The Planar Statistics section will display the beam current.

3.11.5  Generating Case Summary

This Generate Case Summary menu item generates a separate file containing summary informa-
tion for the case. The file is named Case Name_IOS.txt (where Case Name is the name of the cur-
rent case and IOS stands for Input/Output Summary). An information message will appear 
showing the exact location and filename for this file. 

3.11.6  Viewing Optimizer Log

{TBD: Waiting for optimizer case from M}

FIGURE 115. Example of a Run Log
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3.12  Tools

The Tools pulldown menu, shown in Figure 116, 
includes:

• the Cibo tool (a tool for creating an injected 
beam profile)

• the Measure Distance tool

• the Material Properties database

• the License Installer.

3.12.1  Creating an Injected Beam Profile 
(Cibo Tool)

Cibo (Creating Injected 
Beam Optics) is a tool 
to generate an injected 
beam profile (a Cibo 
Output File) to be used 
by BOA for an injected 
emitter. It enables you 
to quickly and easily 
generate an injected 
beam profile in BOA 
format for a given set of 
parameters (beam volt-
age, current, radius, 
etc.) This can be useful, 
for example, to test a 
collector design with-
out having detailed 
spent beam data from other RF codes.

The Cibo menu item brings up the Cibo Configurator dialog shown in Figure 117. The Cibo Out-
put Filename defaults to ‘cibo.ibf’ and the default location is the current Project directory. 

Note that Cibo can be used with or without a case open in BoaGui. If a case is open, BoaGui will 
issue a warning if you set the Model Length Unit to something other than the length unit defined 
in the case. (If no case is opened, no warning is given.) If a case is open with a specified geometry 
in the Model menu, the model length unit is the specified model's. Otherwise, the default unit is 
meter.

FIGURE 116. Tools Pull-down Menu

FIGURE 117. Cibo Configuration dialog
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There are two options for Injection Specification: 
• ‘Beam Current’ - With ‘Beam Current’, you specify the Beam Current and Beam Voltage. The 

particle charge and its energy are then calculated from the beam current, voltage and the beam 
geometry. Thus, each injecting particle charge varies on the injected emitter plane. 

• ‘Particle Charge’. With ‘Particle Charge’, you specify Particle Charge and Particle Energy. 
Each injecting particle has the same specified charge.

There are two options for Beam Shape: 
• ‘Circular’ - With a ‘Circular’ beam shape, you specific Beam Radius, Number of Particle 

Rings and Number of Particles Per Ring. (If you specify 5 rings and 32 particles per ring, there 
will be a total of 160 injecting particles.) 

• ‘Rectangle’ - With a ‘Rectangular’ beam shape, you specify the Beam Height, Beam Width, 
Number of Vertical Particles (along beam height) and Number of Horizontal Particles (along 
beam width). (If you specify 10 vertical and 6 horizontal, there will be 60 injecting particles.) 

For the Beam Axis Type drop down box, select the appropriate beam axis: ‘x’, ‘y’ or ‘z’. (Note that 
the exact label for the Beam Height and Beam Width change according to the selected Beam Axis 
Type.) You can also specify the Azimuthal Particle Velocity (rotation) uniformly to all injecting 
particles, and set the Injected Plane Coord (the beam axis coordinate).

3.12.2  Measuring Distance

{UPDATE THIS SECTION FOR 3D vs. SURFACE SELECT FUNCTIONALITY}

{Also, do more bug-checking: there seems to be a bug where surface select allows you to select 
anywhere. is this true for other surface select places in the GUI? i thought not, but check}

The Measure Distance feature allows you to measure the distance between two endpoints in the 
graphics display window. Both points must be on a part. Use the Control-Left Mouse button to 
select the two endpoints. Boa Gui will display the selected points as small balls. After completing 
selection of the second point, a message will appear showing the measured distance between the 
two points. 

To abort the Measure Distance function prior to completing a measurement, hit the Esc key

WARNING: Before using this feature, you must set the following parameters on the View pull-
down menu: 

1. Set View Representation to Orthogonal 

2. Set Orientation to one of the following: Front, Back, Left, Right, Top, or Bottom 
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If the View pulldown menu parameters are not set correctly, the measured distance will be incor-
rect.   {TBD: Have we implemented error-checking in BoaGui? Thuc says he does not know about 
this, but BV explicitly told me this originally.} 

3.12.3  Material Properties

The Materials Properties database consists of a set of materials and the associated material prop-
erties needed for BOA analyses. These proprieties include:

• Atomic Number           (used with secondary emitters)

• Atomic Mass               (used with secondary emitters)

• Mass Density               (used with secondary emitters)

• Relative Permittivity     (used in electrostatic analyses)

• Relative Permeability    (used in magnetostatic analyses)

• Thermal Conductivity   (used in heat transfer analyses [not yet implemented])

• Yield Coefficient          (used with secondary emitters) 

• Work Function            (used for thermionic emitters)

BOA provides an initial set of commonly used materials, shown in Figure 118. These initial 

‘built-in’ materials cannot be edited or deleted. Users can supplement this library with their own 
materials. The Location of User Material Library shows the location where the data for all user-
entered materials reside. This directory is specified once (when you initially create a project via 
the New Project dialog) and it cannot be changed thereafter.

FIGURE 118. Material Properties dialog
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To add a new material to the Material Properties library, 
click the Add Material button. The dialog shown in 
Figure 119 will appear. Enter the Name for the material 
and enter all values in SI units. Note that the Perme-
ability Source dropdown box enables the Relative Per-
meability to be entered in one of three ways: ‘Scalar’, 
‘File’ or ‘Formula’: 

• Scalar - this option requires entry of a constant, 
uniform Relative Permeability (i.e., a single 
number). 

• File - this option requires the filename for a two 
column file containing the BH curve for the 
material. When this option is chosen the Browse 
button becomes active so that you can locate the 
file. In addition, the Plot button becomes active 
so that you can plot the data. This helps ensure 
that the selected file contains the intended data. 

• Formula [This feature is not yet functional] - 
Future versions of BOA will allow the user to 
enter BH curves via equations (eg B = 0.2 * H^0.2). 

Notice that some of the relative permeabilities provided for the built-in materials are scalars (i.e., 
constants appear in the Relative Permeability column in Figure 118), while others are non-linear 
with data provided via a separate file (i.e., filenames appear in the Relative Permeability column 
in Figure 118). 

Only user entered materials can be edited or deleted. The material entries built into BOA (i.e., 
entries in yellow highlight) cannot be altered. To delete a user-created entry, use the Delete Mate-
rial button (see Figure 118). Similarly to modify a user-created entry, use the Modify Material 
button. 

3.12.4  License Installer

TBD {Get existing instructions}

FIGURE 119. Add/Edit Material dialog
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4.0  Examples

4.1  Example 1 - JLab Klystron Gun 

In this example, BOA is used to per-
form electrostatic and electrostatic 
beam analyses on an electron gun 
assembly used in a klystron. A cross 
section of the gun assembly is shown 
in Figure 120. The voltage is -18000 
Volts on both the cathode and the 
focus electrode. The voltage is 0 
Volts on both the anode and the mod 
anode. The cathode to anode spacing 
is 0.7 inches. 

This example includes a simple elec-
trostatic analysis without adaptive 
meshing (Example 1A), an electro-
static analysis with adaptive meshing 
(Example 1B) and an electrostatic 
beam analysis without adaptive 
meshing (Example 1C).

4.1.1  Example 1A - Electrostatic 
Analysis 

4.1.1.1  Getting Started 

1. Open BoaGui.exe by clicking on the BoaGui icon on your desktop or the BoaGui icon in the 
Start menu.

4.1.1.2  Creating a New Project

FIGURE 120. Cross section of the Electron Gun Assembly 
modeled in this example 
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1. Go to the File pulldown menu and select New 
Project. The dialog in Figure 121 will appear. 
Unlike the screen shown in Figure 121, initially 
the two data entry boxes will be blank.

2. Use the Browse button to locate the desired 
directory for the new Project. If the desired 
directory does not exist yet, type in the desired 
name and BOAGui will created the directory 
for you. 

3. Specify the Project Name in the box provided. 
In this example, the Project Name is ‘Jlab 
Klystron Gun Project’. 

4. Click OK. The new Project will appear in the 
Project/Case Manager tree control on the right 
side of the BOAGui screen. Behind the scenes, a Project folder will be created in the specified 
location. The project folder will contain the BOA Project file (*.boa) and all associated Case 
folders.

4.1.1.3  Creating a 
New Case

1. Right click on 
‘Project Jlab 
Klystron Gun 
Project’ in the 
Project/Case Man-
ager tree control. 
The popup menu 
shown in Figure 122 will appear. 

2. Select Add New Case. The dialog shown in 
Figure 123 will appear. Initially the data entry 
fields will be empty.

3. Specify the Case Name in the box provided. 
In this example the Case Name is ‘Example 
1A’.    

4. Select ‘Electrostatic’ in the Analysis Type 
dropdown box.

5. If desired, add Case Comments to describe 
the case as shown in Figure 123. 

6. Leave the Open Case Now checkbox 
checked. 

FIGURE 121. New Project Dialog Box

FIGURE 122. The Project/Case Tree Control (shown with right-click menu opened)

FIGURE 123. Add New Case dialog
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7. Click OK. The new Case will appear beneath the Project in the Project/Case Manager tree con-
trol as shown in Figure 124. Behind the scenes, a new Case folder will be placed in the current 
Project folder. The Case folder will include all files specific to the case.

4.1.1.4  Saving a Case

As you continue through this example, it is a good idea to save your work occasionally. To save a 
case, right click on the Case name in the Project/Case menu bar and select Save Case. (Alterna-
tively, open the File pulldown menu and click Save Case.) 

4.1.1.5  Specifying the Geometry File

Next, specify the geometry file on which 
to base the analysis. The Boa installation 
includes the geometry file you will need 
to complete this example, as discussed 
below. 

1. Click on the Model menu item and 
the dialog shown in Figure 125 will 
appear. (Unlike Figure 125, initially 
the Geometry Solid Model File data 
entry box will be blank.) 

2. Click the Browse button next to the 
Geometry Solid Model File data entry 
box to locate the geometry file. This 
will bring up a Browse window that 
allows you to locate the desired 
geometry file.

3. Locate the file ‘JLAB Gun.SAT’. If 
you installed BOA using the default 
directory settings, this file will be 
located in C:/Program Files/CCR/
Beam Optics Analyzer/Examples/CAD Files. Select the file and click Open (or alternatively, 
double-click on the file). 

FIGURE 124. Project/Case Tree Control (with Case opened)

FIGURE 125. Geometry Model Parameters dialog
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4. The informational 
message shown in 
Figure 126 will 
inform you that 
BoaGui will cre-
ate a copy of the 
file and place it in 
the current Case 
directory. Click Yes. 

5. The name of the geometry file will appear in 
the Geometry Solid Model File entry box, as 
shown in Figure 125. 

6. The Model Units will appear undefined until 
you load the model. Click Load Model and an 
informational message will inform you that 
the initial model has been loaded and verified, 
as shown in Figure 127. Click OK. 

7. A second informational message will inform 
you that the final model has been loaded and 
verified as shown in Figure 128. Click OK. 
(The initial model is the model you specified, 
as is. The final model is the initial model plus 
modifications necessary to make it usable by 
BOA.) 

8. The model units used in the SAT file will 
appear at the bottom of the Geometry Model Parameters dialog. In this case, the units are set to 
‘inches’. 

9. Click OK to exit the Geometry Model Parameters dialog. 

FIGURE 126. Geometry File Copy Message

FIGURE 127. Initial Model Verification Message

FIGURE 128. Final Model Verification Message
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10.The geometry model will appear in the graphics display region as shown in Figure 129. 

4.1.1.6  Viewing the Geometry Model

1. Experiment with moving the model around in the graphic display region. To spin the model 
around, hold down the left mouse button and move the mouse around. To zoom in, hold down 
the right mouse button and move the mouse forward (or ‘up’). To zoom out, hold down the 
right mouse button and move the mouse backward (or ‘down’). You also may want to experi-
ment with different settings on the View menu, such as predefined Orientations, and different 
options for Surface Representation (Wireframe vs. Surface) and View Representation (Orthog-
onal vs. Perspective). 

2. To return to the orientation shown in Figure 129, click View->Reset View. 

4.1.1.7  Assigning Electrostatic Attributes 

FIGURE 129. Electrostatic Geometry Model (before attribute assignment)
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Now you are ready to 
begin assigning attributes. 

1. Click on the Attributes 
menu item. The 
Attribute Assignment 
Properties dialog 
shown in Figure 130 
will appear, with the 
Electrostatics tab 
active. 

2. The table in the Prop-
erties at the Part Level 
section shows all parts 
contained in the geom-
etry file. The table also 
contains the ‘Back-
ground’ part, if it was 
not already included in 
the geometry file. (The 
Background part is cre-
ated by BOA based on 
the settings in the 
Model Geometry 
Parameters dialog.) 
The part names are 
identical to the names 
provided in the geometry file and they are not editable. Initially BoaGui will assign default 
attributes to all parts. Typically, the user will want to change most or all of the assigned 
attributes. Initially, the Visible checkbox is checked for all parts except the Background part.   

3. Highlight the Mod Anode part. Set the Color dropdown box to ‘cyan’. Check the Voltage 
Assigned to Entire Part checkbox and enter ‘0’ in the data entry box. Set the Material drop-
down box to ‘Copper’ in the Relative Permittivity section. (Note: Material assignments are not 
actually necessary for electrostatic or electrostatic beam analyses. Vacuum, which is the default 
material, produces a correct result. However, for a magnetostatic analysis, this field must be set 
correctly (e.g., if there is a part made of iron, the part must be assigned as such). In this exam-
ple, each part is assigned a material for illustrative purposes. It is good practice to make mate-
rial assignments for each part in an analysis, because then if you convert the case to include a 
BOA integrated magnetostatic case, the materials are already assigned.)

FIGURE 130. Attribute Assignment dialog box, Electrostatic tab
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4. Highlight the Cathode part and assign the attributes shown in Table 1 below. 

5. Highlight the Focus Electrode part and assign the attributes shown in Table 1 above. 

6. Highlight the Anode part and assign the attributes shown in Table 1 above. 

7. You have now completed the definition of properties at the part level. (The Properties at the 
Surface Level section allows you to define properties for specific surfaces on parts in the elec-
trostatic geometry model. For this example, there will be no entries in this table.)

8. Click OK to close the 
Attribute Assignment 
Properties dialog.

9. Before proceeding, 
confirm that the part 
colors appear as shown 
in Figure 131. Use the 
mouse to orient the 
model so that you can 
see the cathode, as 
shown in Figure 131. 

10.To return to the previ-
ous orientation, open 
the View menu and 
select Reset View.

It is a good idea to save 
your work occasionally. 
Take this opportunity to 
save changes to the case 
by right-clicking on the 
case name in the Project/Case menu bar and selecting Save Case. 

4.1.1.8  Generating the Initial Electrostatic Mesh

Once you complete the attribute assignments, you are ready to generate the initial electrostatic 
mesh. In this example, the default mesh parameters are sufficient so you do not need to open the 
Mesh Parameters dialog. 

TABLE 1. Attribute Assignments for Jlab Klystron Gun case 

FIGURE 131. Electrostatic Model with Attributes Assigned
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1. Open the Meshing pulldown menu and select Generate Initial Mesh. 

2. A DOS window will appear indicating progress during the mesh generation process. When the 
process completes, the following text will appear at the bottom of the window: “Mesh Genera-
tion Complete, mesh file created: JLAB Gun_E.sms  !Press any key to continue/exit...”. Hit 
any key to close the DOS window and return control back to the user interface. 

4.1.1.9  Viewing the Initial Electrostatic Mesh

1. To view the initial mesh, 
open the Meshing pull-
down menu. Select Dis-
play Initial Mesh -> 
Complete. The mesh 
will appear in the Main 
Window. 

2. To get the exact orienta-
tion shown in 
Figure 132, click on the 
View pulldown menu 
and select Reset View. 
(You may need to use 
the zoom out feature to 
view the entire mesh. 
Right-click on the 
mouse and drag it back-
ward (or down) until the 
complete mesh is in 
view.)

3. To display only a part of the mesh, use the Extent Clip-
ping feature. Open the Meshing pulldown menu and 
select Extent Clipping Initial Mesh. The Mesh Extent 
Clipping dialog will appear.

4. Change the X Max value to “0” as shown in Figure 133 
and click OK. The partial mesh will appear in the 
graphics display region as shown in Figure 134.

5. To turn off the Extent Clipping feature, reopen the 
Mesh Extent Clipping dialog (i.e., open the Meshing 
pulldown menu and select Extent Clipping Initial 
Mesh) and turn the Clipping State radio button to ‘Off’. 

FIGURE 132. Initial Electrostatic Mesh

FIGURE 133. Mesh Extent Clipping 
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6. To hide the initial mesh, open the Meshing pulldown menu. The Display Initial Mesh->Com-
plete item is preceded by a check mark, indicating that the initial mesh is displayed. Click it to 
‘uncheck’ it and the mesh display will turn off. 

4.1.1.10  Executing BOA (without Adaptive Meshing)

Once the initial mesh is generated, you can execute the BOA engine.

1. Open the Execute pulldown menu and select Single Case->Execute. 

2. The dialog box shown in Figure 135 will appear. 

FIGURE 134. Initial Electrostatic Mesh with Extent Clipping
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3. Leave all parameters set to the default values. (Note that Max Number of Adaptivity Passes is 
set to ‘0’which means the mesh will not be adapted for this run.) Click Execute. 

4. A DOS window will appear indicating progress during BOA execution. When BOA com-
pletes, the following text will appear at the bottom of the window “!Proceed to View Results. 
Press any key to continue...”. Hit any key to close the DOS window and return control back to 
the user interface.

4.1.1.11  Viewing Electrostatic Results (without Adaptive Meshing)

After BOA completes, you must run the post processor to view the Electrostatic results. 

1. Open the View Results pulldown menu. 
Select Electrostatic. An informational 
message will indicate that time is required 
to format the output for plotting, as shown 
in shown in Figure 136. Click ‘Yes’ and 
wait for the postprocessor to complete. 

FIGURE 135. Execute Boa 

FIGURE 136. Postprocessor Informational Message 
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2. The default electrostatic results will appear in the graphics display region and the Electrostatic 
Display Parameters dialog will automatically pop up on top as shown Figure 137. The dis-

played results correspond to the default settings on the Electrostatic Display Parameters dia-
log: Display Vector Field (E) set to ‘On’ and Display Scalar Field set to ‘V’ (i.e., display the 
voltage contours). This Electrostatic Display Parameters dialog is shown more clearly in 
Figure 138. 

FIGURE 137. Electrostatic results with Voltage Contours On, Vector Field On 
(executed with Max Number of Adaptivity Passes = 0) 
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3. Use the Electrostatic Display Parameters dialog to specify different outputs, as desired. Note 
that some sections of this dialog box require the Apply button for changes to take effect. 

The sections below demonstrate a few examples of the different results BOA can display, includ-
ing: 

•  3D contour plot of the voltage field cut along zx plane (Figure 139),

•  Scalar slice of the voltage field on the zx plane (Figure 141), and 

•  Line plot of the E magnitude along the beam axis (Figure 143)

Work through these examples to get a feel for how the how various dialogs work. Then experi-
ment on your own to generate additional results, if desired.

4.1.1.11.1  3D contour plot of the voltage field sliced along the zx plane

FIGURE 138. Electrostatic Display Parameters dialog
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Figure 139 shows a 3D contour of the voltage field sliced along the zx plane. To generate this pic-

ture, perform the following steps.   

1. The Electrostatic Display Parameters dialog 
should still be open. (If it is not, reopen the 
View Results menu and select the Electrostatic 
item.)

2. Turn off the Display Vector Field (E) radio 
button. 

3. In the Clipping State section, turn the Clipping 
radio button to ‘On’. Set the x Max value back 
to ‘1.1’ (you had changed it earlier in the 
example) and the y Min value to ‘0’ and then 
click Apply. This will slice the voltage field.

4. To slice the model itself, go to the View menu 
and select Slice Model. The dialog shown in 
Figure 140 will appear. 

5. In the Choose Plane section, select the ‘zx’ 
radio button. Click Close. The main window 
should display the result shown in Figure 139.

FIGURE 139. Electrostatic results with Voltage Contours On and model and Voltage field cut 
along the zx plane (executed with Max Number of Adaptivity Passes = 0)

FIGURE 140. Slice Electrostatic Model dialog
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6. If desired, experiment with different parameter settings. For example, increase the Number of 
Contours to ‘20’ in the Scalar Field Parameters section to see how the picture changes. 

7. To return the Clipping State to Off, set the Clipping radio button to ‘Off’ in the Clipping State 
section of the Electrostatic Display Parameters dialog. 

4.1.1.11.2  Scalar slice of the voltage field on the zx plane 

Figure 141 shows a scalar slice of the voltage field on the zx plane. To generate this picture, 

perform the following steps.   

1. The Electrostatic Display Parameters dialog should still be open. 

2. Click on the Scalar Slicing button located beneath the Scalar Field radio buttons. The Scalar 
Field Cut Plane dialog will appear. (This is the top dialog shown in Figure 141.)

FIGURE 141. Scalar slice of the voltage field on the zx 
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3. To define the cut plane as the zx plane, set the Angle from Z axis to ‘90’ and the Angle from X 
axis to ‘90’. Set the Dist from Center Along Normal slider so that Norm = ‘1’ (you can do this 
by moving the slider directly or by typing ‘1’ into the Norm data entry field). This allows the 
model to show through the cut plane slightly. The cut plane will appear as shown in 
Figure 141.

4. To change the cut plane to contour lines, select the Show Contours checkbox in the Contour 
Specification section. The plane will change to a series of contour lines.

5. Set Number of Contours to ‘30’and click Apply (or Enter on the keyboard). Notice the number 
of contour lines increase.

6. Change the Dist from Center Along Normal back to ‘0’ and hit Enter to apply the change. 
Notice the plane move slightly, back to center (see Figure 142).

7. If desired, experiment with other settings to see how the results change. 

8. When you are finished experimenting, click Close and the cut plane will disappear.

FIGURE 142. Slice Electrostatic Model dialog
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9. To return to the complete model, click on the View menu and select Slice Model. On the result-
ing Slice Electrostatic Model dialog, select the ‘Off’ radio button in the State section. Click 
Close to close the dialog.

4.1.1.11.3  Line plot of the E magnitude along the beam axis (i.e., z axis) 

Figure 143 shows a line plot of the E magnitude along the z (or beam) axis. To generate this pic-
ture, perform the following steps.   

1. The Electrostatic Display Parameters dialog should still be open. 

FIGURE 143. Line plot of E magnitude along beam axis (i.e., z 
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2. Click on the Line Plot located in the 
0D/1D Display section at the top of 
the dialog. The Electrostatic Line 
Plotter dialog will appear.

3. Change the Field to Plot radio but-
ton to Electric Field, E and leave the 
Mag checkbox checked.

4. Set the Starting Point and Ending 
point for both x and y to ‘0’. Leave 
the Starting Point and Ending Point 
for z at the default. 

5. Set the Abscissa Type radio button to ‘Arc Length’.

6. Click Plot. The line plot will appear in the main window, as shown in Figure 143. 

7. If desired, experiment with other settings to view different results. 

8. Click Exit to close the Electrostatic Line Plotter dialog. 

9. Click Exit to close the Electrostatic Display Parameters dialog.

10.Before continuing on to Example 1B in the next section, make sure to save the case. (Right-
click on the case name in the Project/Case Tree Control and select Save Case.) 

11.Close the Case. (Right-click on the case name in the Project/Case Tree Control and select 
Close Case.) 

4.1.2  Example 1B - Electrostatic Analysis (with Adaptive Meshing)

Next, you will rerun BOA with adaptive meshing 
turned on to generate a more accurate solution. 

4.1.2.1  Creating a New Case

To begin, you will copy the existing case Example 
1A to a new case, as follows.

1. Right click on the ‘Case: Example 1A’ case in 
the Project/Case Manager tree control. The sub-
menu shown in Figure 145 will appear. 

2. Select Save Case As... from the sub-menu. The Copy Case Configurator dialog will appear. 

3. Change the name of the case from ‘Copy of Example 1A’ to ‘Example 1B’ as shown in 
Figure 146. 

FIGURE 144. Electrostatic Line Plotter 

FIGURE 145. Save Case As... on the Case sub-
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4. Leave both checkboxes checked. (The 
initial mesh for this case is the same as in 
case ‘Example 1A’ so there is no need to 
rerun the initial mesh.) 

5. Click OK. The new case will appear in 
the Project/Case Manager Tree control 
and the model will appear in the Main 
Window.

6. To enter comments for case ‘Example 
1B’, right click on the new case (‘Case: Example 1B’) in the Project/Case Manager tree control 
and select Display/Edit Comments from the sub-menu. The Display/Edit Comments dialog will 
appear. 

7. Modify the comments as shown in 
Figure 147. Click OK to close the dialog. 

4.1.2.2  Saving a Case

As you continue through this example, it is a 
good idea to save your work occasionally. To 
save a case, right click on the Case name in 
the Project/Case Manager tree control and 
select Save Case. (Alternatively, open the File 
pulldown menu and click Save Case.) 

4.1.2.3  Executing BOA (with Adaptive 
meshing)

FIGURE 146. Copy Case dialog

FIGURE 147. Add New Case dialog
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There is no need to run the initial mesh since it 
is identical to the initial mesh in case ‘Example 
1A’ and it has been copied into this case, as dis-
cussed above.

1. Open the Execute pulldown menu and select 
Single Case->Execute. 

2. The Execute Single Case dialog shown in 
Figure 148 will appear. 

3. Set Max Number of Adaptivity Passes to ‘2’. 
Leave all other parameters set to the default 
values. Click Execute. 

4. A DOS window will appear indicating 
progress during BOA execution. Because 
adaptivity is turned on, the runtime will be 
longer than the first run. When BOA com-
pletes, the following text will appear at the 
bottom of the window “!Proceed to View 
Results. Press any key to continue...”. Hit 
any key to close the DOS window and return 
control back to the user interface.

4.1.2.4  Viewing Electrostatic Results (with 
Adaptive Meshing) 

After BOA completes, you must again run the post processor to view the Electrostatic results. 

1. Open the View Results pulldown menu and select Electrostatic. As with the first run, a warning 
message will indicate that time is required to format the output for plotting. Click ‘Yes’ and 
wait for the postprocessor to complete. 

2. As in Example 1A, the default electrostatic results will appear in the graphics display region 
and the Electrostatic Display Parameters dialog will automatically pop up on top. The results 
shown correspond to the default settings on the Electrostatic Display Parameters dialog (i.e., 
Display Vector Field (E) set to ‘On’ and Display Scalar Field set to ‘V’, meaning display the 
voltage contours). This is shown in Figure 149.

You may notice that the vectors are spaced differently as compared with the vectors shown in 
Figure 137 (on page 110) for Example 1A. This is due to the difference between the initial mesh 

FIGURE 148. Execute dialog for Example 1B
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and the adapted mesh. (The vectors are located at the mesh corners and the mesh for this example 
has been adapted).    

[Mike this is where I stopped my updates when I sent to you on 11/18/09]

4.1.2.4.1  Viewing the Adapted Mesh

Next, look at the adapted mesh to see how it differs from the initial mesh. 

FIGURE 149. Electrostatic results with Voltage Contours On, Vector Field On 
(executed with Max Number of Adaptivity Passes = 2) UPDATE THIS 
PICTURE?. In my recheck with new version this picture looks different (see 
below). Confirm with Thuc that new picture is correct...
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1. The Electrostatic Display Parame-
ters dialog should still be open. In the 
Adapted Mesh section, change the 
Display Mesh radio button to ‘On’. 
The mesh will appear as shown in 
Figure 150. Notice that the adapted 
mesh is coarser towards the front of 
the view and finer towards the back. 

2. To see the inside of the mesh, change 
the Clipping radio button to ‘On’ in 
the Clipping State section. Set x Max 
to ‘0’ and set yMin back to ‘-1.1’. 

3. In order to see inside the gun assem-
bly, hide the anode and the mod 
anode as follows. Open the Attributes 
menu. The Attributes Assignment 
Properties dialog will pop up on top 
of the Electrostatic Display Parame-
ters dialog. Select mod anode and 
uncheck the Visible checkbox. Do the 
same for the anode.

4. Click Ok to close the Attributes Assignment Properties dialog.

5. The mesh will appear similar to that 
shown in Figure 151. Use the mouse 
to move the picture around and view 
it from different perspectives.Notice 
how the mesh is coarser in some 
areas and finer in the areas of inter-
est.

4.1.2.4.2  Line plot of the E magnitude 
along the beam axis (i.e., z axis) 

Figure 152 shows a line plot of the E 
magnitude along the z (or beam) axis. 
To generate this picture, perform the 
following steps.   

FIGURE 150. Adapted Mesh On

FIGURE 151. Adapted Mesh On, Clipping State On
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1. The Electrostatic Display Parameters dialog should still be open. 

2. Click on the Line Plot located in the 0D/1D section at the top of the dialog. The Electrostatic 
line Plotter dialog will appear.

3. Change the Field to Plot radio but-
ton to Electric Field, E and leave the 
Mag checkbox checked.

4. Set the Starting Point and Ending 
point for both x and y to ‘0’. Leave 
the Starting Point and Ending Point 
for z at the default. 

5. Click Plot. The line plot will appear 
in the main window, as shown in 
Figure 152. 

FIGURE 152. Line plot of E magnitude along beam axis (i.e., z axis) for example 1B

FIGURE 153. Electrostatic Line Plotter 
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6. Compare this graph with the Line Plot of the E magnitude you created for Example 1A in 
Figure 143 (on page 115). Notice that the peak field with adaptivity (Figure 152) is higher and 
smoother at both bottoms of the bell curve than the peak field without adaptivity (Figure 143).

4.1.2.4.3  Viewing additional results

As in example 1A, you may want to experiment with different parameters to see different results. 
For example, to get the result shown in Figure 154 follow the steps below.

1. Set the Clipping State radio button to ‘Off’.

2. Set the Adapted Mesh radio button to ‘Off’.

3. Set the Display Scalar Field radio button to ‘Off’. 

4. Leave the Display Vector Field (E) radio button set to ‘On’. 

5. When you are done viewing the results, continue on to Example 1C. Make sure to save the 
case. (Right-click on the case name in the Project/Case Tree Control and select Save Case.) 

6. Close the Case. (Right-click on the case name in the Project/Case Tree Control and select 
Close Case.) 

FIGURE 154. E field ‘On’ with anode and mod anode hidden
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4.1.3  Example 1C - Electrostatic Beam Analysis (with Thermionic Emitter) 

In this example, you will extend Example 1A to create a beam optics analysis. Adaptivity is not 
used in this example. 

4.1.3.1  Creating a new Case

To begin, you will copy the first Case, Example 
1A, to a new Case, as follows.

1. Right click on the ‘Case: Example 1A’ case in 
the Project/Case Manager tree control. The 
submenu shown in Figure 155 will appear. 

2. Select Save Case As... from the sub-menu. The 
Copy Case Configurator dialog will appear. 

3. Change the name of the Case from ‘Copy of 
Example 1A’ to ‘Example 1C’ as shown in Figure 156. 

4.Uncheck the Copy Meshes checkbox. 
(You will generate a different initial mesh 
for this case.) Leave the other checkbox 
checked. 

5.Click OK. The new case will appear in 
the Project/Case Manager tree control and 
the model will appear in the graphics dis-
play region.

6.To add comments for Example 1C, right 
click on the new case (‘Case: Example 

1C’) in the Project/Case Manager tree control. Select Display/Edit Comments from the sub-
menu. The Display/Edit Comments dialog will appear. 

7. Modify the comments as shown in Figure 157. 

8. Click OK to close the dialog.

4.1.3.2  Saving a Case

As you continue through this example, it is a 
good idea to save your work occasionally. To 
save a case, right click on the Case name in the 
Project/Case Manager tree control and select 
Save Case. (Alternatively, open the File pull-
down menu and click Save Case.) 

4.1.3.3  Defining Analysis Type

Example 1C is an Electrostatic Beam analysis type. 

FIGURE 155. Save Case As... on the Case sub-menu

FIGURE 156. Copy Case dialog

FIGURE 157. Display/Edit Comments dialog
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1. Open the Analysis pulldown menu and select Electrostatic Beam analysis type. 

4.1.3.4  Assigning Beam Optics Attributes

Because this example is based on Example 1A, 
the geometry file has already been specified and 
the electrostatic attributes have already been 
assigned. Now you will assign the beam optics 
attributes. 

1. Open the Attribute Assignment Properties dia-
log. (Click on the Attributes menu item.) In the 
next few steps, the goal will be to define the 
surface of the cathode as a thermionic emitter. 
In order to better see the cathode, make sure 
the Anode and the Mod Anode are invisible by 
unchecking the Visible checkbox for both. 

2. Rotate the model so that the cathode surface is 
clearly visible as shown in Figure 158. To cen-
ter the visible model, open the View menu and 
click Refresh View.

FIGURE 158. Geometry rotated so that 
cathode emitter surface is visible.
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3. Click on the Beam Optics tab. The dialog shown in Figure 159 will appear. Unlike Figure 159, 
however, the Emitter Assignments table will be blank.

4. Leave the Beam Optic Parameters set to the defaults.

5. In the Emitter Assignments section, click the Thermionic Emitter Add button beneath the table. 
This will bring up the graphics display window containing the electrostatic geometry model. 

FIGURE 159. Attribute Assignment dialog box, Beam Optics tab
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6. Select the cathode surface by pressing Ctrl-Left mouse 
button. The cathode surface will appear selected (it 
will change color) as shown in Figure 160. Click enter 
to complete the selection. 

7. The dialog box shown in Figure 161 will appear. In 
this case, the surface you selected corresponds to a part 
surface named ‘emitter’ in the geometry file. There-
fore the Name box automatically shows the name 
‘emitter’ and it is not editable. (If the selected surface 
did not correspond to a named part surface in the 
geometry model, this field would be editable.) 

8. Set the Color dropdown box to ‘orange’. 

9. Set Approximate Number of Particle Launch Sites to 
‘100’.

10.In the Meshing Parameters (for Beam Analysis) box, define the cathode to anode spacing by 
entering 0.7 in the Cathode-to-Anode Spacing data entry box. (Leave the Grid Present check-
box unchecked.) 

11.Click OK to complete the emitter 
definition. The newly defined emit-
ter will appear in the Emitter Assign-
ments table as shown in Figure 159.

12.Click the Electrostatic tab. Check 
the Visible checkbox for the Anode 
and the Mod Anode to make them 
visible again. 

13.Click OK to close the Attribute 
Assignment dialog.

14.To reset the model position, open 
the View menu and select Reset 
View.

4.1.3.5  Generating the Initial Elec-
trostatic Mesh 

Once you complete the attribute assign-
ments, you are ready to generate the 
initial electrostatic mesh. Unlike in 
Examples 1A and 1B, you will define 
areas of finer mesh control.

FIGURE 160. Defining the cathode 

FIGURE 161. Defining a thermionic emitter
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1. Open the Meshing pulldown menu and select Parameters. The dialog box shown in Figure 162 
will appear. 

2. All tables in this section will be blank initially. In this example, the goal is to define the local 
mesh density (i.e., Local Mesh Refinements) for three different sets of surfaces. These include 
the tunnel of the anode, a portion of the focus electrode and the tunnel of the mod anode. 
(Defining a Local Mesh Refinement means that you specify the mesh for either a set of surfaces 
or for a part. The initial mesh generation will create these meshes closely to your specifica-
tions. Furthermore, when adaptation is requested, the adaptation routine may refine but never 
coarsen these meshes.) 

3. Click the Add Surface(s) button beneath the table in the Local Mesh Refinement section. This 
will bring up the graphics display window containing the electrostatic geometry model. 

FIGURE 162. Meshing Parameters Dialog Box
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4. Confirm that the model is oriented so that the Anode is in the front as shown in Figure 163. 

The goal is to define the portion shown in purple in the right-hand image (that is, the inner tun-
nel of the anode) as a Local Mesh Refinement (i.e., as a mesh controlled surface). Use the Ctrl-
Left mouse button to select the tunnel. The inside of the anode will appear selected (it will 
change color) and the status bar on the bottom of the screen will display the selected surface 
tags (48 and 50), as shown in Figure 164. (The internal algorithms used by BOA separate each 

part in the geometry model into multiple ‘surface tags’. In order to specify a desired set of sur-
faces in BoaGui, you usually have to make a separate selection for each surface tag. However, 
if the geometry file contains a ‘named surface’ (an optional feature in some CAD programs), 
BoaGui allows you to select all of the surface tags included in the named surface as one single 
entity. In this case, the JLAB Gun.SAT file contains the named surface ‘AnodeTunnel’ and it 
consists of surface tags 48 and 50. Because it is a named surface in the geometry file, you only 
need to select one of the tags; all tags associated with the named surface will automatically get 
included in the selection.) Click Enter to complete the selection.

FIGURE 163. The Anode Tunnel (Left image is prior to defining the AnodeTunnel model surface. Right 
image is after defining the AnodeTunnel model surface.)

FIGURE 164.  The Surface Tag IDs on the Status 
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5. The dialog in Figure 165 will appear. The 
Name entry box will not be editable. It will be 
prepopulated with the name ‘AnodeTunnel’. 
This is the name provided in the JLAB 
Gun.SAT file for this set of surface tags. Set 
the Color dropdown box to ‘purple’. Check 
both the Set Mesh Size and Set Curvature-
Based Refinement boxes. Leave the remain-
ing entries at their default values. Click OK to 
complete the surface definition.

6. The newly defined surface will appear in the 
Local Mesh Refinement section, as shown in 
the first entry of the table in Figure 166.

7. The next surface to define is part of the focus electrode. It will be easier to select if only the 
focus electrode is visible. Click the Attributes menu item to bring up the Attribute Assignment 
Properties dialog. (Notice that you can open this dialog without closing the Electrostatic Mesh 
Parameters (Optional) dialog. The Attribute Assignment Properties dialog simply pops up on 
top.) In the Properties at the Part Level table on the Electrostatics tab, make all parts invisible 
except the Focus Electrode. That is, select the Mod Anode and uncheck the Visible checkbox. 
Do the same for the Cathode and the Anode. Click OK to close the Attribute Assignment Prop-
erties dialog.

8. The Electrostatic Mesh Parameters (Optional) dialog will still be open. In the Local Mesh 
Refinement section, click the Add Surface(s) button beneath the table. This will bring up the 
graphics display window containing the electrostatic geometry model. 

9. Orient the model as shown in Figure 167. The goal is to define the portion shown in purple in 
the right-hand image as a Local Mesh Refinement (i.e., as a mesh controlled surface). Use the 
Ctrl-Left mouse button to make the necessary selections. You will need to move the model 
around in order to select all associated surface tags. (The internal algorithms used by BOA 
have broken this portion of the Focus Electrode part into eight separate surface tags: 36, 38, 39, 

FIGURE 165. Defining a Local Mesh 
Refinement for the Surface ‘Anode Tunnel’ 

FIGURE 166. Local Mesh Refinements
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40, 41, 42, 43, 44. Unlike with the selection of the Anode Tunnel in a the previous surface def-

inition, the JLAB Gun.SAT file does not contain a named surface for this area. Therefore you 
must make a selection for each of the eight surface tags separately. As you make each selec-
tion, the surface tag numbers will appear on the status bar.)

a. To begin, Select Add Surface(s) below the 
table in the Local Mesh Refinement sec-
tion. The dialog box will disappear 
exposing the model window. Ctrl-left 
click on any region indicated in purple in 
Figure 167, then hit Enter. The dialog 
shown in Figure 168 will appear. Enter 
FocusElectrodeSurface (without a space) 
in the Name box. Check the Set Mesh Size 
checkbox and the Set Curvature-Based 
Refinement checkbox and leave the asso-
ciated entries at their default values.

b. Click on Add Surface in the top right of 
the box. This will close the dialog box 
and return to the model window. Select another surface from the purple region shown in 
Figure 167. (You may need to move the Electrostatic Mesh parameters dialog to access the 
region.) Hit the Enter key to return to the Surface Local Mesh Refinement dialog and note 
that another surface tag was added to the Tag box. 

c. Repeat this procedure (Add Surface > select surface > Enter > Add Surface) until all purple 
regions shown in Figure 167 are selected. If you lose track of which surfaces have been 
selected, close the Surface Local Mesh Refinement dialog box and select FocusElectrodeS-
urface in the Local Mesh Refinement table. This will indicate by color which surfaces have 
been chosen. Select the Modify button to add any missed surfaces. (As you can see, select-

FIGURE 167. The Focus Electrode. (Left image is prior to defining the FocusElectrode surface. 
Right image is after defining the FocusElectrode surface.)

FIGURE 168. Defining a Local Mesh Refinement 
for the Surface ‘FocusElectrodeSurface’ 
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ing surfaces that have not been named in the CAD file can be tedious. For this reason, 
among others, it is highly recommended that you name all important surfaces in your CAD 
file prior to importing it into BOAGui.)

d. Once you have completed the ‘FocusElectrodeSurface’ definition, it will appear in the 
Local Mesh Refinement section, as shown in the second entry of the table in Figure 166.

5. The next surface to define is on the Mod Anode. It will be easier to select if you make only the 
Mod Anode visible. Click the Attributes menu item to bring up the Attribute Assignment Prop-
erties dialog. In the Properties at the Part Level table on the Electrostatics tab, select the Focus 
Electrode and uncheck the Visible checkbox, then select the Mod Anode and check the Visible 
checkbox. Click OK to close the Attribute Assignment Properties dialog.

6. The Electrostatic Mesh Parameters (Optional) dialog will still be open. In the Local Mesh 
Refinement section, click the Add Surface(s) button beneath the table. This will bring up the 
graphics display window containing the electrostatic geometry model. 

7. Turn the model so that the Mod Anode is oriented as shown in Figure 169. The goal is to con-
trol the mesh density on the portion shown in purple in the picture on the right. As before, 
select Add Surface(s) in the Local Mesh Refinement region and use the Ctrl-Left mouse button 
to select one of the surfaces. This will select a named surface with two tags (surface tags 14 
and 17). 

8. Click Enter. The dialog box in Figure 165 will appear. The Name box will not be editable. It 
will be prepopulated with the name ‘ModTunnel’. (This is the name given in the JLAB 
Gun.SAT file for the named CAD surface consisting of tags 14 and 17.) Set the Color to ‘pur-
ple’. Check the Set Mesh Size checkbox and the Set Curvature-Based Refinement checkbox and 
leave the associated entries at their default values.

9.  Click OK to complete the surface definition. 

FIGURE 169. The Mod Anode. (Left image is prior to defining the ModAnodeSurface 
model surface. Right image is after defining the ModAnodeSurface model surface.)
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10.The newly defined surface will appear in the table in the Local Mesh Refinement section, as 
shown in the third entry of the table in Figure 166.

11.Click OK to close the Electrostatic Mesh Parameters (Optional) dialog.

12.Click the Electrostatic tab. Check the Visible checkbox for the Cathode, Focus Electrode and 
Anode to make them visible again. Uncheck the Visible checkbox for the Mod Anode to make 
it invisible for the remainder of the example. It's not necessary to see it and it hides the interior 
of the gun.) 

13.Open the Meshing pulldown menu and select Generate Initial Electrostatic Mesh. 

14.A DOS window will appear indicating progress during the mesh generation process. When the 
process completes, the following text will appear at the bottom of the window: “Mesh Genera-
tion Complete, mesh file created: JLAB Gun.sms”. !Press any key to close the DOS window 
and return control back to the user interface. 

4.1.3.6  Viewing the Initial 
Electrostatic Mesh

1. To view the initial mesh, 
open the Meshing pulldown 
menu. Select Display Initial 
Mesh and then select Com-
plete. The mesh will appear 
in the graphics display 
region. 

2. To get the exact orientation 
shown in Figure 170, click 
on the View pulldown menu 
and select Orientation->Iso-
metric. You may need to use 
the zoom out feature to view 
the entire mesh. Right-click 
on the mouse and drag it 
backward (or down) until the 
complete mesh is in view. 

FIGURE 170. Initial Electrostatic Mesh



BOA Version 4, User Manual v0.5 updates in progress[5/10] 133

3. To display only a part of the mesh, use the Extent Clipping feature. Open the Meshing pull-
down menu and select Extent Clipping Initial Mesh. The Mesh Extent Clipping dialog shown 
in Figure 171 will appear.

4. Change the X Max value to “0” and click OK. The partial mesh will appear in the graphics dis-
play region as shown in Figure 172.

FIGURE 171. Mesh Extent Clipping dialog

FIGURE 172. Initial Electrostatic Mesh with Extent Clipping 
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5. To get an even better look at the mesh, slice the model. Click on the View menu item and select 
Slice Model. The Slice Electrostatic Model dialog shown in Figure 173 will appear. On the 

Choose Plane section, select ‘yz plane’. In the Slicing Side section, select ‘Positive Side’. Click 

FIGURE 173. Slice Electrostatic Model dialog
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Close. The image in Figure 174 will appear. Notice that the mesh is much more refined around 
the thermionic emitter and in the areas you defined as Local Mesh Refinements (i.e., ‘Anode-
Tunnel, ‘FocusElectrodeSurface’ and ‘ModTunnel’).

6. To turn off the Extent Clipping feature, reopen the Mesh Extent Clipping dialog (i.e., open the 
Meshing pulldown menu and select Extent Clipping Initial Mesh) and turn the Clipping State 
radio button to ‘Off’. 

7. To hide the initial mesh, open the Meshing pulldown. The Display Initial Mesh->Complete 
item is preceded by a check mark, indicating that the initial mesh is displayed. Click it to 
‘uncheck’ it and the mesh display will turn off. 

8. To show the complete model again, open the View menu and select Slice Model. On the Slice 
Electrostatic Model dialog, set the State radio button to ‘Off’.

9. Click Close to close the Slice Electrostatic Model dialog. 

4.1.3.7  Executing BOA (without Adaptive Meshing)

Once the initial mesh is generated, you can execute the BOA engine.

1. Open the Execute pulldown menu and select Single Case->Execute BOA. 

2. The Execute Single Case (Electrostatic Analysis) dialog will appear. (This dialog was shown in 
Example 1A, Figure 135.) 

FIGURE 174. Initial Electrostatic Mesh with Extent Clipping and Sliced Model
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3. Leave all parameters set to the default values. (As in Example 1A, note that Max Number of 
Adaptivity Passes is set to ‘0’. This means the mesh will not be adapted for this run.) Click 
Execute. 

4. A DOS window will appear indicating progress during BOA execution. Note that this run will 
usually take longer than Examples 1A and 1B. When BOA completes, the following text will 
appear at the bottom of the window “Proceed to View Results but first Press any key to con-
tinue/exit”. Hit any key to close the DOS window and return control back to the user interface. 

Notice that the lower right corner is used to monitor the progress of the simulation. The conver-
gence plot displays the beam current, the relative errors of the electric field and emission current 
versus particle iterations. (For a clearer and larger display, you can show the plot in the main win-
dow or a new window by going to View menu and selecting Plot Parameters. On the resulting 
Plot Control Parameters dialog, set the Plot Type dropdown box to ‘Convergence’ and the Plot 
Display Location dropdown box to ‘Main Window’ or ‘New Window’.)

4.1.3.8  Viewing Beam Analysis Results

Once BOA completes, you can immediately view the beam optics results. 

1. Open the View Results pulldown menu. Click on Beam Analysis. The Beam Optics Display 
Control Panel dialog will open and the trajectories will automatically appear (per the default 
settings) as shown in Figure 175.

FIGURE 175. Trajectories On (shown with the model sliced)
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2. To get a better look at the trajectories, slice the 
model. First click on the View menu item and 
select Slice Model. The Slice Electrostatic 
Model dialog will appear (Figure 176). 

3. In the Choose Plane section, select the ‘zx’ 
radio button. 

4. In the Slicing Side section, select ‘Negative 
Side’ radio button. 

5. Click Close. The model will be sliced in half, 
exposing the trajectories, as shown in 
Figure 177. 

6. Use the right-mouse button to zoom in on the 
trajectories, as desired.

7. To view the intersection of the trajectory parti-
cles on a desired plane, change the Display 
Traj/Planar Particles radio button to ‘Planar 
Particles’. 

FIGURE 176. Slice Electrostatic Model dialog

FIGURE 177. Trajectories On (shown with the model sliced)
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8. In the Planar Particles section, leave the Choose Plane radio button set to ‘xy’, and use the 
Normal Distance edit box or slider to define a desired distance. In Figure 178, the Normal Dis-
tance is set to -0.75.    

FIGURE 178. Planar Particles
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9. Next, generate a coordinated plot of the planar particles and create an output file. Select the 
Output File and Plot radio button and click Generate. The coordinated particle plot appears in 
the main window as shown in Figure 179. The detailed beam profile characteristics appear in 
the Plot Statistics section of the Beam Optics Display Control Panel dialog. The particle output 
file named ‘papa.ppo’ is saved to the case directory.

10.To return to the pre-plot state of the Beam Optics Display Control Panel dialog, click Return. 
Experiment with other parameters and results, as desired. To close the Beam Optics Display 
Control Panel, click Close. 

If desired, you can also view the Electrostatic results (as you did in Examples 1A and 1B). 

Before closing the case, make sure to save it. Right-click on the case name in the Project/Case 
Tree Control and select Save Case.

FIGURE 179. Coordinated Plot of planar Particles
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4.2  Example 2 - Multi-stage Depressed Collector (MSDC) 

In this example, BOA is 
used to perform both an 
Electrostatic Beam analysis 
and an Electro/Magneto-
static Beam analysis on a 
multi-staged depressed col-
lector (MSDC). A cross sec-
tion of the is shown in 
Figure 180. An injected 
beam enters through a open-
ing in the body of the shown 
on the right side of the dia-
gram. The voltage on both 
the body and stage 1 is 
25000 Volts. The voltage is 
16000 volts on stage 2, 
8000 Volts on stage 3 and 0 
Volts Stage 4.

This example consists of two different cases. Example 2A illustrates a basic electrostatic beam 
analysis with an injected beam. Example 2B builds on 2A but adds an external magnetic field and 
secondary emitter surfaces. 

4.2.1  Example 2A - Electrostatic Beam Analysis (with Injected Beam)

4.2.1.1  Getting Started 

1. Open BoaGui.exe by clicking on the BoaGui icon on your desktop or the BoaGui icon in the 
Start menu.

4.2.1.2  Creating a New Project

1. Go to the File pulldown menu and select New 
Project. The dialog in Figure 181 will appear. 
Unlike the screen shown in Figure 181, initially 
the first two data entry boxes will be blank.

2. Use the Browse button to locate the ‘Boa 
Examples’ directory that you created in Exam-
ple 1. 

3. Specify the Project Name in the box provided. 
In this example, the Project Name is ‘ Project’. 

4. Leave the User Material Library Location as is. 
It is not used in this example. (This directory automatically defaults to your computer’s home 
directory.) 

FIGURE 180. Cross section of Multi-stage Depressed Collector 

FIGURE 181. New Project Dialog Box 
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5. Click OK. The new Project will appear in the Project/Case Manager tree control on the right 
side of the BoaGui screen. Behind the scenes, a Project folder will be created in the specified 
location. The project folder will contain the BOA Project file (*.boa) and all associated Case 
folders.

4.2.1.3  Creating a New Case

1. Right click on ‘ Project’ in the 
Project/Case Manager tree con-
trol. The popup menu shown in 
Figure 182 will appear. 

2. Select Add New Case. The dia-
log shown in Figure 183 will 
appear. (Initially the data entry 
fields will be empty.)

3. Specify the Case Name in the 
box provided. In this example the Case 
Name is ‘Example 2A’.    

4. Select ‘Electrostatic Beam’ in the Anal-
ysis Type dropdown box.

5. If desired, add Case Comments to 
describe the case as shown in 
Figure 183. 

6. Leave the Open Case Now checkbox 
checked. 

7. Click OK. The new Case will appear 
beneath the Project in the Project/Case 
Manager tree control as shown in 
Figure 184. Behind the scenes, a new 
Case folder will be placed in the cur-
rent Project folder. The case folder will include all files specific to the case.

4.2.1.4  Saving a Case

FIGURE 182. The Project/Case Tree Control (shown with right-
click menu opened) 

FIGURE 183. Add New Case dialog

FIGURE 184. Project/Case Tree Control (with Case opened)
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As you continue through this example, it is a good idea to save your work occasionally. To save a 
case, right click on the Case name in the Project/Case menu bar and select Save Case. (Alterna-
tively, open the File pulldown menu and click Save Case.) 

4.2.1.5  Specifying the Geometry File

Next, specify the geometry file on which 
to base the analysis. The Boa installation 
includes the geometry file you will need 
to complete this example as discussed 
below. 

1. Click on the Model menu item and 
the dialog shown in Figure 185 will 
appear. (Unlike Figure 185, initially 
the Geometry Solid Model File data 
entry box will be blank.) 

2. Click the Browse button next to the 
Geometry Solid Model File entry box 
to locate the geometry file. This will 
bring up a Browse window that 
allows you to locate the desired 
geometry file.

3. Locate the file ‘.SAT’. If you installed 
BOA using the default directory set-
tings, this file will be located in C:/
Program Files/CCR/Beam Optics 
Analyzer/Examples/CAD Files. Select the file and click Open (or alternatively, double-click on 
the file). 

4. The informational 
message shown in 
Figure 186 will 
inform you that 
BoaGui will cre-
ate a copy of the 
file and place it in 
the current Case 
directory. Click Yes. 

5. The name of the geometry file will appear in 
the Geometry Solid Model File entry box, as 
shown in Figure 185. 

FIGURE 185. Geometry Model Parameters dialog

FIGURE 186. Geometry File Copy Message

FIGURE 187. Initial Model Verification Message
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6. The Model Units will appear undefined until you load the model. Click Load Model and an 
informational message will inform you that the initial model has been loaded and verified, as 
shown in Figure 187. Click OK. 

7. A second informational message will inform 
you that the final model has been loaded and 
verified as shown in Figure 188. Click OK. 
(The initial model is the model you specified, 
as is. The final model is the initial model plus 
modifications necessary to make it usable by 
BOA.) 

8. The model units used in the SAT file will 
appear at the bottom of the Geometry Model Parameters dialog. In this case, the units are set to 
‘inches’. 

9. Click OK to exit the Geometry Model Parameters dialog. 

10.The geometry model will appear in the graphics display region as shown in Figure 189. 

4.2.1.6  Viewing the Geometry Model

1. Experiment with moving the model around in the graphics display window. To spin the model 
around, hold down the left mouse button and move the mouse around. To zoom in, hold down 
the right mouse button and move the mouse forward (or ‘up’). To zoom out, hold down the 
right mouse button and move the mouse backward (or ‘down’). (Note: These directions assume 

FIGURE 188. Final Model Verification Message

FIGURE 189. Geometry Model for MSDC
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you are in the Trackball mode, which is the default. If you are in Joystick mode, see Section 3.5 
for details on mouse control.) You may also want to experiment with different settings on the 
View menu, such as predefined Orientations, and different options for Surface Representation 
(‘Wireframe’ vs. ‘Surface’) and View Representation (‘Orthogonal’ vs. ‘Perspective’). 

2. To return to the orientation shown in Figure 129, click View->Reset View. 

4.2.1.7  Assigning Electrostatic Attributes 

Now you are ready to 
begin assigning attributes. 

1. Click on the Attributes 
menu item. The 
Attribute Assignment 
Properties dialog 
shown in Figure 190 
will appear, with the 
Electrostatics tab 
active. 

2. The table in the Prop-
erties at the Part Level 
section shows all parts 
contained in the geom-
etry file. The part 
names are identical to 
the names provided in 
the geometry file and 
they are not editable. 
Initially BoaGui will 
assign default 
attributes to all parts. 
Typically, the user will 
want to change most or 
all of the assigned 
attributes. The table 
also contains the ‘Background’ part. This part is not in the geometry file. It is created by 
BoaGui based on the settings in the Model Geometry Parameters dialog. The Visible checkbox 
is checked for all parts except the Background part.   

3. Highlight the Stage 1 part. Leave the Color dropdown box set to ‘default’. Check the Voltage 
Assigned to Entire Part checkbox and enter ‘25000’ in the data entry box. Set the Find Another 
Rel. Permittivity (Optional) dropdown box to ‘Copper’. 

FIGURE 190. Attribute Assignment dialog box, Electrostatic tab
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4. Highlight the Stage 3 part and assign the attributes shown in Table 2 below. 

5. Highlight the Emitter part and assign the attributes shown in Table 2 above. 

6. Highlight the Stage 4 part and assign the attributes shown in Table 2 above. 

7. Highlight the Stage 2 part and assign the attributes shown in Table 2 above.

8. Highlight the Body part and assign the attributes shown in Table 2 above.

9. You have now completed the definition of properties at the part level. (The Properties at the 
Surface Level section allows you to define properties for specific surfaces on parts in the elec-
trostatic geometry model. For this example, there will be no entries in this table.)

4.2.1.8  Assigning Beam Optics Attributes (Injected Emitter)

Next you will assign the beam optics attributes. For 
this case, this means defining the injected emitter sur-
face and specifying the emitter part as optically trans-
parent.

1. The Attribute Assignment Properties dialog should 
still be open with the Electrostatic tab active. In the 
next few steps, the goal will be to define the sur-
face of the part named ‘Emitter’ as an Injected 
Emitter. In order to better see the emitter, make 
Stage 1, Stage 2, Stage 3 and Stage 4 invisible by 
unchecking the Visible checkbox for each. 

2. Rotate the model so that the emitter surface is 
clearly visible as shown in Figure 191. To center 
the visible model, open the View menu and click 
Refresh View.

TABLE 2. Attribute Assignments for case 

FIGURE 191. Geometry rotated so that 
emitter surface is visible (in yellow).
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3. Click on the Beam Optics tab. The dialog shown in Figure 192 will appear. Unlike Figure 192, 
however, both the Emitter Assignments table and the Optically Transparent Parts table will be 
blank.

4. Leave the Beam Optic Parameters set to the defaults.

5. In the Emitter Assignments section, click the Injected 
Emitter Add button beneath the table. This will bring 
up the graphics display window containing the geom-
etry model.

6. Zoom in on the emitter by right-clicking the mouse 
and moving it forward (or up). Select the emitter sur-
face by pressing Ctrl-Left mouse button. The emitter 
surface will appear selected (it will change from yel-
low to green) as shown in Figure 193. Click enter to 
complete the selection. 

FIGURE 192. Attribute Assignment dialog box, Beam Optics tab

FIGURE 193. Defining the injected emitter
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7. The Injected Emitter Parameters dialog shown in Figure 194 will appear (though the Injected 
Emitter File Name data entry field will be blank initially). In this case, the surface you selected 
corresponds to a part surface named ‘Emitter’ in the geometry file. Therefore the Name box 
automatically shows the name ‘Emitter’ and it is not editable. (If the selected surface did not 
correspond to a named part surface in the geometry model, this field would be editable.) Leave 
the Color dropdown box set to ‘red’. 

8. Use the Browse button to locate the injected beam file ‘_InjectedBeam.ibf’. If you installed 
BOA using the default directory settings, this file will be located in C:/Program Files/CCR/
Beam Optics Analyzer/Examples/Data Files. Select the file and click Open (or alternatively, 
double-click on the file). (Note: This beam profile was obtained from running a separate com-
puter code called ‘MAGIC’. You can also create a beam profile using BoaGui’s built-in Cibo 
tool (Tools->Cibo).)

FIGURE 194. Injected Emitter Parameters dialog 
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9. The informational 
message shown in 
Figure 195 will 
inform you that 
BoaGui will cre-
ate a copy of the 
file and place it in 
the current Case 
directory. Click Yes. 

10.Back on the Injected Emitter Parameters dialog, leave the File Format for Planar Emitter 
radio button set to ‘BOA Format’ with ‘Transformation required’ and Axis of Original Spent 
Beam set to ‘z’. 

11.Click OK to complete the emitter definition and close the Injected Emitter Parameters dialog. 
The newly defined emitter will appear in the Emitter Assignments table as shown in 
Figure 192.

12.In the Optically Transparent Parts section, click the Add button next to the table. This will 
bring up the graphics display window containing the geometry model. 

13.Select the Emitter part by pressing Ctrl-Left mouse button anywhere on the part. The entire 
Emitter part will appear selected (it will change color). Click Enter to complete the selection. 

14.The part will appear in the Optically Transparent Parts table as shown in Figure 192. (This 
part is considered optically transparent because it is not a physical entity. It models an injected 
beam.) 

15.Click the Electrostatic tab. Check the Visible checkbox for all parts (except the background) to 
make them visible again. 

16.Click OK to close the Attribute Assignment Properties dialog.

17.To reset the model position, open the View menu and select Reset View.

Note: It is a good idea to save your work occasionally. Take this opportunity to save changes to 
the case by right-clicking on the case name in the Project/Case menu bar and selecting Save Case. 

4.2.1.9  Generating the Initial Electrostatic Mesh

Once you complete the attribute assignments, you are ready to generate the initial electrostatic 
mesh. In this example, the default mesh parameters are sufficient so you do not need to open the 
Mesh Parameters dialog. 

1. Open the Meshing pulldown menu and select Generate Initial Mesh. 

2. A DOS window will appear indicating progress during the mesh generation process. When the 
process completes, the following text will appear at the bottom of the window: “Mesh Genera-
tion Complete, mesh file created: _E.sms !Press any key to continue/exit...”. Hit any key to 
close the DOS window and return control back to the user interface. 

FIGURE 195. Injected Beam File Copy Message
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(If desired, you can view the mesh by opening the Meshing pulldown menu and selecting Display 
Initial Mesh. The mesh will appear in the graphics display region. This step was illustrated in the 
previous JLAB example. See Example 1A for details.) 

4.2.1.10  Executing BOA

Once the initial mesh is generated, 
you can execute the BOA engine.

1. Open the Execute pulldown menu 
and select Single Case->Execute 
BOA. 

2. The dialog box shown in 
Figure 196 will appear. 

3. Leave all parameters set to the 
default values. (Note that Max 
Number of Adaptivity Passes is set 
to ‘0’which means the mesh will 
not be adapted for this run.) Click 
Execute. 

4. A DOS window will appear indi-
cating progress during BOA exe-
cution. When BOA completes, the 
following text will appear at the 
bottom of the window “Proceed to 
View Results. Press any key to 
continue/exit”. Hit any key to 
close the DOS window and return 
control back to the user interface.

4.2.1.11  Viewing Beam Analysis Results 

For this example, you will proceed directly to the Beam Analysis results to view the trajectories 
and the power densities on the interior surfaces of the collector. 

FIGURE 196. Execute Boa 
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1. Open the View Results pulldown menu and select Beam Analysis. The Beam Optics Display 
Control Panel dialog shown in Figure 197 will appear.

2. By default, the Display Traj/Planar Particles radio button is set to display ‘Trajectories’. In 
order to view the trajectories inside the collector, you will need to slice the model. Go to the 
View menu and select Slice Model. 

3. On the resulting Slice Electrostatic Model dialog, select the ‘zx plane’ (in the Choose Plane 
section). The trajectories will be exposed as shown in Figure 198. Click Close to close the Slice 
Electrostatic Model dialog.

FIGURE 197. Beam Optics Display Control Panel dialog
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4. Use the mouse to zoom in on the trajectories as desired. When you are done, use the Reset View 
(on the View menu) to reset the view.

5. Next, take a look at the power densities on various surfaces inside the collector. For better 
viewing, first turn off the trajectories by setting the Display Traj/Planar Particles radio button 
to ‘Off’ on the Beam Optics Display Control Panel. 

6. Set the Display 
Power Densities 
radio button to 
‘On’. Because you 
have not selected 
any surfaces yet, a 
blank version of 
the Surface Selec-
tor dialog shown 
in Figure 199 will 
automatically pop 
up. 

7. Click the Add Sur-
face(s) button 
beneath the table. This will bring up the graphics display window containing the geometry 
model. 

FIGURE 198. Trajectories

FIGURE 199. Surface Selector dialog
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8. Rotate the model so that 
you can see the face sec-
tions of Stages 1, 2 and 3, 
as shown in Figure 200. 

9. Select the Stage 1 Face by 
pressing the Ctrl-Left 
mouse button. (The Stage 
1 Face surface is a named 
surface in the CAD file 
consisting of tags 8 and 
9.) The Stage 1 Face will 
appear selected (i.e., it 
will change from the 
default pink color to a 
dark green). Press Enter 
and the Stage 1 Face will 
appear in the Selected 
Surfaces table. 

10.Next, add the Stage 2 
Face surface. Again click 
the Add Surface(s) button 
beneath the table on the 
Surface Selector dialog. This will bring up the graphics display window containing the geome-
try model. 

11. Select the Stage 2 Face by pressing the Ctrl-Left mouse button. (The Stage 2 Face surface is a 
named surface in the CAD file consisting of tags 44 and 45.) The Stage 2 Face will appear 
selected (it will change from cyan to a dark green). Press Enter and the Stage 2 Face will 
appear in the Selected Surfaces table. 

12.Repeat the above procedure two more times to add the Stage 3 Face (a named CAD surface 
consisting of tags 20 & 21) and the Stage 3 Wall (a named CAD surface consisting of tags 23 & 
24). 

13.After you have added all four surfaces, the Selected Surfaces table should appear as shown in 
Figure 199. Click OK to close the Surface Selector dialog.

FIGURE 200. Geometry model oriented to show Stage 1, 2 and 3 Faces
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14.The power densities will 
appear on all four surfaces 
as shown in Figure 201. 

15.Experiment with the set-
tings in the Power Densi-
ties (W/m^2) section of the 
Beam Optics Display Con-
trol Panel dialog to see 
how the picture in the 
graphics display window 
changes. For example, 
increase the No. of Con-
tours to get a more accu-
rate look at power 
densities. Or highlight the 
regions of highest inten-
sity by increasing the Min 
value for the range. 
Figure 202 shows the No. 
of Contours set to ‘400’ 
and the Min value set to ‘1000000’ W/m^2. Notice the region of highest intensity on the Stage 
1 Face. 

FIGURE 201. Power densities shown on four defined surfaces (20 contour

FIGURE 202. Power Densities shown on Stage 1, 2 and 3 Faces and Stage 3 Wall. 
(No. of Contours = 400 and Min value = 1000000)



154 [5/10] BOA Version 4, User Manual v0.5 updates in progress

4.2.1.12  Viewing Electrostatic Results 

If desired, you can also view the Electrostatic results as you did in Examples 1A and 1B. Remem-
ber, the first time you click on View Results->Electrostatics you will be prompted to run the Elec-
trostatic postprocessor.

4.2.1.13  Saving the Case

Before closing the case, make sure to save it. Right-click on the case name in the Project/Case 
Tree Control and select Save Case. 

4.2.2  Example 2B - Electro/Magnetostatic Beam Analysis w/ Secondary Emissions 

This example extends Example 2A by adding an external magnetic field and adding secondary 
emissions. 

4.2.2.1  Creating a New Case

To begin, you will copy the previous Case, Exam-
ple 2A, to a new Case, as follows.

1. Right click on the ‘Case: Example 2A’ case in 
the Project/Case Manager tree control. The 
submenu shown in Figure 203 will appear. 

2. Select Save Case As... from the sub-menu. The 
Copy Case Configurator dialog will appear. 

3. Change the name of the Case from ‘Copy of 
Example 2A’ to ‘Example 2B’ as shown in 
Figure 204. 

4.Uncheck the Copy Meshes 
checkbox. (You will generate a 
different initial mesh for this 
case.) Leave the other checkbox 
checked. 

5.Click OK. The new case will 
appear in the Project/Case Man-
ager tree control and the model 
will appear in the graphics display 
region.

6.To add comments for Example 
2B, right click on the new case (‘Case: Example 2B’) in the Project/Case Manager tree control. 
Select Display/Edit Comments from the sub-menu. The Display/Edit Comments dialog will 
appear. 

7. Modify the comments as shown in Figure 205. 

FIGURE 203. Save Case As... on the Case sub-menu

FIGURE 204. Copy Case dialog
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8. Click OK to close the dialog.

4.2.2.2  Saving a Case

As you continue through this example, it is 
a good idea to save your work occasion-
ally. To save a case, right click on the Case 
name in the Project/Case Manager tree 
control and select Save Case. (Alterna-
tively, open the File pulldown menu and 
click Save Case.) 

4.2.2.3  Defining Analysis Type

In Example 2B you will add an external 
magnetic field. So this is an Electro/Magnetostatic Beam analysis type. 

1. Open the Analysis pulldown menu and select Electro/Magnetostatic Beam analysis type. 

4.2.2.4  Defining the External Magnetic Field

This example is based 
on Example 2A. There-
fore the geometry file 
has been specified, the 
electrostatic attributes 
have been assigned and 
the injected emitter (a 
beam optics attribute) 
has been defined. Next 
you will add the exter-
nal magnetic field. 

1. Open the Attribute 
Assignment Proper-
ties dialog (shown 
in Figure 206) by 
clicking on the 
Beam Optics tab. 

2. In the External 
Magnetic Field 
Options section, set 
the drop-down box 
to ‘1D Axial 
Imported Magnetic 
Flux Density’. 

FIGURE 205. Display/Edit Comments dialog

FIGURE 206. Attribute Assignment Properties dialog
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3. The dialog in 
Figure 207 will pop 
up. 

4. Use the Browse but-
ton next to the 1D 
Axial Magnetic Flux 
entry box to locate the 
external magnetic 
field file named 
‘_Bz.bf’. If you 
installed BOA using 
the default directory 
settings, this file will 
be located in C:/Pro-
gram Files/CCR/Beam 
Optics Analyzer/
Examples/Data Files. Select the file and click Open (or alternatively, double-click on the file). 

5.  The message shown in 
Figure 208 will give you the 
option to create a copy of the 
external magnetic field file in the 
current Case directory. Click Yes. 

6.  Back on the 1D Axial Mag-
netic Flux Density Parameters 
dialog, set the Largest Field 
Radius to ‘1.6’ (half of the outer 
diameter of the collector), the 

Grid Unit to ‘in’ and the Num r Coord to ‘51’.

7. Before clicking OK, you can 
choose to visually inspect a plot of 
the magnetic field to confirm it is 
correct. Click the Plot to Verify 
Field button. The information 
message shown in Figure 209 will 
warn you that the z bound of the 
magnetic field is inside of the 
problem domain. In this case, this 
is expected because [Thuc please 
give me a short explanation of 
why this is expected behavior]. 

FIGURE 207. 1D Axial Magnetic Flux Density Parameters UPDATE (num 
r coord should not default to 0)

FIGURE 208. Copy File Message for the External 
Magnetic Field File

FIGURE 209. Information Message about the location of the 
magnetic field boundary within the problem domain 
UPDATE? Did this message change? Now includes x and y too
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8. A plot of the external magnetic field will appear in the main window, as shown in Figure 210.

9. When you are satisfied that the external magnetic field is correct, click OK on the 1D Axial 
Magnetic Flux Density Parameters dialog to close the plot. The main window will return to the 
geometry model and the1D Axial Magnetic Flux Density Parameters dialog will close.

4.2.2.5  Defining the Secondary Emitters

Next you will define the secondary emitters

1. The Attribute Assignment Parameters dialog should still be open, with the Beam Optics tab 
active. 

2. In the Emitter Assignments section, click the Secondary Emitter Add button beneath the table. 
This will bring up the graphics display window containing the geometry model. 

3. In order to specify the secondary emitter surfaces, you will first need to slice the model to 
expose the interior of the collector. Open the View menu and select Slice Model. On the result-
ing Slice Electrostatic Model dialog, select the ‘zx plane’ in the Choose Plane section. Click 
Close to close the Slice Electrostatic Model dialog.

FIGURE 210. Plot of the 1D Axial Magnetic Flux Density
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4. Rotate the model so that you can 
see the face sections of Stages 1, 2 
and 3, as shown in Figure 211. 

5. Select the Stage 1 Face by pressing 
the Ctrl-Left mouse button. (The 
Stage 1 Face surface is a named 
surface in the CAD file consisting 
of tags 8 and 9.) The Stage 1 Face 
will appear selected (i.e., it will 
change from the default pink color 
to a dark green). Press Enter and the 
Assign Secondary Electron Emis-
sion Parameters dialog will appear 
(shown in Figure 212). 

6. On the Assign Secondary Electron 
Emission Parameters dialog, 
change the Color to ‘Yellow’ and 
leave all other parameters at their 
default values (Number of Second-
aries = ‘3’, Surface Material = 
‘Copper’ and the secondary model 
set to ‘Atomic Specification’). 

7. Click OK to close the dialog. 

8. The new secondary emitter will 
appear as the second entry in the 
Emitter Assignments table on the 
Assign Attributes Properties dia-
log, as shown in Figure 213. 
(Figure 213 shows the Emitter 
Assignments table with four second-

FIGURE 211. Geometry model oriented to show Stage 1, 2 
and 3 Faces

FIGURE 212. Assign Secondary Electron Emission 
Parameters dialog
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ary emitters. This is how the table will appear after you have completed all secondary emitter 
definitions, as described in the next few steps.)

9. Next, define the Stage 2 Face as a secondary emitter. Again, click the Secondary Emitter Add 
button beneath the Emitter Assignments table. This will bring up the graphics display window 
containing the geometry model. 

10. Select the Stage 2 Face by pressing the Ctrl-Left mouse button. (The Stage 2 Face surface is a 
named surface in the CAD file consisting of tags 44 and 45.) The Stage 2 Face will appear 
selected (it will change from cyan to a dark green). Press Enter and the Assign Secondary Elec-
tron Emission Parameters dialog will reappear. 

11.Again change the Color to ‘Yellow’ and leave all other parameters at their default values.

12.Click OK to close the dialog. The new secondary emitter will appear as the third entry in the 
Emitter Assignments table (Figure 213) on the Assign Attributes Properties dialog.

13.Repeat the above procedure two more times to define Stage 3 Face (a named CAD surface 
consisting of tags 20 & 21) and the Stage 3 Wall (a named CAD surface consisting of tags 23 & 
24) as secondary emitters. 

14.After you have added all four secondary emitters, the Emitter Assignments table should appear 
as shown in Figure 213. (Note: As discussed in the next section, BoaGui will automatically 
generate Local Mesh Refinements for each of these surfaces. (It is important to model these 
surfaces with a higher degree of accuracy since they are now defined as secondary emitters.) 

15.Click OK to close the Attribute Assignment Properties dialog.

16.{Thuc, sometimes when I close the Attribute Assignment Properties dialog, the geometry 
model appears a little odd. See separate email message. Generating the Initial Electrostatic 
Mesh} check if still happening

Once you complete the attribute assignments, you are ready to generate the initial electrostatic 
mesh. 

1. Open the Meshing pulldown menu and select Parameters. 

FIGURE 213. Emitter Assignments table shown with four Secondary Emitters defined
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2. The Electrostatic Mesh Parameters (Optional) dialog will appear, as shown in Figure 214. 
Notice that Local Mesh Refinements table contains four entries that you did not explicitly cre-
ate. BoaGui automatically generated these entries -- one local mesh refinement for each of the 
secondary emitter surfaces that you defined in the previous section. (BOAGui auto-generates 
these entries because is important to model secondary emitter surfaces more accurately.)

3. No changes are needed to the meshing parameters, so click OK to close the dialog. Click 

4. Reopen the Meshing menu and select Generate Initial Mesh.

5. A DOS window will appear indicating progress during the mesh generation process. When the 
process completes, the following text will appear at the bottom of the window: “Mesh Genera-
tion Complete, mesh file created: _E.sms !Press any key to continue/exit...”. Hit any key to 
close the DOS window and return control back to the user interface. 

(If desired, you can view the mesh by opening the Meshing pulldown menu and selecting Display 
Initial Mesh. The mesh will appear in the graphics display region. This step was illustrated in the 
previous JLAB example 1A. See Example 1A for details.)

4.2.2.6  Executing BOA

Once the initial mesh is generated, you can execute the BOA engine.

1. Open the Execute pulldown menu and select Single Case->Execute BOA. 

FIGURE 214. Local Mesh Refinements table shown with four automatically generated 
entries (corresponding to the four secondary emitters)
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2. Leave all parameters set to the default values. (Note that Max Number of Adaptivity Passes is 
set to ‘0’which means the mesh will not be adapted for this run.) Click Execute. 

3. A DOS window will appear indicating progress during BOA execution. When BOA com-
pletes, the following text will appear at the bottom of the window “Proceed to View Results. 
Press any key to continue/exit”. Hit any key to close the DOS window and return control back 
to the user interface. (Expect this run to take longer than the previous run.)

4.2.2.7  Viewing Beam Analysis Results 

For this example, you will proceed directly to the Beam Analysis results to view the trajectories 
for the three different generations of secondaries. 

1. Open the View Results 
pulldown menu and select 
Beam Analysis. The Beam 
Optics Display Control 
Panel dialog shown in 
Figure 215 will appear.

2. By default, the primary 
trajectories are shown. 
(The Display Traj/Planar 
Particles radio button is 
set to display ‘Trajecto-
ries’ and the Generation 
No checkboxes in the 
Emitters and Trajectories 
section show only the ‘0’ 
generation checked.) 

FIGURE 215. Beam Optics Display Control Panel dialog
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3. To show the trajectories for different 
generations of secondaries, check the 
desired Generation No in the Emitters 
and Trajectories section. For example, 
Figure 216 shows the primaries and 
the first generation of secondaries. 
(The Generation No checkboxes are 
checked for ‘0’ and ‘1’.) 

4. Figure 218 shows the primaries and 
the first and second generation of sec-
ondaries. (The Generation No check-
boxes are checked to include ‘0’, ‘1’ 
and ‘2’.) 

5. Figure 218 shows the primaries and 
the first, second and third generation 
of secondaries. (The Generation No 
checkboxes are checked to include 
‘0’, ‘1’, ‘2’ and ‘3’.) 

6. You can also turn different emitter 
surfaces on and off using the check-
boxes in front of the Emitter names in 
the Emitter table. Play around with 
these controls to see how the display 
changes. Zoom in and out to get a 
closer look at the trajectories.

7. If desired, you can also change the 
color of the trajectories. Open the 
View menu and select Color->Trajec-
tories. On the resulting Color Trajec-
tories dialog, select the desired 
generation and click Change Color. 
The Color palette dialog will pop up. 
Select a color and click OK to change 
the color and close the Color palette. 
To close the Color Trajectories dia-
log, click the Close button. 

4.2.2.8  Viewing Electrostatic Results 

You can also view the Electrostatic 
results as you did in Examples 1A and 

FIGURE 216. Primaries and First 
Generation of Secondaries

FIGURE 217. Primaries and First & Second 
Generation of Secondaries

FIGURE 218. Primaries and First, Second & 
Third Generation of Secondaries
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1B. Remember, when you click on View Results->Electrostatics the first time you will be 
prompted to run the Electrostatic postprocessor.

4.2.2.9  Saving the Case

Before closing the case, make sure to save it. Right-click on the case name in the Project/Case 
Tree Control and select Save Case. 

4.3  Example 3 - Solenoid for a Multibeam Klystron (MBK)

4.3.1  Example 3A - Magnetostatic Analysis 

[revise to match format of previous examples]

The geometry is a solenoid for a multibeam klystron (MBK). This klystron requires a uniform 
field from the gun through the RF circuit, but a diverging field after the circuit to spread the beam 
into the collector. The return has eight holes for the beam to pass through in the collector polepi-
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ece, shown at the right. There is one hole on center at the gun (left) end. This is for access to the 
cathode. The model is shown in Figure 219. 

FIGURE 219. Model for the MBK solenoid. The coil is red and the iron return is violet. The yellow 
object is the focus electrode for the electron gun. This is not part of the magnetics problem, and will be 
ignored by BOA. It is included to show how parts from other relevant structures can be included for 
reference.



BOA Version 4, User Manual v0.5 updates in progress[5/10] 165

The problem was started by select-
ing Magnetostatic from the drop 
down menu under Analysis. Next, an 
ACIS (.sat) file from a solid model-
ing program was imported using the 
dialog activated by selecting Model 
in menu, and shown in Figure 220. 
In this case, the program was Solid 
Works. For this simple model, there 
were no small features that were 
likely to cause problems with mesh-
ing, so the Small Feature Entities 
value was left at the default of 0. 
While the problem has symmetry 
around the y-z plane, it is simple 
enough to allow the whole geometry 
to be modeled within a reasonable 
time. Thus, the Infinite radio button 
on the Background selection portion 
of the dialog has been selected. The 
model units were identified by BOA 
as ‘mm’. Hitting OK or Load Model 
loads the model. 

The resulting graphic, after slicing (View/slice model) the model on the yz plane, is shown in 
Figure 219. 

FIGURE 220. Model GUI used to import the model.
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The next step is to assign attributes by opening the Attributes Assignment Properties dialog (see 
Figure 221). The return was initially assigned as ‘iron’ with a fixed permeability of 3200. We 

shall check the validity of the this assignment later. The coil was assigned as ‘copper’, but it could 
also be left as ‘vacuum’ for this problem where only the permeability is of importance. The ‘FE’ 
is the gun part that is included for reference. Its material is set to ‘vacuum’.

The middle part of the dialog contains the means for assigning the coil currents. In this case, we 
have a simple solenoidal coil, and ‘Analytic Cylindrical Solenoid’ was selected as the Current 
Vector Type. The coil was selected by pushing Add Parts, the selecting the appropriate part on the 
model graphic by, as usual, holding the control key down while clicking the left mouse button. Hit 
return to exit the model graphics screen and bring up the Cylindrical Solenoid dialog shown in 
Figure 222. All of the entries except the coil current (highlighted) are filled in by BOA. The cur-

FIGURE 221. Attribute Assignment Properties dialog
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rent must be specified. Our solenoid consists of a single part, and thus the dialog should be exited 
at this point by selecting OK.

The final section of 
the dialog is used to 
select surfaces to 
serve as Dirichlet 
boundaries. How-
ever, when import-
ing the model, we 
selected quasi-infi-
nite boundary con-
ditions, and thus no 
entries are required 
in this part of the 
dialog.

Hit OK exit the dialog.

FIGURE 222. GUI for specifying the solenoid parameters.
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The next step is to 
mesh the model. 
Select Meshing/
Parameters from the 
menu, and the dialog 
shown in Figure 223 
will appear. For this 
problem, only the 
Local Mesh Refine-
ment and the Free 
Regions portions of 
the dialog will be 
used. 

In Local Mesh 
Refinement, BOA 
will have supplied 
the first entry ‘Coil’. 
This provides 
enhanced meshing 
of the coil. The 
return, since it is rel-
atively thin, should 
also be meshed in 
more detail than the 
default. To do this, 
push Add Part, then 
select the return on 
the graphics screen 
with the usual cntrl/
left mouse button. 
Hit return to exit. The dialog shown in Figure 224 will appear. Make sure the Set Mesh Size box is 
checked. Choose ‘Absolute Size’ in the drop down menu for Type and enter 25 mm, the thickness 
of the return, for the value. Uncheck the Set Curvature-Based Refinement box, and hit OK.

Changes to this or the coil's meshing can be made by selecting the appropriate part in the table, 
and clicking on Modify.

FIGURE 223. Mesh Parameters dialog.
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For this problem, the only 
other entry in this dialog is a 
Free Region. With this feature, 
the user can specify a cylinder 
with a specified mesh density. 
This is often required to get an 
adequately smooth solution in 
a region which will have an 
electron beam. In this case, the 
cylinder is specified by select-
ing Add a free cylinder, and 
filling in the dialog shown in 
Figure 225. The parameters for 
the cylinder were chosen so 
that it encompassed the beam 
for the MBK. 

The mesh can now 
be generated (Mesh/
Generate Initial 
Mesh) and viewed in 
the usual manner. 

Next, the problem 
should run using 
Execute/Single Case. 
The default values 
should be used. As 
usual, progress will 
be shown in a DOS 
window. This prob-
lem took three min-
utes on a Xeon 3 
GHz processor. 
When the program 
has finished, close 
the DOS window, 
and select View 
Results/Magnetostatics. The generation of the results view may take a few minutes. 

FIGURE 224. Part Local Mesh Refinement dialog.

FIGURE 225. Free cylinder definition GUI.
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The final step is to 
view the results 
through the menu item 
View Results / Magne-
tostatics. The dialog in 
Figure 226 controls the 
display. Set the con-
trols as shown in the 
figure. Note that 
because the magnitude 
of the field in the iron 
is much higher than the 
field of interest, it is 
necessary to reduce the 
maximum displayed 
flux density. The field 
of interest is expected 
to be about 0.02 Tesla, 
and the maximum is 
set to 0.1 Tesla. Note 
also that clipping is 
turned on to allow 
viewing of the yz plane 
at x=0. 

The field at x=0 is 
shown in Figure 227. 
The utility of the high 
density mesh along the 
beamline by the free 
cylinder is apparent. 
The irregularity of the 
surface outside of the 
free cylinder is due to 
the lower mesh density, 
and the fact that no 
smoothing is done in 
this view. The field that 
would be used in beam 
simulation is 
smoothed. The field is 
uniform across the cross section, as indicated by the uniform color. 

FIGURE 226. Magnetostatic display GUI
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Various other components and field quantities can be plotted by selecting the vector field type and 
component.

FIGURE 227. Magnetic flux density as displayed with the controls set as in Figure 226.
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The field also can be viewed on a plane using ‘scalar slicing’. Turn the clipping off for this display 
to be most useful. The dialog controlling the scalar slicing is shown in Figure 228, and the result-
ing display is shown in Figure 229.

FIGURE 228. Scalar cut plane GUI.
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The magnetic field along a line can be plotted using Line Plot, which brings up the dialog shown 
in Figure 12. The parameters for a line at the center of the beam-line are shown in the dialog. The 

line plot with these parameters is shown in Figure 231. Note that the vector components of the 
field density as well as H and the current density J can also be plotted. 

 

FIGURE 229. Scalar slice of the magnitude of the magnetic field density.
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FIGURE 230. Line Plotter dialog

FIGURE 231. Magnetic flux density plotted along the line defined in Figure 230.
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{TBD: Add additional Example cases

• Magnetostatic

• Optimization case}

5.0  Troubleshooting

To report problems or bugs, contact Thuc Bui (bui@calcreek.com).

{Is the Help-> Send Case to CCR menu item functional? If so, add a discussion here}
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6.0  Appendices

This chapter contains the following Appendices

• Appendix A - Input Files

• Appendix B - Output Files (Boa-generated Files Intended for User)

• Appendix C - Internal Files (BOA-generated Files for Internal Use Only)
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6.1  Appendix A - Input Files

This appendix documents the input files required by BOA, including

• Geometry File (required for all analyses)

• Injected Beam File (required in beam analyses if specifying an injected emitter)

• External Magnetic Field Files (required in Electro/Magnetostatic/Beam and Electro/Magneto/
Self Field Beam analyses) 

• Excel Optimization File

6.1.1  Geometry File

Each BOA analysis requires a geometry file. The geometry file is specified on the Geometry Mod-
els Parameters dialog (accessed via the Model->Parameters menu item). The file must be either 
an ACIS *.sat file or a ParaSolid *.x_t file. It is important to be aware of the following restrictions 
and conventions:

Model Units

The units used in the geometry model file dictate the units used in the BOA analysis. You do not 
have the option to change units from within BOA. Be sure to define the model units in the CAD 
package as you intend to use them in BOA. {TBD - MAKE SURE THIS IS SAID in THE DIALOG 
SECTION TOO}

Part Names

The geometry file contains parts representing the device being modeled. When BOA imports the 
geometry file, it uses the part names specified in that file. Part names are not editable in BOA so 
make sure to name parts within the CAD program as you want them to appear in BOA. 

Note to beta users: The geometry file should not contain a ‘Background’ part. The newer version 
of BoaGui automatically creates a Background part when more than one non-Background part 
exists in the CAD file. 

Surface Names

You are not required to name surfaces in the CAD package before exporting the model to a *.sat 
or a *.x_t file. Unlike with parts, you can name surfaces directly in BoaGui. However, there are 
distinct advantages to naming surfaces to which you plan to assign properties. These include all 
emission surfaces as well as surfaces that have anything to do with boundary conditions. 

Often a CAD package breaks a single surface into multiple surfaces. If you do not name your sur-
face, BOA will consider each surface of the surface as a single surface. For example, if you have 
a single emitting surface in the CAD package, upon exporting the CAD package might break it 
into, say, three surfaces. BOA will then consider it three surfaces and if you want to define emitter 
properties for it, you will have to do it three separate times. However, if you name the surface, 
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BOA will be able to ‘reassemble’ the surfaces back into a single surface as you intended it and 
you will see the surface name in BOA. (In effect, the fact that it was broken into three pieces will 
be hidden from you). Therefore it is recommended that you name any surface you plan to assign 
properties to.

6.1.2  Injected Emitter File

BOA supports the following four file formats for the spent beam data: 
• BOA file format (also referred to as CCR format),

• Magic2D file format

• Magic3D file format

• Christine file format 

Boa supports multiple injected beams per analysis. In the current beta implementation, each beam 
from each injected plane requires a separate file for injected particles. 

By convention, the extension for the Injected Beam Parameters filename is *.ibf. However, this is 
not a requirement. 

6.1.2.1  BOA Format (or CCR Format)

There are three acceptable CCR formats the Injected Emitters: 

• CCR Format 1 (the original CCR format used in early beta), 

• CCR Format 2 (a newer CCR format), 

• *.ppo file, a.k.a. Papa output file (One can slice the beam to obtain particle planar attribute 
on a plane, then use its output, the ppo file as an injected beam file.) 

Format 1

The BOA file format contains the complete 3D particle attributes at the original injected plane. Its 
form is simply

pID x[uL]    y[uL]      z[uL]     vx[uL/s]     vy[uL/s]     vz[uL/s]    I[A]

where 

pID is an identifier for the particle. It must be an integer number and distinct for each parti-
cle. 

x, y, z represent the initial particle position in global coordinates. The position units (shown 
as uL above to indicate user length) correspond to the Model Units defined on the Geometry 
Model Parameters screen (e.g. if the Model Units are set to inches, the position coordinates 
are assumed to be in inches). 
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vx, vy, vz represent the initial particle velocity. The velocity units correspond to the Model 
Units defined in the Geometry Model Parameters screen (e.g. if the Model Units are set to 
inches, the velocity coordinates are assumed to be in inches/sec).

I is the particle current is in Amperes.

Example of CCR Format 1: 

0 0.0 0.5 0.5 1.0e4 0.0 0.0 0.001

1 0.0 0.25 0.25 1.0e4 0.0 0.0 0.001

2 0.0 0.75 0.25 1.0e4 0.0 0.0 0.001

3 0.0 0.75 0.75 1.0e4 0.0 0.0 0.001

4 0.0 0.25 0.75 1.0e4 0.0 0.0 0.001

Format 2

A second CCR format has been added whose form is as follows:

            # comment line

                  VelocityType = explicit | normalized | relativistic

                  LengthUnit = 0.0254     #unit conversion to meter, this example indicates length unit is

                                                #inch

                  zPlane = 0.000          #injecting plane

            # if no velocity type is specified, explicit type is assumed

            # if no length unit is specified, assume length unit is the same as model length unit

                  q = xx      # particle charge of xx is used instead of Ip if specified

                  pID x y [z] vx vy vz Ip #explicit

            # or

                  pID x y [z] bx by bz Ip #normalized

            # or

                  pID x y [z] gbx gby gbz Ip    #relativistic

            where z is not needed if zPlane is specified, pID is the particle ID,

            (x,y,z) is the particle position, (vx,vy,vz) the particle velocity, 



180 [5/10] BOA Version 4, User Manual v0.5 updates in progress

            (bx = vx/c, by = vy/c, bz = vz/c) normalized velocity,

            (gbx = gamma bx, gby = gamma by, gbz = gamma bz) and Ip the particle current in Amp

            gamma = 1/sqrt(1 - v^2/c^2)

Example of CCR Format 2:

Papa Output file (*.ppo file)

One can slice the beam to obtain particle planar attribute on a plane, then use its output, the ppo 
file, as an injected beam file of type CCR format.

{are these three options mentioned in the Injected Emitters dialog section?} 

If the injected emitter requires a transformation (as specified in the boa gui) then the original 
injected plane will be transformed to the actual injected plane per the GUI inputs.

6.1.2.2  Magic3D Format

The Magic3D file format, like the BOA format (which is for a DC, Cartesian beam), contains the 
complete 3D particle attributes at the original injected plane. It has the form

-I[A]      x[m]      y[m]      z[m]      γvx[m/s]     γvy[m/s]     γvz[m/s]

Similar to the BOA beams, if the Magic3D injected emitter is a transformed type, its original 
injected plane will be transformed to the actual injected plane.

6.1.2.3  Magic2D Format

FIGURE 232. Example of CCR format 2
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The Magic2D file format is for Polar beams. Its spent beam axis is assumed to be always the z-
axis. Thus, the original injected plane will always be the rθ plane normal to the z-axis, and the 
direction of the beam is assumed to always point to the same direction of the positive z-axis. A 
Magic2D beam is always a transformed type (i.e., it always requires coordinate transformations). 
The format of a Magic2D beam is

-I[A]    z[m]    r[m]    γvz[m/s]    γvr[m/s]     γvθ[m/s]

6.1.2.4  Christine Format

The Christine spent beam can be either Cartesian or Polar beam. Like Magic2D beams, its spent 
beam axis is also assumed to be always the z-axis. Thus, the original injected plane will always be 
the xy or rθ plane normal to the z-axis, and the direction of the beam is assumed to always point to 
the same direction of the positive z-axis. Also like Magic2D beam, a Christine beam is always a 
transformed type, and always requires coordinate transformations. The format of a Polar Christine 
beam is

pID KE[keV]   Phase[deg]   r[cm]   θ[deg]    pr[mc]   pθ[mc]   I[A]

where pID is the particle number. KE is the particle kinetic energy, pr and pθ are the particle nor-
malized momenta. The format of the Cartesian Christine beam is assumed to be

pID KE[keV]    Phase[deg]    x[xm]   y[cm]   px[mc]   py[mc]    I[A]

Note: This format still needs to be confirmed. This format is not based on an example; it is just 
extended from a provided example of Polar format. Thus, the Cartesian Christine file format is 
subject to change when the time comes to model sheet beams in Christine.

6.1.3  External Magnetic Field File

Currently BOA supports the following file types for external magnetic fields: 

• Boa Magnetic Flux Density (fef file)

• CCR Imported Magnetic Flux Density (bf file)

• Maxwell 3D Imported Magnetic Flux Density

• Maxwell 2D XY Imported Magnetic Flux Density

• Maxwell 2D RZ Imported Magnetic Flux Density

• Pandira/Poisson RZ Imported Magnetic Flux Density

• 1D Axial Imported Magnetic Flux Density

This appendix section documents the 1D Axial Imported Magnetic Flux Density, Boa Magnetic 
Flux Density (fef file) and the CCR Imported Magnetic Flux Density (bf file) only.     

6.1.3.1  1D Axial Magnetic Flux Density File Format

File Format:
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z Min: 0.0 Max: 1.117 Number of Cells: 1117 # field separator must be a blank space in the 
header

0 -0.0000334038 # field separator is a blank space or a tab

0.001 -0.0000327384 # the first data field is the z coordinate

0.002 -0.0000320659 # the second data field is Bz in Tesla

...

1.117 0.0018822490 # zmax = 1.117 as in the header

In this example, there are 1118 data points; thus, 1117 cells or intervals. They must be equally 
spaced in z coordinate. Also, the header has total of nine data fields.

6.1.3.2  Boa Magnetic Flux Density (fef file) File Format

This file is generated by Boa. The file format is: 

# xL = (x0, y0, z0) is the coordinates of the lowest corner, dx = (dx, dy, dz) is the cell size
# Nxyz = (Nx, Ny, Nz) are the number of cells per dimension
x0 y0 z0 dx dy dz Nx Ny Nz # field separator is a blank space
# Each line below contains all k-varied vector values for a fixed index 
# pair (i,j) with 0 <= k <= Nz
B[ 0, 0, 0] B[ 0, 0, 1] ... B[ 0, 0,Nz] # (i=0,j=0), field separator is a blank space
B[ 0, 1, 0] B[ 0, 1, 1] ... B[ 0, 1,Nz] # (i=0,j=1)
...
B[ 0,Ny, 0] B[ 0,Ny, 1] ... B[ 0,Ny,Nz] # (i=0,j=Ny)
B[ 1, 0, 0] B[ 1, 0, 1] ... B[ 1, 0,Nz] # (i=1,j=0)
B[ 1, 1, 0] B[ 1, 1, 1] ... B[ 1, 1,Nz] # (i=1,j=1)
...
B[Nx,Ny, 0] B[Nx,Ny, 1] ... B[Nx,Ny,Nz] # (i=Nx,j=Ny)

6.1.3.3  CCR Imported Magnetic Flux Density (bf file) File Format

The CCR formatted file can be generated via PostPro for a Boa Magnetostatic run. 

If you are using an unsupported magnetostatic solver and want to import its magnetic field into 
BOA, the easiest thing to do is to write a translator to convert the format to the CCR format.

6.1.4  Excel Optimization File

{TBD: get info from MR or TB}



BOA Version 4, User Manual v0.5 updates in progress[5/10] 183

6.2  Appendix B - Output Files 

6.2.1  Planar Particle Output File (Papa output)

TBD {note that default filename can be changed; Note that papa output file can also be used as 
injected beam file (considered a CCR file format type} 

6.2.2  Terminal Particle Output File (Enpa output)

TBD {The default name for the file is ‘n-Enpa.out’, where n corresponds to the Particle Iteration.}

6.2.3  Cibo Output File

TBD {see ibf file format} 

6.2.4  Case Summary File

TBD  

6.3  Appendix C - Internal Files

By convention all files post-fixed wit the character '_' are for internal usage only. Examples are 
CaseName_.ebm, CaseName_.cde and ModelName_E_.sat. A file pre-fixed with a number and '-' 
indicates this file is for that particular particle iteration number. An example is 0-CaseName_.spd, 
0 stands for 0th iteration.

List of BOA-generated files:

• *.ssv files: [S]olution and [S]ource [V]olume files keep the list of the VTK readable msd files 
of regional (3D) electrostatic or magnetostatic fields generated from post-processing the fef 
files via either Electrostatic Display Control Panel or Magnetostatic Display Control Panel.

• *.sss files: [S]olution and [S]ource [S]urface files keep the list of the VTK readable mss files of 
surface (2D) electrostatic or magnetostatic fields generated from post-processing the fef files 
via either Electrostatic Display Control Panel or Magnetostatic Display Control Panel.

• *.pws files: [PoW]er [S]urface files keep the list of the VTK readable spd files of surface (2D) 
power density fields generated from post-processing the fef files only in Beam Optics Display 
Control Panel.

• *.ebm files: [E]nd [B]ea[M] files keep all terminal particle attributes automatically created 
after each Beam Optics Analysis.

• *.out files: Output files from various tools such as PAPA and Enpa.

• *.cde files: keep the current and potential convergences during a beam analysis. This file is 
used to update the Convergence plot.
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• *.tdb files:  [T]empo [D]ata [B]ase files to keep track of the fef and jc files available after each 
iteration during the analysis. These fef and jc files are listed only for those iterations that users 
select to store (outputable iteration). The 0th, 1st and last iteration files are always stored. 
Noted for either electrostatic or magnetostatic (no beam) analysis, there is only 0th iteration.

• *trj.tdb files: keep track of trajectory and power density fef files available after each ouputable 
iteration during a beam analysis.

• *.fef files: [F]inite [E]lement [F]ield files keep the solution fields produced by either magneto-
static or electrostatic field solver. (Note: The clean up feature removes all *.fef files generated 
by the case, but does not remove those imported into the case, such as those generated by 
another case)

• *.jc files: Cathode current density files: only exists in a beam analysis. It stores the current den-
sity on emitter surfaces.

• *.trj files: Particle trajectories produced by a beam analysis.

• *.msd files: 3D volumetric VTK files keeping the 3D fields created from fef files for display.

• *.mss files: 2D surface VTK files keeping the 2D fields created from fef files for display.

• *.spd files: 2D surface VTK files keeping the 2D power density field calculated from the 
power density fef file, which actually derived from the trj file.

• *.res:  file from the conjugate gradient solver 

• *.sle  stores user's selected entities during post processing  


